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PREFACE 

ABOUT THIS GUIDE 
This guide helps you to use the Tzunami Deployer and migrate contents from legacy ECM 

systems to Microsoft SharePoint. 

This preface contains the following topics. 

• Intended Audience 

• Structure 

• Related Documentation  

• Conventions 

• Technical Support 

• Comments and Suggestions 

INTENDED AUDIENCE 
Tzunami Deployer Administrators’ Guide is intended for: 

• System Administrators who are responsible for setting migration environment using 

Tzunami Deployer. 

• Project Managers and IT Managers who create and regulate usage of Tzunami 

Deployer. 

STRUCTURE 
This Tzunami Deployer User Guide is organized as follows: 

• Preface contains the overview of this manual. 

• Chapter 1 ‘Tzunami Deployer for SharePoint Migration’ provides the overview of 

Tzunami Deployer. 

• Chapter 2 ‘Tzunami Deployer Options’ explicates how to set global options for 

migration projects. 

• Chapter 3 ‘Getting Started with Tzunami Deployer’ explicates how to create a 

Deployer project and save a project for future migration. 

• Chapter 4 ‘Connecting and Loading servers’ illustrates how you can load a Source 

ECM contents and target SharePoint in the Deployer Project. 

• Chapter 5 ‘Modeling Target SharePoint explains how you can model the target 

SharePoint. 

• Chapter 6 ‘Deploying Source Data for Migration’ explains how you can deploy the 

source data to target. It provides the mapping metadata and its values to target. 

• Chapter 7 ‘Migrating Deployer Project’ explains how you can migrate the deployed 

project to the target source. 

• Chapter 8 ‘Auto Migration’ describes you how to auto migrate the data using 

Tzunami migration tools. 

• Chapter 9 ‘Auto Delta Migration’ describes you how to auto delta using Tzunami 

migration tools. 
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• Chapter 10 ‘Configuring Tzunami Deployer Advance Features’ describes you how to 

configure Tzunami Deployer settings. 

• Chapter 11 ‘Naming Considerations’ describes the naming considerations and 

restrictions. 

• Chapter 12 ‘Troubleshooting’ describes you how to step forward when an error 

occurred during the migration. 

• Chapter 13 ‘Frequently Asked Questions’ lists out the ‘Frequently Asked Questions’ 

with its solution. 

RELATED DOCUMENTATION  
For more information, see these Tzunami Deployer resources. 

Table 0-1: Tzunami Products Documentation and Resources 

Products Resource Brief Description 

Tzunami Deployer Tzunami Deployer 
Installation Guide 
 
 
 
Tzunami Deployer User’s 
Guide 

Describes how to run the setup program and 
complete the installation and configuration of 
Tzunami Deployer and Tzunami Deployer 
Service Components. 
 
Elaborates the steps required to create, Load, 
model, deploy and migrate a Deployer project. 

Tzunami Deployer 
Licensing Service 

Licensing Service Guide Explains step by step instruction for Tzunami 
Deployer licensing service. 

Exporters   

Tzunami AquaLogic 
Exporter 

AquaLogic Exporter Guide Supports migration of BEA AquaLogic User 
Interaction portal contents to Microsoft 
SharePoint. 

Tzunami Confluence 
Exporter 

Confluence Exporter 
Guide 

Support migration of Confluence Enterprise 
contents to Microsoft SharePoint. 

Tzunami Confluence 
Cloud Exporter 

Confluence Cloud 
Exporter Guide 

Support migration of Confluence Cloud 
Enterprise contents to Microsoft SharePoint. 

Tzunami Documentum 
Exporter 

Documentum Exporter 
Guide 

Supports migration of Documentum 
repositories and content management services 
to Microsoft SharePoint. 

Tzunami Documentum 
Cloud Exporter 

Documentum Cloud 
Exporter Guide 

Supports migration of Documentum Cloud 
repositories and content management services 
to Microsoft SharePoint. 

Tzunami DocuShare 
Exporter 

DocuShare Exporter 
Guide 

Facilitates migration of Xerox DocuShare web 
contents to Microsoft SharePoint. 

Tzunami eRoom 
Exporter 

Documentum eRoom 
Exporter Guide 

Supports extraction of all rooms on the server 
and guides migration to Microsoft SharePoint. 

Tzunami Exchange 
Exporter 

Exchange Exporter Guide Guides migrating Exchange contents to 
Microsoft SharePoint. 

Tzunami FileNet 
Exporter 

FileNet Exporter Guide Support migration of FileNet contents to 
Microsoft SharePoint. 

Tzunami Hummingbird 
DM5 Exporter 

Hummingbird DM5 
Exporter Guide 

Supports migration of Hummingbird DM 
enterprise contents repositories to Microsoft 
SharePoint. 
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Products Resource Brief Description 

Tzunami Livelink 
Exporter 

Livelink Exporter Guide Supports migration of LiveLink contents to 
Microsoft SharePoint. 

Tzunami OpenText 
Content Server 
Exporter 

OpenText Content Server 
Exporter Guide 

Supports migration of OpenText Content Server 
contents to Microsoft SharePoint. 

Tzunami Lotus Notes 
Exporter 

Lotus Note Exporter 
Guide 

Supports migration of Notes contents to 
Microsoft SharePoint. 

Tzunami Oracle WCI 
Exporter 

Oracle WebCenter 
Interaction Exporter 
Guide 

Support migration of Oracle WebCenter 
Interaction components to Microsoft 
SharePoint. 

Tzunami HCP Exporter HCP Exporter Guide Supports migration of Hitachi Content Platform 
contents repositories to Microsoft SharePoint. 

Tzunami HPE Content 
Exporter 

HPE Content Exporter 
Guide 

Supports migration of HPE Content Manager 
contents repositories to Microsoft SharePoint. 

CONVENTIONS 
The following text conventions are used in this document: 

• Commands and keywords are given in boldface   

• Terminal sessions, console screens, or system file names are displayed in fixed width 

fonts 

 Caution indicates that the described action might result in program malfunction or data loss. 

 
Notes contain helpful suggestions about or references to materials not contained in this 

manual. 

 Tips provide information that might help you solve a problem. 

TECHNICAL SUPPORT 
Before contacting Tzunami Deployer Support team, ensure that you are referencing the latest 

copy of this user guide (Ctrl+Click to follow link) Tzunami Deployer User Guide. 

 

If you have searched our reference materials and the issue still persists, contact Tzunami 

Deployer Support Team at support@tzunami.com. 

COMMENTS AND SUGGESTIONS 
Your feedback is important to us and will help us to provide the most accurate and high 

quality information possible in our documentation. Send us comments or suggestions by email 

to support@tzunami.com. Be sure to include as much of the following as possible: 

• The document title. 

• The location that the document was accessed from (either downloaded from 

Tzunami web site or the Tzunami Deployer User Guide available in Tzunami 

Deployer). 

• The section or chapter number and the original text found in the document. 

 
When you send information to Tzunami Deployer, you grant Tzunami a non-
exclusive right to use or distribute the information in any way it believes appropriate 
without incurring any obligation to you 

https://www.tzunami.com/download/deployerUserGuide
mailto:support@tzunami.com
mailto:support@tzunami.com
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1 TZUNAMI DEPLOYER FOR SHAREPOINT 

MIGRATION 

This chapter describes the features of Tzunami Deployer for SharePoint that are documented in 

this guide and provides pointers to additional information. It contains the following topics: 

• Tzunami Deployer Overview 

• Tzunami Deployer Workflow 

• Key Features 

• Licensing Information 
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1.1 TZUNAMI DEPLOYER OVERVIEW 
Tzunami Deployer is the leading tool for rapid migration and consolidation of content from 

multiple sources into Microsoft SharePoint Products and Technologies. 

Tzunami Deployer enables organizations that wish to start using or upgrading their SharePoint 

to dramatically reduce migration costs. Using Tzunami Deployer, the time required for a 

SharePoint content migration project is significantly reduced compared to the traditional 

labor-intensive processes. 

Tzunami Deployer enables you to prepare modeling and migration plans offline and even 

off-site. Any changes performed in Tzunami Deployer do not actually affect the SharePoint 

server until you choose to migrate them. 

1.1.1. Supported Source Systems 

Tzunami Deployer supports various ECM systems, multiple versions of SharePoint 

servers, File System and HyperWave as source systems. The following table lists the 

ECM Systems as source. 

Table 1-1 Source Systems 

Field Description 

ECM Systems This tab enlists the different ECM source systems. 

• Atlassian Confluence 

• Atlassian Confluence Cloud 

• BEA AquaLogic 

• EMC Documentum 

• ECM Documentum Cloud 

• EMC Documentum eRoom 

• Exchange Server 

• FileNet 

• Hitachi Content Platform 

• HPE Content Manager 

• Hummingbird DM5 

• Lotus Notes and Domino Server Databases 

• OpenText LiveLink 

• Open Text Content Server 

• Oracle WebCenter Interaction 

• Xerox Docusate 
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Field Description 

SharePoint 
Systems 

This tab enlists the different version of SharePoint servers. 

• SharePoint Portal Server 2001 

• SharePoint Portal Server 2003 

• SharePoint Server 2007 

• SharePoint Server 2010  

• SharePoint Server 2013   

• SharePoint Online Server 
 

Other This tab enlists the other source system. 

• Local File System and Remote File Servers 

• HyperWave 

• Custom Repositories 
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1.1.2. Supported Target Systems 

Tzunami Deployer supports the various SharePoint Server versions as target source. 

The following table enlists the supported SharePoint Server versions as target source. 

Table 1-2 Supported Target Systems 

Field Description 

SharePoint Systems This tab enlists the different version of SharePoint 
servers. 

• SharePoint Server 2016 

• SharePoint Server 2019 
 

O365 This tab enlists the different version of SharePoint 
Online servers. 

• Microsoft Teams 

• OneDrive 

• SharePoint Online 
 

On-premise As Online This tab enlists the different version of On-premise 
SharePoint servers. 

• SharePoint 2019 As Online 
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1.2. TZUNAMI DEPLOYER WORKFLOW 
Tzunami Products should be configured based on the target system and migration approaches. 

There are four topologies available.  

A. Migration to On-Premise SharePoint using Remote Service 

Tzunami Deployer communicates with Remote Service and Source systems. Remote Service 

communicates with Target SharePoint On-Premise, Tzunami Licensing Service and Tzunami 

Link Resolver Service. 

 

Figure 1-1 Topology for SharePoint On-Premise 

B. Migration to SharePoint On-Premise as Online 

Tzunami Deployer communicates with Source systems as well as Target SharePoint On-

Premise, Tzunami Licensing Service and Tzunami Link Resolver Service. 

 

Figure 1-2 Topology for SharePoint On-Premise as Online 

 

C. Migration to SharePoint Online 
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Tzunami Deployer communicates with Source systems as well as Target SharePoint Online, 

Tzunami Licensing Service and Tzunami Link Resolver Service. 

 

Figure 1-3 Topology for SharePoint Online 

D. Migration to SharePoint Online using Migration API 

Tzunami Deployer communicates with Source systems Remote Service as well as Target 

SharePoint Online using Migration API (and CSOM when necessary), Tzunami Licensing Service 

and Tzunami Link Resolver Service. 

 

Figure 1-4 Topology for SharePoint Online using Migration API 
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1.3. KEY FEATURES 
• Easy to use– Similar to the windows file explorer, Tzunami Deployer has a familiar, tree-

based, drag and drop user interface.  

• Migrates all List Types– Custom Lists,  Document Libraries, Folders, Issues, Task, Contacts, 

Announcements, Discussions, Web Part, Home Page, Quick Launch, Wiki Site, Content 

Type etc. can all be migrated while preserving views, metadata, and user-edit information. 

• Copying contents within SharePoint servers– Tzunami Deployer supports the copying of 

content between and within SharePoint Server 2007, SharePoint Server 2010, SharePoint 

Server 2013, SharePoint Server 2016, SharePoint Server 2019, SharePoint Online, sites and 

lists. 

• Modeling and deploying tool– Leading tool for modeling, customizing, and designing 

SharePoint sites, lists, libraries, and folders etc. as well as managing security settings. 

• Metadata editing and mapping– Tzunami Deployer’s metadata editing and mapping 

features provides a central point for metadata administration for all SharePoint sites. 

• Retain your valuable data– When deploying content to SharePoint, Tzunami Deployer 

maps metadata properties of source items to target columns in SharePoint libraries and 

lists. If no appropriate columns exist in the target to host your source properties, you can 

create them on the spot. 

• Migrate permission– When migrating content into SharePoint, Tzunami Deployer analyzes 

security permissions in the content sources and allows mapping of source users, roles  and 

permissions to corresponding SharePoint users, groups, roles and permissions in order to 

best match the existing settings. 

• Offline simulation environment– Tzunami Deployer loads all source and target 

information into a Tzunami Deployer project. This enables Tzunami Deployer to be used to 

make modifications and deployment plans even when it is not connected to either the 

source or the target machines. 

All modification and deployment actions performed in Tzunami Deployer are not executed 

immediately. Rather, these changes are recorded in a Tzunami Deployer project. You can 

duplicate a Tzunami Deployer project to create several modeling and deployment 

scenarios, and choose the one best suited for your needs. 

Tzunami Deployer only applies the changes to the target location and uploads the content 

from the source locations when you perform the migrating stage.  

All changes performed by Tzunami Deployer are done through the supported SharePoint API’s. 

Tzunami Deployer does not perform any unsupported direct writes to the SharePoint databases. 

1.4. PERMISSION REQUIRED FOR MIGRATION USER 
During the migration from source to target SharePoint, migration users should have specific set of permissions are 

required to perform various actions required for data migration. 

• ECM System and File System as Source: Typically, Tzunami Deployer/Exporter requires the read 

permission in the source ECM System or File Systems. Tzunami tools or services do not 

write/edit/delete in source system. However, Tzunami Deployer/Exporter required elevated 

permission to download the files or read data from personal workspaces of the users in the system. 
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Therefore, Tzunami Inc. recommends connecting using user having elevated administrator permission 

while connecting to source ECM or File system. 

• SharePoint On-premises as Source: Tzunami Inc recommends using the migration user as a member of 

site collection administrator’s group while connecting to SharePoint on-premises as source. Even 

though there are no write/edit/delete actions required in source, reading the system configurations, 

templates and managed metadata etc. requires elevated permission for migration user. 

• SharePoint On-premises as Target: Tzunami Deployer requires the write/edit/delete/read operations 

in SharePoint site collection during the migration. Tzunami Inc requires using the migration user as a 

member of site collection administrator’s group. 

• SharePoint Online as Target:  

User account used for connecting SharePoint online and data migration requires Site Collection 

Administrator Level Permission.  

Deployer recommends and implements azure app-based authentication approach for data migration. 

The Azure App authentication approach requires an azure app to be created on target tenant’s Azure 

directory and provide necessary API permissions. 

o Azure App Creation  

Azure App creation is a one-time operation that needs to be done before starting a migration 

project. Tzunami recommends creating Azure App and providing one time consent for the App 

with user having Global Admin permission.  Migrating user does not require any tenant level 

permission. 

Azure App creation process is detailed in separate guide, please refer link below.  

https://tzunami-downloads.s3.us-west-

2.amazonaws.com/TzunamiAzureAuthenticator/How+to+create+an+Azure+Application+for+m

igration.pdf 

 

o Office 365 AD Service  

• Office 365 AD service utilizes the consent provided for Azure App to read users from Azure 

Active Directory. 

1.5. AZURE APPLICATION FOR SHAREPOINT ONLINE CONNECTION 
Tzunami Deployer requires Azure Application to connect the SharePoint online. The Azure 

Application should have the following permissions:  

SharePoint API 

• AllSites.FullControl 

• TermStore.ReadWrite.All 

The SharePoint API is used to read and write the content in SharePoint Online during migration. 

Graph API 

• User.Read.All 

• Group.Read.All 

• Directory.Read.All 

The Graph API is used to read the users and groups from Azure Active Directory in Microsoft 365.  

https://tzunami-downloads.s3.us-west-2.amazonaws.com/TzunamiAzureAuthenticator/How+to+create+an+Azure+Application+for+migration.pdf
https://tzunami-downloads.s3.us-west-2.amazonaws.com/TzunamiAzureAuthenticator/How+to+create+an+Azure+Application+for+migration.pdf
https://tzunami-downloads.s3.us-west-2.amazonaws.com/TzunamiAzureAuthenticator/How+to+create+an+Azure+Application+for+migration.pdf
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The Azure Application can have Delegated or Application Permissions as per client  opts. The Azure 

Application can be created and provide the consent by the client oneself or use the Azure 

Application provide by the Tzunami Inc. 

Furthermore, the Tzunami Deployer O365 AD Service must connect to the Azure Application. The 

Tzunami Deployer communicates with Tzunami Deployer O365 AD Service to get the necessary 

connection parameters for the SharePoint online connection. Please, refer the Tzunami O365 

Active Directory Service section of Deployer Installation user guide for more information about the 

connection parameters for Azure Application.  

User can refer the following link to create the Azure Application using “Public client/native 
(mobile & desktop )” option in Redirect URI(optional) setting. 
https://learn.microsoft.com/en-us/azure/active-directory/develop/quickstart-register-app 

User can use the Tzunami Azure Authenticator tool (refer user guide for the tool) to register the 

Tzunami Azure Application.  

 
The Azure Application can have the Application Permissions or Delegated Permissions. 

In case of Application Permissions, the Azure application must have the Admin Consent which should 

be provided by a user having Global Admin role in Microsoft 365 only. Tzunami recommends to 

provide the Admin Consent in both Application Permissions or Delegated Permissions types. However, 

User Consent can be used in case of Delegated Permissions, in this case, the consent can be provided 

by a user having minimum Cloud Application Administrator role in Microsoft 365 to the Azure 

Application. 

 

In Application Permissions, the Azure application runs as a background service or daemon without a 

signed-in user. So, there is no need the user credential while connecting SharePoint from Tzunami 

Deployer. The application gets the necessary permission as a member of site collection administrator 

group upon successful connection to the SharePoint. 

In Delegated Permissions, the Azure application needs to access the API as the signed-in user.. So, 

migration user must provide credential while connecting SharePoint from Tzunami Deployer. The 

migration user should be the member of Site Collection Administrators group in target SharePoint site. 

 

1.6. AZURE STORAGE KEY FOR MIGRATION API 
Tzunami Deployer supports Azure Storage subscribed by the organization (or other vendors) and 

provided by the Microsoft as well. For the Azure Storage subscribed by the organization, user should 

manually configure the storage account details and provide the parameter in Deployer’s option as 

shown below: 

https://learn.microsoft.com/en-us/azure/active-directory/develop/quickstart-register-app
https://tzunami-downloads.s3.us-west-2.amazonaws.com/TzunamiAzureAuthenticator/Tzunami+Azure+Authenticator.zip
https://tzunami-downloads.s3.us-west-2.amazonaws.com/TzunamiAzureAuthenticator/Tzunami+Azure+Authenticator.pdf
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Figure 1-5 Private Azure Storage 

Users need to test the connection and save the credentials. For Microsoft provided azure storage 

(SPO-Provided Azure Storage) option, no such parameters required.  

Please, contact your SharePoint Administrator for more about Azure Storage configuration. 

In order to plan the auto migrations, after the first install of Deployer tools, the user must run at least 

one sample migration manually. If they are planning to use Migration API (with Private Azure 

Storage, provide the Azure Storage Credentials and Test the Connection), enable that as well during 

the connection accordingly. 
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2 TZUNAMI DEPLOYER OPTIONS 

Tzunami Deployer allows you to configure its behavior via the Options window. 

To define the Tzunami Deployer options:  

Navigate to Tools > Options  

The Options window appears. 

2.1 GENERAL  

  
Figure 2-1 Options Window – General 

 

Table 2-1 Deployer Options - General 

Option Description 

Deploy Security Enables you to specify whether to deploy security (users, 
groups and roles). 

Show metadata warning of 
empty and required field 

Select this option to show metadata warning of empty and 
required fields. 

InfoPath Form Template 
Deployment Level 

Specify the location for deployment of InfoPath form 
template in the target SharePoint. 
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2.2 SHAREPOINT CONNECTIVITY 

 
Figure 2-2: Options Window – SharePoint Connectivity 

Table 2-2: Deployer Options - SharePoint Connectivity 

Option Description 

Enable self-hosting of the 
Remote Service 

 

Self-host Deployer Remote Service and force connecting to 
the Remote Service using TCP or HTTP. 

Use authentication cookie from 
Internet Explorer 

Enables you to use the authentication cookie from Internet 
Explorer cookie cache. 

Cache the Remote Service for 
improved performance 

Enable the proxy object to the Tzunami Deployer Remote 
Service is cached and not created from scratch for each 
request. It improves performance while working with 
SharePoint 2007, SharePoint 2010, SharePoint 2013, 
SharePoint 2016 server and SharePoint 2019 server. 

Use WCF Service Endpoint 
Identity when connecting to 
Remote Service. 

Specify the endpoint identity mode to use when connecting 
to the remote service using WCF. 

Commit Managed Metadata 
field as Choice/Multichoice 
property 

Select the option for migrating Managed Metadata from 
source to target as Choice/Multichoice property. 

Commit Managed Metadata 
field preserving term hierarchy 

Select the option for migrating Managed Metadata from 
source to target as Managed Metadata preserving the term 
hierarchy of the source. 

Language filter for reading site 
templates. Separate multiple 
entries with commas 

Specify filtering the reading of site template based 
language. For Example, the value: '1033: English’. Multiple 
entries are allowed, separated with commas (,) such as 
'1033:English, 1049:Russian'. 

Specify the port used to 
connect to the SharePoint 2003 
DB Server 

Controls the ports used to connect to the SharePoint 2003 
DB Server. 
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2.2.1 SharePoint Timeouts 

 
Figure 2-3: Options Window – SharePoint Timeouts 

Table 2-3: Deployer Options – SharePoint Timeouts 

Option Description 

Reading root site timeout Specify the amount of time, in milliseconds, that Tzunami 
Deployer tries to connect to the specified Active Directory 
domains before it times out the connection. 

Root sites creating 
timeout 

Specify the root site creation timeout value in milliseconds 

Timeouts for the XML 
HTTP Web Requests 

 

Connection timeout Specify the connect timeout value in milliseconds 

Send timeout Specify the send timeout value in milliseconds 

Receive timeout Specify the receive timeout value in milliseconds 

Resolve timeout Specify the resolve timeout value in milliseconds 

Timeouts for Office 365 
HTTP Web Requests 

 

Request timeout Specify the request timeout value in milliseconds for SharePoint 
Online 
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2.2.2 SharePoint Read Settings 

 
Figure 2-4: Options Window – SharePoint Read Settings 

Table 2-4: Deployer Options– SharePoint Read Settings 

Option Description 

Specify the path to the 
Custom Global Templates 
mapping file 

Enables you to specify the path to the Custom Global Template 
mapping file. 

Specify advanced site 
read settings 

 

Read folder metadata Set this flag to ‘True’ to load metadata of folders while loading 
the target. 

Allow Deployer to load 
the same site collection in 
source and target 

Enables you to connect to the same SharePoint Site Collection in 
both as a source and target. 

Read SPS2003 Portal Area 
as Windows SharePoint 
Service Sites 

Allows Tzunami Deployer to read Areas as regular sites in order to 
get also non Area sub sites under a parent Area. 

Read Hidden Lists Enables you to read the hidden lists. 

Specify advanced list 
read settings 

 

List Item Collection 
Position  Next 

The index of an item in each list from which to read onwards. 

List Item Order by 
Filename 

The field name used to sort items while reading from SharePoint 
lists or folders. 

Max Item Count in Lists The maximum number of items to be read from each list or 
folder. 

Number of List Items to 
Read 

The number of list items to reach in each request to SharePoint. 
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Option Description 

Throughput while 
reading SharePoint 

Enables you to specify how intensely Tzunami Deployer will 
interact with the SharePoint server during connection and reading 
from the server. By default, medium level is set. User can change 
to minimum and maximum level, too. 

When using a higher level of usage, SharePoint performances 
might be influenced. 

2.2.3 SharePoint Migration Settings 

  
Figure 2-5: Options Window – SharePoint Migration Settings 

Table 2-5: Deployer Options – SharePoint Migration Settings 

Option Description 

Delete automatically 
created list properties 

Enables you to delete auto created properties and content types 
from the target list. 

Do not upload files without 
first checking them in 

Enables you to prevent items from being uploaded as check-out. 
If this flag is enabled, items which fail to publish will not be 
uploaded to SharePoint. An error will be provided during the 
migration and items will be available for migrating at a later 
time. 

Preserve approval status of 
uploaded items 

Enables you to preserve information about approval status from 
the source. 

 
• In case of migration to SharePoint Online 

(without using Migration API), the Approval 

Status or (Modified by & Modified Date) will be 

preserved, but not both due to SharePoint API 

limitation. If you don't want to preserve 

Approval Status (Moderation Status) but want 

to preserve (Modified by & Modified Date) 

then, uncheck the option. 
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Option Description 

Fail creating a list if a list 
with same URL already 
exists 

Stops creating a list if a list with same URL already exists in the 
target. 

Navigation Migration  

Migrate site quick launch Enables you to update the Quick Lunch Bar of the target site. 

Migrate top navigation Enables you to update the Top Navigation bar of the target site. 

Specify how Deployer will 
Migrate views 

Specify how to migrate the Source views into target SharePoint. 

Tzunami Deployer provides following options: 

• Do not migrate views: check this option if you do not 
want to migrate views. 

• Add views: check this option if you do not want to add 
views. 

• Replace existing views: This option is checked by 
default and replaces the existing views. 

Abort Migrate when error 
occurs 

Select this option to quit migrate when error occurs during 
migration. 

Abort upload of list items if 
attachments is problematic 

Select this option to abort uploading items containing 
problematic attachments (such as the attachment file size that 
exceeds the SharePoint maximum limit, attachment files 
containing blocked extensions or attachment file size are zero 
(0) byte or corrupted). Do not select this option if you wish to 
upload parent items without problematic attachments. 

File size notification mode Set file size notification mode as Silent/Loud/None as required. 
This refers to whether you want to let the user/log know if a file 
size which was uploaded is different than the original file size. 

Maximum file upload time Specify the timeout used when uploading files to SharePoint. If 
you plan to migrate large files, it is recommended to increase 
this value.  
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2.3 DEPLOYMENT 

 
Figure 2-6: Options Window – Deployment 

Table 2-6: Deployer Options – Deployment 

Option Description 

Specify Entity Mapping 
Suggestors  (separate 
individual values by 
commas) 

Configure the Suggestors for entity mapping. These are used to 
suggest entity mappings. Following suggestors are provided: 

ById ➔Suggest by ID 

ByName➔ Suggest by Name 

ByRegex➔ Suggest by Regular Expression 

ByProvider ➔ Suggest by Membership Provider 

ByDisplayName ➔ Suggest by Display Name 

ByLoginToDisplay ➔ Suggest by Login Name to Display Name 

Specify Group Mapping 
Suggestor (separate 
individual value by 
commas) 

Configure the Suggestors for group mappings. These are used to 
suggest group mappings:  

ById ➔ Suggest by ID 

ByName ➔Suggest by Name 

ByDisplayName ➔ Suggest by Display Name 

ByeRoomName ➔ Suggest by eRoom Name – useful when source 
is eRoom 

Specify the source 
property to check for 
duplicates 

Enter Unique Property Name of any Folder/Item/Documents of 
source property during the first migration, later Deployer 
identifies and uses these in a delta/incremental migration to find 
the matching existing Folder/Item/Documents based on that 
retained property. 

Specify the target 
property to check for 
duplicates 

Enter Unique Property Name of any Folder/Item/Documents of 
target property during the first migration, later Deployer 
identifies and uses these in a delta/incremental migration to find 
the matching existing Folder/Item/Documents based on that 
retained property 
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Option Description 

Specify the source 
properties in commit 
reports 

List of source properties separated by ',' that values would be 
written as 'Source URL' in commit report. If no value or [Default] 
is specified, usual values as returned by Deployer will be used. 

Specify the target 
property in Migrate 
report 

Target properties whose value would be written as 'Target URL' in 
Migrate report. If no value or [Default] is specified, usual values 
as returned by Deployer will be used. 

Flattening structure 
except first-level 
Container with: 

Select this flag to flatten the folder structure except the first level 
container having specified value in the property. 

• Property Name – Enter the property name. 

• Value – Enter the property value. 

Allow deployment of 
corrupt file version 

Select this flag to enable deployment of corrupt file version. Set 
this flag to false to prevent deploying corrupted or physically non-
existing file version. 

Ignore migration db 
during deployment 

During deployment, Tzunami Deployer verifies existing items in 
SharePoint target based on entries available in migration 
database and loaded project’s target source. Check this option if 
latest information is available in project’s target source. Tzunami 
Deployer will only consider the project’s target source to verify 
existing items in target SharePoint and skip to query in migration 
database to check for existing items. 

Location of Migration database: 
C:\ProgramData\Tzunami\Tzunami SPO Migration 

Find and replace mapping 
file path 

Enter the path of FindAndReplaceSample.xml file including the 
file name (e.g. C:\Program Files (x86)\Tzunami\Deployer 
4.0\Utility Files\FindAndReplaceSample.xml). 

FindAndReplaceSample.xml file has options to specify the text(s) 
to find and replaced with for Folders or Files as well as both 
separately. During the deployment process, Deployer reads the 
configuration(s) from the FindAndReplaceSample.xml file and 
performs the find and replace action accordingly. User can see 
the replaced text in target window of Deployer after finishing the 
deployment process. 

 
• User need to specify the text to be found in regex 

pattern if RegEx is set to True in 
FindAndReplaceSample.xml file. It is useful to 
specify the complex search pattern for example to 
ignore some leading/tailoring character(s), to ignore 
some characters within text to be found etc. 
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2.4 MAPPINGS 

 
Figure 2-7: Options Window – Mappings 

Table 2-7: Deployer Options – Mappings 

Option Description 

Show Value 
Mapping 
Dialogs  

Enables you to specify whether the deployment wizard will display (or skip) 
Value Mapping steps: 

• Always – Always display Value Mapping steps. 

• When there are unmapped values – Display Value Mapping steps 
only if some of the source values are not mapped. 

• Only when default value is not mapped – Display Value Mapping 
steps only if the default source value is not mapped. 

Special Show mapping for Yes/No (Boolean) properties – Select this option to 
display value mapping for Boolean properties.  

Show mapping for Approval Status properties – Select this option to display 
value mapping for Approval Status properties. 

Show only relevant values – Select this option to display value mapping for 
relevant values. 

Add All Missing Properties in Target – Select this option to add source’s all 
missing properties in target during deployment, automatically. 
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Option Description 

Show 
Property 
Mapping 
Dialogs 

Enables you to specify whether the deployment wizard will display (or skip) 
Property Mapping steps: 

• Show Always – Always display Property Mapping steps. 

• Hide for empty container – Check this option to skip 
Property Mapping steps for the empty container. 

• Hide if provided by Rule Engine – Skip Property Mapping steps that 
are filled using the Rule Engine. 

• Hide Always – Always skip Property Mapping steps. 

• Exceptions: 

• Unless there are missing properties – Do not skip 
Property Mapping steps if there are missing 
properties. 

• Unless there are unmapped target properties – 
Do not skip Property Mapping steps if any of the 
target properties is unmapped. 

Use Global 
Mapping 

• If checked, mapping for Security, Property and Value mappings are 
taken from files available in the directory 
C:\ProgramData\Tzunami\Global Configuration. 

• If unchecked, Mapping available in Deployer Migration Project is 
used. 

 

 
The default directory "C:\ProgramData\Tzunami\Global 
Configuration" will be used as the Global Mapping path. When the 
plan file for auto migration is generated, mapping files are created 
under this location. Alternatively, the end user may copy the 
required mapping file to this place. Additionally, if we execute 
deployment and choose the "Use Global Mapping" option, the 
mapping files are created in the default place. 
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2.5 SECURITY 

 
Figure 2-8: Options Window – Security 

 

Table 2-8: Deployer Options – Security 

Option Description 

Show Security Mapping 
Dialogs 

Enables you to specify whether the deployment wizard will 
display (or skip) Security Mapping steps: 

• Always – Always display Security Mapping steps. 

• When there are unmapped values – Display Security 
Mapping steps only if some of the source values are 
not mapped. 

• Only when default value is not mapped – Display 
Security Mapping steps only if the default source 
value is not mapped. 

Add Site’s name to groups as 
a part of a deployment 
process 

Select this option to add site’s name to group as a part of a 
deployment process   

Map “unmapped” group to 
Create New Groups 

Select this option to map “unmapped” group to create new 
group. 

Show warning if there are 
any unmapped roles 

Select this option to display warnings if there are any 
unmapped roles. 

Auto Map Security Select this option to auto map security (Users and Groups). 

Advanced Security Settings  

Break security inheritance for 
empty ACLs 

Select this option to break inheritance even when created ACL 
is empty. 

Fix invalid ACL entries Select this option to automatically fix ACLs by removing 
entries of invalid entities. 
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Option Description 

Ignore invalid user type 
values 

Select this option to upload item in case a user property value 
is of user which cannot be resolved. Empty value will be used 
instead resulting in the Deployer user value in SharePoint. 

Prioritize Group Select this option to specify not to assign permissions to an 
entity if it receives similar permission by being a member of a 
group that already has permission on that item. 

Optimize Security If this option is set, an item will inherit permission if its ACL is 
same as its parent's ACL when a TDX is loaded. 

Flat group members Select this option to specify not to assign permissions to an 
entity if it receives similar permission by being a member of a 
group that already has permission on that item. 

Security deployment logic Enables you to specify the security deployment. Set this value 
to a Copy of Parent ACL for broken inheritance if the break in 
security inheritance should result in item to have a copy of 
parent ACL, otherwise, inheritance breaks will result in blank 
ACL. 

 

2.5.1 Active Directory  

  
Figure 2-9: Options Window – Active Directory  

Table 2-9: Deployer Options – Active Directory  

Field Description 

Ignore disabled users 
when reading from 
active directory. 

Select this option to ignore disabled users while reading users from active 
directory 

Active Directory 
connectivity timeout 

Specify the timeout used when checking Active Directory connectivity. 
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Field Description 

Active Directory caching 
timeout 

Configure how long (in minutes) a thread should wait for another thread to 
complete reading and caching of AD. If the operation is not completed in this 
time, the thread will start reading the AD directory. Note that this time should 
be less than Remote Service Timeout. 

Advanced Active 
Directory Settings 

 

The number of AD 
entities to return from 
the Remote Service in 
one call 

Configure how may Active Directory entities to return from the Remote Service 
in one call. Large size might cause WCF buffer overflow. 

The number of domains 
Deployer will read in 
parallel 

Configure how many Domains to read in parallel based on resource availability 
on the Remote Server machine. This operation is memory intensive. 

The number of AD 
entities to read from 
domain in one request. 

Configure how many entities to read from an Active Directory domain at a time. 
Maximum allowed size is 100. Decrease in case AD overflow errors are seen 
while reading. 

Domain Settings Map DNS name with NetBIOS name, if DNS name is different than NetBIOS 
name. Enter the DNS name and NetBIOS name separated by colon (:). For 
Example 'Domain1:Domain2'. Multiple peers are allowed, separated with 
commas (,). 

Read Settings Settings to fetch the Users and Groups 

Read users and groups 
from Azure Active 
Directory 

Check this option to read users and groups from Azure Active Directory. If this 
option is unchecked, users and groups will not be read from Azure Active 
Directory. 

Always read users and 
groups 

While using Use REST API option, the users and groups are always ready from 
O365 even if TzOnlineUserandGroups.xml file exits in the Deployer installation 
directory. 
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2.5.2 Membership Provider 

 
Figure 2-10: Options Window – Membership Provider 

Table 2-10: Deployer Options - Rule Engine 

Option Description 

Please enter the 
credentials of an FBA 
user 

Enter the credentials of a Form Based Authentication user. 

 
The user should have enough privileges in the web 
application to add other FBA users to SharePoint. The user 
must have Full Control and Full Read permission in the User 
Policy of the Web Application. 
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2.6 RULE ENGINE 

 
Figure 2-11: Options Window – Rule Engine 

Table 2-11: Deployer Options - Rule Engine 

Option Description 

Rule Sets File Paths Enter the Rule Set File Paths. 

Select rule set to use for 
each system 

Allows you to select the rule set to use for each system. 
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2.7 AUTO FIXES 

  
Figure 2-12: Options Window - Auto Fixes 

Table 2-12: Deployer Options - Auto Fixes 

Option Description 

Lookup conversion to 
choice property 

 

When a list containing a lookup column is deployed without 
the list to which the lookup column is pointing to, then that 
column is changed into a choice type in SharePoint after 
migration. Deployer allows you to decide the format of the 
corresponding choice value in the target SharePoint with the 
help of the following two options: 

i. Leave values as is (containing source item id): If you 
select this option, the choice value in target appears 
as: 

“Item id;* Item Value”, where “Item id” is the lookup 
id and “Item Value” is the lookup value. 

ii. Modify values (remove source item id): If you select 
this option the choice value in target appears as:  

“Item Value”, which is the lookup value. 

Properties Values  

Automatically fix 
Date/Time values 

Select this option to let Deployer fix Date/Time values that are 
out of valid range, to valid SharePoint values. 

Automatically fix Numeric 
values 

Select this option to let Deployer fix numeric values that are 
out of valid range (Maximum or Minimum values), to the valid 
values. 

Automatically fix Hyperlink 
Values to include a default 
protocol 

Specify whether to automatically add a protocol to values of 
properties of type Hyperlink, in order to meet SharePoint 
restrictions. 

Automatically truncate the 
long Hyperlink values 

Select this option to truncate the long URLs. 
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Option Description 

Illegal Characters From this section, user can map the illegal characters and 
Microsoft Windows reserved words to desired valid values. 
Tzunami Deployer provides separate mapping sections for 
illegal characters and Microsoft Windows reserved words 
mapping configuration. 

• Click on Map button beside Map illegal characters in 
SharePoint to valid values to replace illegal 
character(s) with desired valid value. In the Replace 
Illegal Char dialog, provide the mapping with desired 
valid values then, click on OK button to save the 
mappings. 

• Click on Map button beside Map Reserve Names to 
valid values to replace Microsoft Windows reserved 
words in folder(s) and file(s) name (exact matched 
name) with desired valid name. In the Replace 
Reserve Name dialog, provide the mapping with 
desired valid name then, click on OK button to save 
the mappings. 

Blocked Extensions Enables you to specify how to handle blocked extension files. 

• Do not deploy files with a blocked extension – Select 
this option to stop deploying files with blocked 
extensions. 

• Allow files with blocked extension - Select this option 
to deploy files with blocked extension. If this option is 
selected, Deployer allows you to append the blocked 
extensions with the given text. 

Append blocked extension with: Appends all 
blocked extensions with the given text. [For 
e.g.: “txt”, blocked files with extension will 
be deployed as .exe.txt, dll.txt, aspx.txt etc.] 

 
In case of migrating to SharePoint Server 2013 
through On-Premise mode, user can update the 
list of blocked extensions in this file according to 
their needs  

BlockedExtensions.xml file located in 
“Sp2013Online” folder under the Deployer 
installation directory contains blocked extensions 
for SharePoint Server 2013. 

 

Long Items,  Files and 
Folders Names 

 

Automatically Truncate 
Long Folder Names 

Select this option to automatically truncate long folder names 
while deploying. 

Automatically Truncate 
Long File Names 

Select this option to automatically truncate long file while 
deploying. 

• Max file name length: SharePoint Server[128] and 
SharePoint Online[255] 

Based on the SharePoint server, provide the character 
length to truncate (less than the maximum limit as 
indicated in square brackets). 
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Option Description 

Problematic Items Only Select this option to automatically truncate long folder/file 
name in problematic items based upon the above options 
selected. 

Max Data Item Name 
Length: SharePoint 
Server[128] and 
SharePoint Online[255] 

 

This option truncates Data Item Name length to 128 characters 
for SharePoint On-premise and 255 characters for SharePoint 
online and SharePoint 2019. You can specify the character 
length to your desired length to truncate (less than the 
maximum limit as indicated in square brackets). 

 

2.8 MIGRATION API 

 

Figure 2-13 Settings for Migration API 

Table 2-13 Settings for Migration API 

Field Description 

Azure Storage Type Tzunami Deployer supports Azure Storage subscribed by the organization 
(or other vendors) and provided by the Microsoft as well. For the Azure 
Storage subscribed by the organization, user should manually configure 
the storage account details and provide the parameter in Deployer 
whereas for the Microsoft provided azure storage no such parameters 
should be provided in Deployer. Please, contact your SharePoint 
Administrator for more about Azure Storage configuration. 

Private Azure Storage Check this radio button to use private azure storage which is subscribed 
the organization (or other vendors. 

Account Name Enter the account name for the azure storage account. 

Account Key Enter the key for the azure storage account. 

Encrypt Migration 
Package 

Check this option to encrypt the migration package and logs. 
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Field Description 

Test Connection Once the parameters are entered, click on Test Connection button to 
check the connectivity for the azure account. If connection fails, 
connection parameters won’t be saved. 

SPO Provided Azure 
Storage 

Check this radio button to use Microsoft provided azure storage account. 
There is no need to provide other connection parameters.  

The migration package and logs are by default encrypted when using this 
option. 

 

2.9 DELTA 

 

Figure 2-14 Settings for Delta 

Table 2-14 Settings for Delta Deployment Description 

Field Description 

Deploy Security Security mappings are deployed during delta deployment. 

Duplicate File Names Specify how Tzunami Deployer handles multiple items with the same name in a 
target location. 

Add a numeric suffix to 
new files 

Item(s) is deployed with a numeric suffix appended in file name. 

Skip files with matches Item(s) does not get deployed. 

Overwrite matching files Item(s) is deployed by overwriting the existing item(s). 

Incremental migration Item(s) is deployed with behavior specified as I or II. 

 
The incremental migration allows updating properties of existing 
items.  Depending on version settings of a library the item version 
number may change. 

 

I. Skip New 
Items 

When this option is checked, Tzunami Deployer skips all the newly added items 
and only deploy the updated items in source system, which were migrated in 
previous migration. 
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Field Description 

II. Skip ACL 
for Existing 
Items 

When this option is checked, Tzunami Deployer skips ACL update for existing 
items in target, but not for the new items. 

III. Add 
version to 
existing 
item 

Item(s) is deployed as new version in the existing item(s). 

IV. Update 
properties 
of last 
version 

Item(s) is deployed and properties get updated in the last (highest) version of 
the existing item(s). 

V. Update 
security 
only 

When this option is checked, Tzunami Deployer updates the security and ACL 
only. 

Overwrite matching files When this option is checked, Tzunami Deployer will overwrite the matched 
existing files. 

Use existing folder 
hierarchy 

Tzunami Deployer will ignore the duplicate items handling for folders, and use 
the existing folder structure. This option is only available when the target of the 
deployment is a list or a folder 

Deploy Versions Specify which item versions to copy when the deployment is migrated. The 
item versions you specified to deploy are selected by default. You can deploy. 

Last Versions Only the available last (latest) document versions are deployed. 

Only last <#> Versions Only the specified number of latest document versions are deployed 

Deploy only approved 
versions 

Only those document versions marked as approved (non-draft) are deployed. 

Deploy all versions as 
major 

All document versions (including minor versions) are deployed as major 
versions. 

Use Global Mapping • If checked, mapping for Security, Property and Value mappings are 
taken from files available in the directory 
C:\ProgramData\Tzunami\Global Configuration. 

• If unchecked, Mapping available in Deployer Migration Project is used. 

 

 
The default directory "C:\ProgramData\Tzunami\Global 
Configuration" will be used as the Global Mapping path. When the 
plan file for auto migration is generated, mapping files are created 
under this location. Alternatively, the end user may copy the 
required mapping file to this place. Additionally, if we execute 
deployment and choose the "Use Global Mapping" option, the 
mapping files are created in the default place. 
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2.10 OTHERS 

 
Figure 2-15: Options Window – Others 

Table 2-15: Deployer Options - Others 

Field Description 

Restore message boxes Enables display of message boxes hidden by “Don’t show me 
again” checkbox – This will result in all message boxes being 
displayed to the user. 

Migrate Hyperlink Property 
as Note Type 

Check this option to migrate the hyperlink type properties as 
Note Type. 
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2.10.1 Link Registration 

 
Figure 2-16: Options Window – Link Registration 

Table 2-16:  Deployer Options – Link Registration 

Field Description 

Use Link Resolver Service Controls if Deployer will register migrated items to Link 
Resolver Service. 

Registration timeout for Link 
Resolver service 

Specify the link registration timeout for Link Resolver 
Service in milliseconds. 
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2.10.2 Logging 

 
Figure 2-17: Options Window – Logging 

Table 2-17: Deployer Options – Logging 

Option Description 

Keep log history for Enables you to specify for how long Tzunami Deployer retain 
log files in the open project. 

Log stack trace Specify whether to include additional information in the log 
files. 

Logging Level Specify the verbosity of the logs. The higher the level you 
select, the more verbose the logs will be. It is recommended to 
leave this to Debug level. 

Specify the maximum size 
for the WCF log file 

Enables you to set WCF Log file size. 

 The default WCF log file size is 5 MB. 
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2.10.3 Notification Setting 

 
Figure 2-18 Options Window – Notification Setting 

 

Table 2-18 Deployer Options – Notification Setting 

Option Description 

To Enter email address to send/receive notification. 

Email Notification for 

Migration Report Check if needs to send notification for Migration Report. 

Schedule Migration Task 
Added/Updated/Deleted 

Check if needs to send notification for Schedule Migration Task 
Added/Updated/Deleted. 

Schedule Migration Started Check if needs to send notification for Schedule Migration 
Started. 

Schedule Migration 
Finished 

Check if needs to send notification for Schedule Migration 
Finished. 
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2.10.4 Auto Retry and Pause 

 
Figure 2-19 Options Window - Auto Retry and Pause 

Table 2-19 Deployer Options – Auto Retry and Pause 

Option Description 

Retry for failed Items This option works after completion of running migration. This 
option is beneficial for those kinds of failed items which are 
caused by temporary reasons like internet connection issue or 
throttling issue that can be resolved in next try after some 
minutes.  

Use Retry Option By default this option is unchecked. 

Check this option to use Auto Retry for failed items after 
completion of running migration process. 

Retry After Every (Minutes) Specify the time in minutes to start auto retry in every 
specified time for failed items after completion of running 
migration process. 

Maximum time period is 1440 minutes (i.e. 24 hour). 

No of Retries Specify the number of retry attempts to be made. Maximum 
retry value is 9.  

Auto Pause This option is used to pause and resume the current running 
migration process. It is beneficial to pause during working 
hours and resume after working hours for migration. 

Use Auto Pause By default this option is unchecked. 

Check this option to use Auto pause and resume of running 
migration process. 

Pause migration every day 
at 

Specify the time in 24 hour format. E.g. 09:00 for 9 AM every 
day. 

Resume migration every 
day at 

Specify the time in 24 hour format. E.g. 17:00 for 5 PM every 
day. 
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3 GETTING STARTED WITH TZUNAMI DEPLOYER  

This chapter describes how to create a project in Tzunami Deployer and save Deployer project for future use. 

This chapter contains the following topics: 

• Configuration of Tzunami Migration Services 

• Creating a New Migration Project 

• Save a Project 
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3.1 CONFIGURATION OF TZUNAMI SERVICE SETTINGS 
The Tzunami Deployer, Exporters and Deployer Remote service communicate with various migration 

services during the migration process. Tzunami Inc. provides a program packaged with the respective 

installation file. This program enables the user to configure the services, time outs and other relevant 

settings during installation. 

When users save the configuration parameters, ServiceComponentConfiguration.xml located at 

C:\ProgramData\Tzunami\Deployer is updated. The Tzunami Deployer, Exporters and Deployer Remote 

service uses this file to point the migration services. The following sections provide the details for the 

configuration. 

3.1.1 Service Settings for Deployer and Exporters 

When installing Tzunami Deployer or Exporter or Remote Service for the first time, a Tzunami Service 

Settings dialog is displayed. In Tzunami Service Settings, the Licensing Service, Link Resolver Service and 

O365 AD Service are pointed to localhost (same machine) along with the Time Outs for the respective 

services. 

 
Figure 3-1 Tzunami Deployer Service Settings Manager 

 

 

User can run the Settings Manager.exe application from the installation directory of the Deployer or 

Exporter to display this service settings dialog at any time and updated the settings to point the 

Tzunami services as required. 

 

If these services are installed on another machine, point to that machine with the machine name 

or IP Address. Also, the following ports should be enabled in firewall or equivalent programs to 

make connections with the respective services. 

Licensing Service: TCP port 8008  

Link Resolver Service: TCP port 9028 and 

O365 AD Service: TCP port 9000  
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3.1.2 Service Settings for Deployer Remote Service 

Similarly, when installing the Deployer Remote Service (RS) in the SharePoint on-premises server, 

Licensing service and Link Resolver Service should be configured. At the end of the installation, 

Remote Service Settings dialog opens. In Remote Service Settings, the Licensing Service and Link 

Resolver Service are pointed to localhost (same machine) along with the Service Timeouts, Delays and 

Logging Level for the remote service. 

 
Figure 3-2 Remote Service Settings Manager 

 

User can run the Settings Manager.exe application from the installation directory of the Deployer or 

Exporter to display this service settings dialog at any time and updated the settings to point the 

Tzunami services as required. 

If these services are installed on another machine, point to that machine with the machine name 

or IP Address. Also, the following ports should be enabled in firewall or equivalent programs to 

make connections with the respective services. 

Licensing Service: TCP port 8008  

Link Resolver Service: TCP port 9028 and 
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Users must restart the Remote Service in windows services after changing and saving the 

configuration parameters. 

 

 

3.2 CONFIGURATION TO SUPPORT DOT CHARACTER IN FOLDER 
Tzunami Deployer supports dot (“.”) character in folder name while migrating in SharePoint online. By 

default, it is not supported. User needs to configure in Deployer configuration file to enable it. Please, 

perform the following steps to configure the settings. 

1. Go to the Deployer installation location. 

2. Open the Deployer.exe.Config in an editor with privileged permission. 

3. In <appSettings>, find the key SupportDotOnFolderNameForOnline. 

4. Set the value to True. 

 

Figure 3-3 Support dot character in folder name. 

5. Save the file in same location. 

Now, user can run the deployer. 

 

The dot (“.”) character in folder title property is supported even when the key 

SupportDotOnFolderNameForOnline in Deployer configuration file is set to False. 
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3.3 CREATING A NEW MIGRATION PROJECT 
Tzunami Deployer stores all the information related to a particular project in a Tzunami Deployer project. 

The project consists of a file system folder, which contains the Tzunami Deployer project file (information 

describing the SharePoint structure and changes that will be executed on the target).  

Begin using Tzunami Deployer by creating a new project. 

3.3.1 To create a project: 

1. Launch Tzunami Deployer and select File > New. The New Project window appears. 

  
Figure 3-4: New Project Window 

 

2. Enter a name for the project in the Project name field. 

3. In the Project folder field, enter the location where you want Tzunami Deployer to create the new 

project folder.  

 
The project folder contains all the definitions that you create in Tzunami Deployer, 

automatic backups of the project, as well as logs and reports of the activities that are 

performed in and by Tzunami Deployer. 
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4. Select one or more types of source systems to be migrated to this project. 

One of Tzunami Deployer’s advantages is its ability to consolidate several source systems (Enlisted 

in ECM, SharePoint and Other tabs) into a single target SharePoint server. The source options that 

are available for selection are determined by the license that you installed, as described in the 

previous section. Options that are not permitted by your license are not available for selection. For 

more information about the Tzunami Deployer license, and for support of systems that are not 

listed, contact the Tzunami Support Team. 

The following table shows the supported source system enlisted under ECM, SharePoint and Other 

tabs. 

Table 3-1: List of Supported Source Systems 

Field Description 

ECM This tab enlists the different ECM source systems. 

• AquaLogic 

• Confluence 

• Documentum 

• DocuShare 

• eRoom 

• Exchange 

• FileNet 

• Google 

• Hummingbird DM 

• Hitachi Content Platform (HCP) 

• HPE Content 

• Livelink 

• LotusNotes 

• Oracle WCI 

SharePoint This tab enlists the different version of SharePoint servers. 

• SharePoint 2001 

• SharePoint 2003 

• SharePoint 2007 

• SharePoint 2010 

• SharePoint 2010 Remote 

• SharePoint 2013 

• SharePoint 2016 

• SharePoint 2019 

• SharePoint Online 

Other This tab enlists the other source system. 

• File System 
• HyperWave 

 

 
Tzunami Deployer does not support SharePoint 2001. 

 



 

  Page | 42  

5. Select a target system for the migration in this project. The options that are available for selection 

are determined by the license that you installed. The following table shows the supported target 

systems. 

Table 3-2 List of Supported Target Systems 

Field Description 

SharePoint This tab enlists the different version of SharePoint servers. 

• SharePoint 2003 

• SharePoint 2007 

• SharePoint 2010 

• SharePoint 2010 Remote 

• SharePoint 2013 

• SharePoint 2016 

• SharePoint 2019 

O365 This tab enlists the different online SharePoint sites. 

• Microsoft Teams 

• OneDrive 

• SharePoint Online 

On-premise As Online This tab enlists the different On-premise SharePoint sites 

• SharePoint 2019 As Online 

 

6. Click OK. Tzunami Deployer creates the new project folder and initializes the project files in it. The 

Project window appears. Initially, both parts of the Project window are empty. 

   
Figure 3-5: Project Window 
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The top half of the Project window uses a Windows Explorer style folder tree and details list to display the 

structure and content that has been loaded from the source systems. The bottom half of the Project 

window uses a similar approach to display the structure and content of the target SharePoint. The details 

list in the top and bottom parts of the Project window show columns of metadata properties and other 

information for the child items. 

The status bar indicates various types of information, such as the currently listed and selected items and 

the status and progress of Tzunami Deployer processes. An indicator on the left of the status bar displays 

red when Tzunami Deployer is busy or when a dialog is open and Tzunami Deployer is waiting for user 

input. This indicator blinks yellow when Tzunami Deployer is performing a background operation. During a 

background operation, the current stage of the operation is also displayed, as well as a progress bar and 

the estimated time remaining for the operation to be completed. The indicator is green at all other times. 

3.4 SAVE A PROJECT 
When you save a project, you can save it to a folder on your hard disk drive, a network location, disk, the 

desktop, or another storage location. To do this, select a desired drive/folder from the Save As window. 

The Saving process is the same, regardless of what location you choose. 

You should save the project frequently while you are working on it to avoid losing data because of an 

unexpected power failure or other problem. 

3.4.1 To save a project: 

1. Click  

Or 

Select File > Save 

Or 

Press Ctrl + S 

 
Figure 3-6: Save As window 

 

2. Enter Project name and Click Ok. 
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4 CONNECTING AND LOADING SERVERS 

This chapter explains how to connect and load sources content and target SharePoint in Deployer project. 

This chapter contains the following topics: 

• Connecting and Loading Source Server 

• Connecting and Loading Target Server 

• Reloading SharePoint Items 

• Removing SharePoint Projects 

• Handling Throttling with SharePoint Online 

• Best Practice 
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4.1 CONNECTING AND LOADING SOURCE SERVER 
After creating a Tzunami Deployer project, you can load the information that describes the source system’s 

hierarchy structure and the metadata properties associated with each item. A tab appears in the Project 

window for each source system type that you selected in the New Project window. 

 
The loaded information is only read from the source system and no modifications are made 

to the actual source at any time during the migration process. 

You can load information into Tzunami Deployer from one or more of the following source stores: 

• ECM System– Tzunami Deployer can load directly from a source or load the exported .tdx file. 

• SharePoint On premise server– Tzunami Deployer can load directly from a source SharePoint 

2003/2007/2010/2013 store. 

• File System – Tzunami Deployer can load information directly from your file system. 

 
Information loaded from a source system captures the contents of that store at the time it is 
loaded (or exported, in the case of TDX files). If the source system is modified after being 
loaded, these modifications are not reflected in your Tzunami Deployer project. To access 
the up-to-date content of the source system, you must reload that system (or recreate the 
TDX file, where necessary). 

After loading, two numbers appear to the right of each folder name in the source tree, for 

example . The second number is the total number of items in that particular 
folder and all its subfolders. The first number is the number of items that were deployed to 
the target. 

All source items are read-only and their icons are displayed with a blue lock ( ) overlay. 

4.1.1 Loading from File System 

Tzunami Deployer can load directly from a file system into one or more root folders that you can define in 

the source tree.  

 
You can load HyperWave directly from a File System by using HMI files generated by HyperWave. HMI 
files are text files. It contains properties, their values and security permission for a specific file folder. 

 
In order for a .HMI file to relate to a file/folder, the HMI file should: 

Be named after the related file/folder. 
For Example – The HMI file sample1.doc.hmi relates to sample1.doc and contains its properties and 
security permissions. 

Have the correct value for the property ‘Type’ 
For Example – If the property Type is populated with the value ‘Link’, the file has to be html (or similar) 
file. 

HMI files must start with the following line: 
“HyperWave Meta Information/1.1” 
Followed by an empty line 

To load a source file system: 

1. Click  

Or 
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Right-click in the File System tab and select Add File System Root or Add HyperWave 

Root. 

 
You can add as many roots as you want. 

The Add File System Root window appears. 

  
Figure 4-1: Add File System Root window 

 

 
Figure 4-2: Add HyperWave Root window 

 

2. Enter a name for the file system root and specify the location of the source file system 

folder to be loaded. 

3. Select Created After, Modified After, and Accessed After to filter out the files that will be 

loaded from the file system. 

 
The Analyze document content checkbox is selected by default and instructs 
Tzunami Deployer to scan each file for embedded metadata properties, such as 
title, author, and so on. Metadata is retrieved based on IFilters installed on the 
computer running Tzunami Deployer. 

If the number of source documents in your file system is very large or each file’s 
internal metadata does not need to be migrated, deselect this checkbox. When the 
Analyze document content checkbox is deselected, the loading process is faster. 
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4. Click OK. The source begins to load. When the process is complete, the folder and files 

loaded by Tzunami Deployer appear at the top of the Project window and the status bar 

displays Ready. 

 
Figure 4-3: Tzunami Deployer Window - Loaded File System 

 
If certain files fail to load, a warning window appears, listing those files. You can save 
the information in this window in order to keep track of the migration. This may 
occur for a variety of reasons, such as failure to access a file because of a technical 
problem. 

4.1.2 Connecting and Loading from Source SharePoint 

If you are migrating contents between SharePoint servers, upgrading from SharePoint 2003/SharePoint 

2007/SharePoint 2010 to SharePoint 2013/SharePoint 2016/ SharePoint 2019/SharePoint Online or simply 

copying your SharePoint content, Tzunami Deployer is an easy to use, leading tool to migrate your 

SharePoint data.  

To do so, you must first connect and load the source SharePoint as a source in the Tzunami Deployer 

project. This process is identical to the process of loading the target SharePoint information, except that 

you right-click in the source store area and then select the Connect to SharePoint option. 

To connect and load source SharePoint: 

• Click  

Or 

Right-click in the Source SharePoint (For example SharePoint 2010) tab and select 

Connect to SharePoint.  
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4.1.3 Loading from TDX File 

4.1.3.1 Load TDX file 

If you have purchased a Tzunami Exporter, you can migrate content from additional sources such as 

SharePoint 2001, LiveLink, and various other systems. This is done with a Tzunami Deployer Export (TDX) 

file that can then be loaded as a source in Tzunami Deployer. If you want to migrate from a content source 

that is not currently supported, contact the Tzunami Support Team for more information, including the 

specifications for the TDX file format, which can then be used in the same manner as the sources. 

 
When running Tzunami Deployer on several machines, you can run an export on one machine, 
and load the exported data on another machine. While copying exported data to another 
machine, verify that you copy all the exported data, including both the TDX file and the 
extracted files directory (typically named FileStore). 

When loading TDX file, Exporters have two modes of operations: Full Export and Lite Export. 
When performing a Full Export, documents that are exported are saved to the file system and 
uploaded from the file system during the migrate stage. When performing a Lite Export only 
the structure, metadata, and security information are exported, without the documents. 
During the migrate stage, Tzunami Deployer accesses the source system and downloads the 
documents that are to be uploaded. For Lite Export, the Tzunami Exporters must be installed 
on the Deployer machine. 

To load a TDX file: 

1. Right-click in the source area, and select Load <ECM Name> TDX. The Load <ECM Name> 

exported information window appears. 

 
If you have just completed an export, the Load <ECM Name> exported information 
window is already displayed and the Location field already contains the location of 
the exported data. 

 
Figure 4-4: Load <ECM Name> exported information window 
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2. Enter a name for the content to be loaded and specify the location of the TDX file. 

3. Click OK. The source content begins to load. When the process is complete, the folder and 

files loaded by Tzunami Deployer appear in the top window and the status bar displays 

Ready. 

4.1.3.2 Load TDX with Property Merge 

Tzunami Deployer provides a feature to merge multiple source properties’ values into a 

newly created single property after loading the source content in Tzunami Deployer project. 

User can initiate a property merge process in the Deployer migration project during loading 

the source data in the project. User can create a new property to hold merged properties’ 

values, select properties to merge whose values will be merged in a single property and 

select a separator which will separate the merged values. 

 

Steps for Property Merge in Deployer migration project 

1. Create or open the Deployer Migration Project, then load the tdx file in source panel. 

A tdx file browsing window appears. 

 

Figure 4-4 TDX File Browsing Window 

Enter the name, browse the tdx file. 

 

2. Check Apply check box, then click on Settings button. A Merge Properties window 

appears. 

 

Figure 4-5 Settings for Properties Merge 
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If you do not want to use the property merge feature, click on OK button then the property 

merge process will be skipped. The source data will load in the source panel. 

3. Create a new property in which properties will be merged by clicking on New button 

beside New Properties list in upper panel. 

 

Figure 4-6 Merge Properties Window 

A New Property window appears. 

4. Enter the name of Output column, then click OK button. 

Figure 4-7 New Merge Property Window 

The new added property is always of type “Long Text”. 

You can perform following action for new property: 

• Rename: You can rename and remove the newly created merge property 

using Rename button when a property is selected in New Properties list. 

• Delete: you can delete new property using Delete buttons when a 

property is selected in New Properties list. 
 

 



 

  Page | 51  

. 

5. Select properties to be merged from Source Properties and a newly created property 

from New Properties list, then select a separator from dropdown Value Separator. After 

that, click on Merge button. 

 

Figure 4-8 Merged Property Window 

The selected properties from Source Properties list are merged to selected property 

from New Properties list and the merged property is displayed in Merged Properties 

Panel in the bottom. The Source column shows the selected properties with specified 

separator and Target column shows the property in which source properties are 

merged. 

    For the newly merged property, you can perform the following actions: 

• Remove: Select a merged property, then click on Remove button. A 

confirmation window appears, click in Yes. 

 

The removed new property is displayed in New Properties list. 

• Export: You Click on Export button to export the newly merged property 

so that it can be imported in another migration project. Select a 

destination and provide the file name and then click on Save. 
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• Import: You can import the already created and exported merge 

property using Import button. 

6. Repeat steps 2, 3, 4 and 5 to create more properties to merge if required, then click on 

OK button of the Properties Merge window. 

7. Click on OK button in the Tdx loading window. 

Figure 4-9 TDX Loading Window 

The new merge property will be created and values from selected properties will be 

merge into the property. Then, the source tdx will be loaded in source panel. You can 

verify the output column from Properties window by right clicking the item in left side 

and selecting Properties. 

 

Figure 4-10 Merged Property Data Window 
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4.1.3.3 Load TDX with Metadata Transformation 

Tzunami Deployer when loads the exported source content in migration project, all the 

associated metadata are loaded in the source panel. User can view the metadata associated 

in with each item separately. Also, user can view the metadata associated with each 

property set separately as well. The Tzunami Exporter tool manages all exported metadata 

in .tdx and .stdx files based on its architecture. Based on the information available in .tdx 

and .stdx files, Tzunami Deployer configures and displays the metadata in property sets and 

items in Deployer migration projects. 

In some cases, user needs to transform one or more metadata. Tzunami Deployer or 

Exporter do not provide facility to edit the exported data i.e. .tdx or .stdx files. However, 

Tzunami Deployer provides feature to transform the metadata in the Deployer Migration 

project. In fact, the metadata transformation feature in Tzunami Deployer provides facility 

to create metadata as a transformed metadata in Deployer Migration project during loading 

the .tdx file in the project. Hence, user will have all exported metadata along with newly 

created transformed metadata in the Deployer Migration project that can be mapped and 

migrated to the target SharePoint as other metadata using regular process of migration. 

Since, the transformation metadata is accompanied by creating new metadata in Deployer 

Migration project, this feature is also useful when user has externally or internally managed 

metadata which is not possible to export using API or by the limitation in the source ECM 

system. 

Before using Metadata transformation in Deployer Migration project, user needs to create a 

.csv file where user needs to reference the source property and provide the unique value of 

that property. Then, provide title for the transform property and choice values (separated 

with semicolon). Once the .csv file is prepared, user will be guided through the steps 

required for metadata transformation while loading the source ECM in Deployer Migration 

project. The following section will provide the detail steps. 

4.1.3.3.1 Create Metadata Transformation file 

User has to create a .csv file with some detail and save the file in any convenient location. 

The first row of the .csv file must have the source property preceded with “$” and should 

specify the values in successive rows. The transform property should have specified in next 

row with regular name i.e. without preceding with above mentioned sign and values should 

be specified in successive rows. If transformation property has multiple values, then those 

values should be separated with semicolon. The sample of the file is as below: 
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Figure 4-5 Transformation File Sample 

In the above figure, first column refers to the source property which is preceded with “$” 

sign. This property is exported and is available in .tdx or .stdx files. It is reference here 

because the Tzunami Deployer when load the ECM source in Deployer Migration project, it 

should identify the property set where transform property should be created. The value of 

this property specified in successive row (here in second row) uniquely identify the 

associated property set having “ID” property with value “0_424F”. Then, during 

transformation, a transformed property named “Transfrom 1” is created with multi choice 

values “ABC, def, 123” in the property set of the Deployer Migration project. So, the newly 

created transformed property will be always created as multi-choice property. User can save 

this file in any convenient location in the network and will need to browse in next step. 

4.1.3.3.2 Load Metadata Transformation file in Deployer Migration Project 

Create Deployer Migration project with desired source and target systems. 

 
Figure 4-6 Deployer Migration Project 

Load the source in upper source panel of the Deployer migration project. 
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Figure 4-7 Loading Source ECM data in Deployer Migration Project 

When .tdx file is browsed, the Apply Metadata Transformation option is enabled. 

Check the option Apply Metadata Transformation, a Metadata Transformation window 

appears, 

 
Figure 4-8 Metadate Transformation Window 

Click on Add button, then browse the Metadata Transformation csv file. Then, Metadata 

Mappings window appears. 
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Figure 4-9 Metadata Mappings Window 

4.1.3.3.3 Configure default values 

In the Metadata Mappings window, user can define the default value for the transformed 

metadata.  

 
Figure 4-10 Metadata Transformation Default Value 

In the right side panel of the Metadata Mappings window, Default Value column is 

presented and a dropdown for each transformed metadata is available. From the dropdown 

user can select the default value as desired. 

In the left side panel of the Metadata Mappings window, user can map the default value for 

the referenced source property. User can choose the default value from the dropdown 
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available under Map To column. This mapping is beneficial when there are duplicate values 

for the referenced property in the source system. 

When default value configuration is completed, click on OK button. Then, the Metadata 

Mappings window is closed and Metadata Transformation window is displayed. 

 
Figure 4-11 Metadata Tranformation Window with Mapping files 

User can see the list of mapping files currently used in Mapping files panel. 

4.1.3.3.4 Export/Import Metadata Transformation configuration 

When mapping files is browsed and configure, user can export the mappings files to any 

convenient location for future use in another Deployer Migration project. 

Click on Export Mappings button, a location to save mapping file is displayed. It is 

recommended to save the file in shared location in the network so that Tzunami Deployer 

instances running in different machine can import this file in Deployer Migration project. 



 

  Page | 4-58  

 
Figure 4-12 Metadata Transformation Export Mapping  files 

Follow the other instruction to save the file. 

Similarly, if metadata mapping file is already exported, user can click on Import Mappings 

button to import the mapping file. 

 
Figure 4-13 Metadata Transformation Import Mapping file 

Once importing the mapping files, the imported files is listed in Metadata Transformation 

window. 

4.1.3.3.5 View transformed metadata 

When mapping configuration is completed, user can view the metadata. 

First select the mapping file from Mapping files list, then View and Remove buttons will be 

enabled. Click on View button, then the information will be displayed. 
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Figure 4-14 Metadata Transformation View Information 

4.1.3.3.6 Remove transformed metadata 

When mapping configuration is completed, user can remove the metadata mapping file. 

First select the mapping file from Mapping files list, then View and Remove buttons will be 

enabled. Click on Remove button, then the information will be removed. 

4.1.3.3.7 Save and Close transformed metadata 

When mapping configuration is completed, Metadata Transformation window is displayed 

as below: 

 
Figure 4-15 Metadata Transformation Window 

Click on Save & Close button. The source loading window appears. 
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Figure 4-16 Load Source Information 

Click on OK button. The metadata transformation process executed internally and the 

update source is load in the source panel. User can see the transformed metadata and value 

in associated item or property set. 

 
Figure 4-17 Metadata Transformation in Deployer Migration project. 

User can perform the deployment, mapping and migration of the transformed metadata as 

other metadata onwards. 

4.1.3.4 Load TDX with Split Content 

In any ECM system, a folder may have a fixed number of maximum data items. This value 

differs from one ECM system to another ECM system. Therefore, the source ECM system 

and SharePoint may have the different value for maximum number of items limit in a list. If 

the source ECM system supports greater number of maximum number of items in a list, then 

a case may encounter where the number of items in a list crosses the maximum limit in 
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SharePoint. In such case, the exceeded number of items get failed during migration in 

Tzunami Deployer. To overcome such limitation, the items in the source list should be split. 

Tzunami Deployer provides a feature to split the number of items of a source to a user 

defined value during the loading of source content in Tzunami Deployer Migration Project. 

Steps for Spit Content in Deployer migration project 

1. Create or open the Deployer Migration Project, then load the 

tdx file in source panel. A tdx file browsing window appears. 

 
Figure 4-18 TDX File Browsing Window 

Enter the name, browse the tdx file. 

 

2. Check Automatically Split lists over check box, and specify the 

value from which items should be split in the list. Then, click on 

OK button. 

 
Figure 4-19 Settings for  Split Content 

If you do not want to use the Split Content feature, click on OK button then, 

the source data will load in the source panel. 
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3. The source panel will load the tdx with divided content. The number of 

items will consider the sub-folders as well in the count. 

 
Figure 4-20 Split Content 

4.2 CONNECTING AND LOADING TARGET SERVER 
In this step, you load the structure information describing the content of the target 

SharePoint Servers (2003, 2007, 2010, 2013, 2016 or 2019) or SharePoint Online. Tzunami 

Deployer loads the SharePoint structure information, including portal areas, sites, lists, 

libraries, folders, documents, items, wiki page, etc. as well as security and metadata 

information. This information is displayed at the bottom of the Project window in the Target 

SharePoint tab.  

 
The target SharePoint is not modified until the migrating step. 

You first connect to the SharePoint server and then specify what information you want to 

load into your Tzunami Deployer project. When you load a SharePoint target, you can 

choose to load only some of the items and then load additional items at a later stage.  

You can also remove the SharePoint information from the Tzunami Deployer project and 

load SharePoint again. This is especially useful for loading a different SharePoint server into 

the current Tzunami Deployer project, or for reloading SharePoint content. 

 
Information loaded from SharePoint captures the SharePoint content at the time it is loaded. If 

SharePoint is modified after being loaded, these modifications are not reflected in your Tzunami 

Deployer project. Tzunami recommends that you do not modify the SharePoint content that is 

currently being processed by Tzunami Deployer. To access the up-to-date content of the SharePoint 

store, you can either remove the SharePoint from your Tzunami Deployer project or refresh a 

particular location by reloading it. 
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Load the SharePoint target smartly – plan the migration destination and nature to make it easier for 

you to choose which sites and lists you want to load in the target SharePoint. Loading the entire farm 

into a single project may be a redundant and time consuming operation. A template project(s) should 

contain only the destination top site collection loaded with no lists or sub sites (un-loaded lists or sub 

sites appear grayed-out in Tzunami Deployer project and you can reload them later). 

4.2.1 SharePoint on premise Server  

4.2.1.1 Connecting and Loading SharePoint Server (2007-2019) 

You can connect and load SharePoint Server (SharePoint 2007, SharePoint 2010, SharePoint 

2013, SharePoint 2016 or SharePoint 2019) servers as a source or target in Tzunami 

Deployer. To load SharePoint Server, you must first connect to a SharePoint server from 

Tzunami Deployer for which you need a user account with the following permissions: 

• The user running Tzunami Deployer needs to be a Local Administrator (to 

get Registry and File System access). 

• The user provided in Deployer must have permission to connect to the 

machine where Tzunami Deployer Remote Service is installed (unless the 

source Remote Service has problems downloading files from the source 

which results in the Deployer-provided credentials being used). 
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To connect and load SharePoint target (connecting SharePoint 2013 as an 

example) 

1.  Click  Data > Target SharePoint 2013 > Connect to SharePoint Or 

Right-click in the Target SharePoint 2013 tab and select Connect to 
SharePoint. The SharePoint 2013 Connection Wizard appears. 

2. Click Next. The Connection Wizard progresses to the Access SharePoint 
Server screen. 

 
Figure 4-21: SharePoint Connection Wizard – Access SharePoint Server Screen 

 

3. Enter the name or Fully Qualified Name (FQN) of the SharePoint front-end 

server in the Server Address field. Use the name or IP Address of the front-

end server running the Tzunami Deployer Remote Service.  

 
The Tzunami Deployer evaluation version only allows you to connect to the local 
server. The local machine name is automatically selected. The fully licensed version 
of Tzunami Deployer does not have this restriction and allows you to connect 
remotely to any SharePoint server. 
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4. Specify the user account to be used by Tzunami Deployer to login and access 

the SharePoint server.  You can choose between two options: 

• Windows logon user – Use the currently logged on user. 

• Different user name – Specify a different user and enter a password 

in the Password field. When specifying a user, use the following 

formats: DOMAIN\user or COMPUTERNAME\User or user@DOMAIN 

or user@COMPUTERNAME. 

 
If Tzunami Deployer fails to connect to SharePoint, verify that you provided all the 
required permissions to the user, as specified in the Tzunami Deployer Installation 
Guide. 

Clicking Auto-scroll scrolls down to display the latest progress messages, as they 
appear. 

Clicking Errors only filters the displayed progress messages to show error messages 
only. 

Clicking Warnings only filters the displayed progress messages to show warning 
messages only. 

 

5. Click Next. The Connection Wizard progresses to the Web Applications 

screen. 

   
Figure 4-22: SharePoint Connection Wizard – Web Applications Screen 

 
If a URL of the virtual server displayed in the screen is not the same as it is in IIS or in 
SharePoint, you can change it from the list of alternative URLs, or configure it 
manually in the URL field. Click Update to use the selected URL. When connecting to 
SharePoint as target, it is not necessary to load versions of documents. 
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6. Select one or more Web Applications to load and click Next. The SharePoint 

Structure appears with three tabs: Sites, Content and Active Directory. 

Sites Tab 

The Site tab allows you to select site collection to load into the Deployer 

Project.  

  

Figure 4-23: SharePoint Connection Wizard – SharePoint Structure - Sites Tab 

 
Loading of SharePoint content may be a lengthy process, depending on the amount 
of content, the type of network, and the workload of the SharePoint server.  

When connecting to SharePoint, it is not necessary to select site collection and item 
to load into the project. Tzunami recommends that you only load the site collection 
and portal sites that are the targets for your current project. 

Site collection and Items that are not loaded at this stage appear grayed out in the 
Project window. Such items can be reloaded at a later time. 
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Click Content Tab to load the Site contents. 

 
Figure 4-24: SharePoint Connection Wizard – SharePoint Structure - Content Tab 

Active Directory Tab 

The Active Directory tab allows you to load user and groups from Active Directory 

domains. 

 
Figure 4-25: SharePoint Connection Wizard – SharePoint Structure - Active Directory Tab 

 

 
Active Directory tab is only available when connecting to the Target SharePoint 
Structure. 
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Table 4-1: SharePoint Structure – Active Directory Tab 

Field Description 

Users and Groups Specify how to load users and groups from Active Directory 
domains. 

Read users and groups 
from Active Directory 

Allows you to read users and groups from Active Directory. 

• Do not load disabled users from Active Directory – Select 
this option to skip disable users and groups when reading 
Active Directory. 

Import users and 
groups from XML 

Allows you to import users and groups from an XML file. 

Do not read users and 
group 

Allows you to skip loading users and groups from Active Directory. 

Active Directory cache 
expiry time (in days) 

Allows you to specify expire time for remove Active Directory cache 
files.  

View Currently Selected 
Domains 

Allows you to view currently selected domains. When mouse 
pointer is hovered on it, the currently selected domain(s) are 
displayed as tool tips.  
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Choose domains… Opens the Choose Domains for Reading window, which displays the 
domain to which the SharePoint machine belongs and any sub-
domains and additional domains with a trusted relationship to that 
domain. 

 
Click Update List to display domains. The Domain that 
is part of SharePoint server, any Sub-Domains and 
Additional Domains with trusted relationship with 
main domain appears in BLACK COLOR.  

Cached Domains have their user information stored in 
a local cache file, and will be read without probing the 
domain controllers for information. The Cached 
Domains are displayed in RED COLOR. 

Any domains with incoming trust relationship are 
displayed in PURPLE COLOR. You must enter domain 
credentials to read users from incoming trusted 
relationship domains.  

  

 

If you select an Active Directory domain, Tzunami Deployer 
retrieves all the users and groups from that domain.  

 

 
Click Add Domain to add custom domains that do not 
appear in the Domains tree. Enter Domain Credentials 
window appears. 
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Specify the Domain name and enter User name, 
Password and Confirm password in their respective 
fields. Click Test to verify domain credentials to connect 
with the custom domains. 

Click Delete Domain(s) to delete selected domains from 
the list. 

Tzunami Deployer caches the results from previous 
connections to SharePoint. You can delete the cached 
information by selecting a domain and clicking Remove 
Cache. 

 

7. Click Next. The Thank you for using the Connection Wizard screen appears. 

8. Click Done. Tzunami Deployer begins scanning the SharePoint server and 

loads information about the selected site collection, including sub sites, lists, 

folders, files and list items.  

A Results window appears, displaying the load progress. 

  
Figure 4-26: Loading SharePoint 2013 – Results Window 

 
You can stop the loading process at any time by closing the Results window, right-
clicking in the SharePoint area, and selecting Stop Loading SharePoint. 
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When the loading process is complete, you can browse the SharePoint structure in 

the Project window. For example: 

  
Figure 4-27: Loaded Target SharePoint 2013 

The following table displays the various icons used by SharePoint 2013 to represent 

various types of items. 

Table 4-2: SharePoint 2013 Icons 

Icon Description 

 Web Application 

 SharePoint Site 

 List 

 Document Library 

 Picture Library 

 Folder  

 

 
Each item in the structure tree is followed by two numbers. The first number is the 
number of documents and list items deployed, but not yet migrated to the target 
SharePoint. The second number is the total number of documents and list items in 
that particular location and all its nested hierarchy. 

 
Clicking a location in the tree displays the list of items in that location. The name of 
the item appears in the first column. Metadata property values and other 
information appear in the adjacent columns. 

To activate the various actions in Tzunami Deployer, select an item and choose a 
menu option or right-click an item to display a context-sensitive menu. All the actions 
in the context-sensitive menus are also available in the Data menu. When you select 
an item, only the options that are relevant to the selected item are made available 
for activation. All other options are deactivated. You can right-click an item and 
select Open to view it. In lists that support document versioning, you can view the 
versions of an item by right-clicking the item and selecting Versions. 
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4.2.1.2 Connecting and Loading SharePoint 2003  

SharePoint 2003 can be connected and loaded as either a source or a target in Tzunami 

Deployer. In order to load a SharePoint 2003 target, you must first connect to a SharePoint 

2003 server, for which you need a user account with the following permissions: 

• Administrative permissions on the SharePoint front end server (member of 

the local Administrators group). 

• Administrative permissions on the SharePoint sites. 

• Read permissions on the SQL Server Configuration Database of both source 

and target SharePoint. 

• Read permissions on the SQL Server Content Databases of source SharePoint 

sites. 

• Read/Write permissions on the SQL Server Content Databases of target 

SharePoint sites. 

• Read rights on the related Active Directory forest (recommended). 

• Execute permissions for the SQL Server stored procedure (in case of SQL 

Server 2005 only). 

• Administrative share “\\<SharePoint machine>\c$\Program Files\Common 

Files\Microsoft Shared\web server extensions” and all subfolders (if not granted to 

the Administrators group). 

• Remote registry access to “Local Machine\SOFTWARE\Microsoft\Shared Tools\Web 

Server Extensions\” and all sub keys (if not granted to the Administrators 

group). 

 
Tzunami Deployer cannot remotely access SPS2003/WSS2.0 servers when the 
backend database of SharePoint is built on the WMSDE edition of SQL Server. In this 
case Tzunami Deployer must be installed locally on the SharePoint machine. 

Missing DNS settings may hinder Tzunami Deployer’s ability to access 

SharePoint front end servers, SQL servers, or domain servers. In such case, 

copy the DNS servers’ definitions from the SharePoint servers.  

4.2.2 Office365 - SharePoint Online 

SharePoint Online can be connected and loaded as a target in Tzunami Deployer. In order to 

load SharePoint Online as a target, you must first connect to SharePoint Online for which 

you need a user account with the following role and permissions: 

• The login user in Deployer must be a Site Collection Administrator of SharePoint Site 

Collection to read and write data in SharePoint sites.  

• The login user in Tzunami O365 Active Directory service must be a member of Global 

administrator in Office 365 for your organization to provide consent for Tzunami 

azure app (TzunamiDeployerforOffice365) to read Users and Groups from Office 365 

using TzunamiO365ADService service. 
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Once, consent is provided for TzunamiDeployerforOffice365 azure app in Office 365, 

the TzunamiDeployerforOffice365 can be logged in with user having SharePoint 

Administrator role in Office 365. 

 
The user running Tzunami Deployer needs to be a Local Administrator (to get 
Registry and File System access). 

Tzunami Deployer can connects Microsoft Teams (i.e. the SharePoint Online site 

created for Microsoft Teams), OneDrive (i.e. the SharePoint Online site created for 

OneDrive) and the login user in Deployer must be a site collection administrator in 

respective sites. 

4.2.2.1 Connecting and Loading Microsoft Teams 

Tzunami Deployer can communicate with the Microsoft Teams SharePoint Online.  When 

Microsoft Teams SharePoint Online is connected through this mode, the Remote Service is 

no longer used. 

1. Click Data > Target SharePoint Online> Connect to Microsoft Teams Or  

Right-click on the Target Microsoft Teams tab and select Connect to Microsoft 

Teams. The Microsoft Teams Connection Wizard appears. 

 

Figure 4-28 Microsoft Teams Connection Screen 

 

 

 

 

 

 



 

  Page | 4-74  

2. Click Next. The Connection Wizard progresses to the Access SharePoint Server 

screen. 

 
Figure 4-29: Access Window for Microsoft Teams (SharePoint Online) 

3. In the Site Collection URL field, enter the URL of the Site Collection. For example: 
https://asteroidnepal.sharepoint.com/sites/TzunamiTeams. 

4. Click on Connect button. User does not need to provide login credential when 
using Azure Application with Applications. When using Delegated based Azure 
Application, a browser will be opened for credential to connect to the 
SharePoint site. Please, provide the credential for login. After successful login a 
SharePoint Structure screen appears. 

 
The browser will be opened based on the configuration in Deployer.exe.Config file 
which is located in the Tzunami Deployer installation location. 

By default, Edge browser is set. User can change the browse available in their 
system. The supported browsers are: “Edge”, “Firefox”, “Chrome” and “Internet 
Explorer” only. Please, open the Deployer.exe.Config file in elevated mode. Then, 
find <add key="WebAuthBrowser" value="Edge" /> key in the file. You can change 
the value for opted supported browser prior to run the Tzunami Deployer. 
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Content Tab 

The Content tab allows you to select site collection and List Types content to load into the 

Tzunami Deployer and whether to load items and their versions.  

  
Figure 4-30: Microsoft Teams Connection Wizard – SharePoint Structure - Content Tab 

 

 When connecting to target, it is not necessary to load versions of documents. 

Content Tab to load the Site contents. 

Table 4-3: SharePoint Structure – Content Tab  

Field Description 

List Types  

None No lists are loaded.  

Libraries Only Only libraries are loaded. 

All Lists All types of lists are loaded. 

Read Folders  

None (faster) No folders of lists and libraries are loaded. 

Immediate Child Folders Only immediate folders are loaded. 

All Folders All folders are loaded. 

Read Items Versions  

No items (faster) No item versions are loaded. 

Latest version only Only the latest item versions are loaded. 

All versions (slower) All item versions are loaded. 

Filter By List  

Use Comma(,) to separate list Enter name of Lists to load even if None option selected 
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5. Click Next. The Thank you for using the Connection Wizard screen appears. 

6. Click Done. Tzunami Deployer begins scanning the SharePoint Online and loads 

information about the selected site collection, including sub sites, lists, folders, 

files and list items.  

A Results window appears, displaying the load progress. 

 
Figure 4-31: Loading Target Microsoft Teams – Results Window 

 
You can stop the loading process at any time by closing results window, Right-clicking 
in the SharePoint area,& selecting Stop loading SharePoint to" You can stop the 
loading process at any time by closing results window, Right-clicking in the 
SharePoint area,& selecting Stop loading Microsoft Teams. 
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When the loading process is complete, you can browse the SharePoint Online 

structure in the Project window. For example: 

 
Figure 4-32: Loaded Target Microsoft Teams SharePoint Online 

The following table displays the various icons used by SharePoint Online to 

represent various types of items. 

 

Table 4-4: SharePoint Online Icons 

Icon Description 

 Web Application 

 SharePoint Site 

 List 

 Document Library 

 Picture Library 

 Folder  

 

 
Each item in the structure tree is followed by two numbers. The first number is the 
number of documents and list items deployed, but not yet migrated to the target 
SharePoint. The second number is the total number of documents and list items in 
that particular location and all its nested hierarchy. 

 
Clicking a location in the tree displays the list of items in that location. The name of 
the item appears in the first column. Metadata property values and other 
information appear in the adjacent columns. 

To activate the various actions in Tzunami Deployer, select an item and choose a 
menu option or right-click an item to display a context-sensitive menu. All the actions 
in the context-sensitive menus are also available in the Data menu. When you select 
an item, only the options that are relevant to the selected item are made available 
for activation. All other options are deactivated. 



 

  Page | 4-78  

You can right-click an item and select Open to view it. In lists that support document 
versioning, you can view the versions of an item by right-clicking the item and 
selecting Versions. 

 

4.2.2.2 Connecting and Loading OneDrive 

Tzunami Deployer can communicate with the OneDrive SharePoint Online.  When 

OneDrive SharePoint Online is connected through this mode, the Remote Service is no 

longer used. 

1. Click Data > Target SharePoint Online> Connect to OneDrive Or 

Right-click on the Target OneDrive tab and select Connect to OneDrive. The 

OneDrive Connection Wizard appears. 

 

Figure 4-33 OneDrive Connection Screen 

 

 

2. Click Next. The Connection Wizard progresses to the Access SharePoint Server 

screen. 



 

  Page | 4-79  

 
Figure 4-34: Access Window for OneDrive- SharePoint Online 

3. In the Site Collection URL field, enter the URL of the Site Collection. For example: 
https://asteroidnepal-my.sharepoint.com/personal/admin_asteroidnepal_com. 

4. Specify a Different user name and enter a password in the Password field. 
Or, select option Using Web Credentials. When Connect button is pressed, User 
does not need to provide login credential when using Azure Application with 
Applications. When using Delegated based Azure Application, a browser will be 
opened for credential to connect to the SharePoint site. Please, provide the 
credential for login. After successful login a SharePoint Structure screen appears. 
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Content Tab 

The Content tab allows you to select site collection and List Types content to load into the 

Tzunami Deployer and whether to load items and their versions.  

  
Figure 4-35: OneDrive Connection Wizard – SharePoint Structure - Content Tab 

 

Content Tab to load the Site contents. 

Table 4-5: SharePoint Structure – Content Tab  

Field Description 

List Types  

None No lists are loaded.  

Libraries Only Only libraries are loaded. 

All Lists All types of lists are loaded. 

Read Folders  

None (faster) No folders of lists and libraries are loaded. 

Immediate Child Folders Only immediate folders are loaded. 

All Folders All folders are loaded. 

Read Items Versions  

No items (faster) No item versions are loaded. 

Latest version only Only the latest item versions are loaded. 

All versions (slower) All item versions are loaded. 

Filter By List  

Use Comma(,) to separate list Enter name of Lists to load even if None option selected 
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5. Click Next. The Thank you for using the Connection Wizard screen appears. 

6. Click Done. Tzunami Deployer begins scanning the SharePoint Online and loads 

information about the selected site collection, including sub sites, lists, folders, 

files and list items.  

A Results window appears, displaying the load progress. 

 
Figure 4-36: Loading Target OneDrive – Results Window 

 
You can stop the loading process at any time by closing results window, Right-clicking 
in the SharePoint area,& selecting Stop loading SharePoint to" You can stop the 
loading process at any time by closing results window, Right-clicking in the 
SharePoint area,& selecting Stop loading OneDrive. 
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When the loading process is complete, you can browse the OneDrive structure in 

the Project window. For example: 

 
Figure 4-37: Loaded Target OneDrive- SharePoint Online 

The following table displays the various icons used by SharePoint Online to 

represent various types of items. 

 

Table 4-6: SharePoint Online Icons 

Icon Description 

 Web Application 

 SharePoint Site 

 List 

 Document Library 

 Picture Library 

 Folder  
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4.2.2.3 Connecting and Loading SharePoint Online 

Tzunami Deployer can communicate with the SharePoint Server Online.  When SharePoint 

Server Online is connected through this mode, the Remote Service is no longer used. 

1. Click Data > Target SharePoint Online> Connect to SharePoint  Or  

Right-click on the Target SharePoint Online tab and select Connect to 

SharePoint. The SharePoint Online Connection Wizard appears. 

 

Figure 4-38 SharePoint Online Connection Screen 

 
In this mode, Remote service is not used to communicate with SharePoint On-Premise Server. 
However, user needs to configure the Blocked Extensions file relevant to SharePoint On-
Premise server.  

2. Click Next. The Connection Wizard progresses to the Access SharePoint Server 

screen. 
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Figure 4-39: Access Window for SharePoint Online 

3. In the Site Collection URL field, enter O365 admin URL. For example: 
https://asteroidnepal-admin.sharepoint.com.  
You can enter the full URL of a SharePoint site collection as well for example:   
https://asteroidnepal.sharepoint.com/sites/tzuanami. 

 
Figure 4-40 O365 admin url in SharePoint Online connection 

4. Select option Using Web Credentials. When Connect button is pressed, User 
does not need to provide login credential when using Azure Application with 
Applications. When using Delegated based Azure Application, a browser will be 
opened for credential to connect to the SharePoint site. Please, provide the 
credential for login. After successful login a SharePoint Structure screen appears. 
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Sites Tab 

The Sites tab allows you to select List of active site collections in O365. 

 
Figure 4-41 SharePoint Connection Wizard - Sites Tab 

Select the site from the list and go to Content Tab. 

Content Tab 

The Content tab allows you to select site collection and List Types content to load into the 

Tzunami Deployer and whether to load items and their versions.  

  
Figure 4-42: SharePoint Connection Wizard - Content Tab 

 When connecting to target, it is not necessary to load versions of documents. 
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Content Tab to load the Site contents. 

Table 4-7: SharePoint Structure – Content Tab  

Field Description 

List Types  

None No lists are loaded.  

Libraries Only Only libraries are loaded. 

All Lists All types of lists are loaded. 

Read Folders  

None (faster) No folders of lists and libraries are loaded. 

Immediate Child Folders Only immediate folders are loaded. 

All Folders All folders are loaded. 

Read Items Versions  

No items (faster) No item versions are loaded. 

Latest version only Only the latest item versions are loaded. 

All versions (slower) All item versions are loaded. 

Filter By List  

Use Comma(,) to separate list Enter name of Lists to load even if None option selected 

5. Click Next. The Thank you for using the Connection Wizard screen appears. 

6. Click Done. Tzunami Deployer begins scanning the SharePoint Online and loads 

information about the selected site collection, including sub sites, lists, folders, 

files and list items.  

A Results window appears, displaying the load progress. 

 
Figure 4-43: Loading Target SharePoint Online – Results Window 

 
You can stop the loading process at any time by closing the Results window, right-
clicking in the SharePoint area, and selecting Stop Loading SharePoint. 
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When the loading process is complete, you can browse the SharePoint Online 

structure in the Project window. For example: 

 
Figure 4-44: Loaded Target SharePoint Online 

The following table displays the various icons used by SharePoint Online to 

represent various types of items. 

Table 4-8: SharePoint Online Icons 

Icon Description 

 Web Application 

 SharePoint Site 

 List 

 Document Library 

 Picture Library 

 Folder  

 

 
Each item in the structure tree is followed by two numbers. The first number is the 
number of documents and list items deployed, but not yet migrated to the target 
SharePoint. The second number is the total number of documents and list items in 
that particular location and all its nested hierarchy. 

 
Clicking a location in the tree displays the list of items in that location. The name of 
the item appears in the first column. Metadata property values and other 
information appear in the adjacent columns. 

To activate the various actions in Tzunami Deployer, select an item and choose a 
menu option or right-click an item to display a context-sensitive menu. All the actions 
in the context-sensitive menus are also available in the Data menu. When you select 
an item, only the options that are relevant to the selected item are made available 
for activation. All other options are deactivated. 

You can right-click an item and select Open to view it. In lists that support document 
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versioning, you can view the versions of an item by right-clicking the item and 
selecting Versions. 

4.2.2.4 Connecting and Loading SharePoint Online using Migration API  

Tzunami Deployer supports Azure Storage subscribed by the organization (or other 

vendors) and provided by the Microsoft as well. For the Azure Storage subscribed by the 

organization, user should manually configure the storage account details and provide the 

parameter in Deployer whereas for the Microsoft provided azure storage no such 

parameters should be provided in Deployer. Please, contact your SharePoint Administrator 

for more about Azure Storage configuration. 

Before proceeding, configure the Migration API settings in Deployer Options. Please, refer 

section Migration API. 

To connect to SharePoint Online using Microsoft Azure Storage Account  

1. Click Data > Target SharePoint Online> Connect to SharePoint Or 

Right-click in the Target SharePoint Online tab and select Connect to 

SharePoint. The SharePoint Online Connection Wizard appears. 

Then check on Migration API check box. 

 
Figure 4-45: SharePoint Online– Welcome Screen 

Table 4-9: SharePoint Online Connection Wizard 

Field Description 

Migration API Select this option to connect to SharePoint Online using Microsoft 
Azure Storage Account. 

 
If this option is not checked, Tzunami Deployer will 
connect to SharePoint Online without using Migration 
API. 
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2. Click Next. The Connection Wizard progresses to the Access SharePoint 

Server screen. 

 
Figure 4-46: Access Window for SharePoint Online using Migration API 

3. In the Site Collection URL field, enter O365 admin URL. For example:  
https://asteroidnepal-admin.sharepoint.com. 
You can enter the URL of a SharePoint site collection as well for example:   
https://asteroidnepal.sharepoint.com/sites/tzuanami. 
 

 
Figure 4-47 SharePoint Connection Wizard – Connection Screen 

 

https://asteroidnepal-admin.sharepoint.com/
https://asteroidnepal.sharepoint.com/sites/tzuanami
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4. Select option Using Web Credentials. When Connect button is pressed, User 
does not need to provide login credential when using Azure Application with 
Applications. When using Delegated based Azure Application, a browser will 
be opened for credential to connect to the SharePoint site. Please, provide 
the credential for login. After successful login a SharePoint Structure screen 
appears. 

5. Click Next. The Connection Wizard progresses to the Web Applications 

screen. Continue following the wizard 

4.2.3 On-premise As Online 

Tzunami Deployer connects with SharePoint On-Premise server using Tzunami Remote 

Service which should be installed in the SharePoint server. However, Tzunami Deployer 

provides a feature in which Tzunami Remote Service in not used. Hence, Tzunami Deployer 

connects with SharePoint On-Premise server like SharePoint online. This feature is 

worthwhile, in case, your organization does not allow to install Tzunami Remote Service in 

SharePoint server.  

You must have valid license for SharePoint Online from Tzunami Inc. to use this feature. 

4.2.3.1 Connecting and Loading SharePoint 2019 As Online 

Tzunami Deployer can communicate with SharePoint Server 2019 through   SharePoint 

Online connection wizard.  When SharePoint Server 2019 is connected through this mode, 

the Remote Service is no longer necessary. 
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1. Click Data > Target SharePoint Online> Connect to SharePoint 2019 As Online Or  

Right-click on the Target SharePoint 2019 As Online tab and select Connect to 

SharePoint 2019 As Online. The SharePoint 2019 As Online Connection Wizard 

appears. 

 

Figure 4-48 SharePoint 2019 As Online Connection Screen 
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2. Click Next. The Connection Wizard progresses to the Access SharePoint Server screen. 

 
Figure 4-49: Access Window for SharePoint 2019 As Online 

3. In the Site Collection URL field, enter the URL of the Site Collection.  
4. Specify a Different user name and enter a password in the Password field. 

 
If Tzunami Deployer fails to connect to SharePoint, verify that you provided all the 
required permissions to the user, as specified in the Tzunami Deployer Installation 
Guide. 

Clicking Auto-scroll scrolls down to display the latest progress messages, as they 
appear. 

Clicking Errors only filters the displayed progress messages to show error messages 
only. 

Clicking Warnings only filters the displayed progress messages to show warning 
messages only. 
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5. Click Next. The Connection Wizard progresses to the Web Applications screen. 

 
Figure 4-50: SharePoint Connection Wizard – Web Applications Screen 

 

6. Select one or more Web Applications to load and click Next. The SharePoint Structure 

appears with tabs: Sites, Content, and Active Directory. 

Sites Tab 

The Sites tab allows you to select site collection to load into the Deployer 

Project.  

  

Figure 4-51: SharePoint Connection Wizard – SharePoint Structure - Sites Tab  
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Loading of SharePoint content may be a lengthy process, depending on the 
amount of content, the type of network, and the workload of the SharePoint 
Online.  

When connecting to Microsoft SharePoint Online, it is not necessary to select site 
collection and item to load into the project. Tzunami recommends that you only 
load the site collections and portal sites that are the targets for your current 
project. 

Site collection and Items that are not loaded at this stage appear grayed out in 
the Project window. Such items can be reloaded at a later time. 

 

7. Click Sites Tab to load the SharePoint site collection and portal sites. 

Table 4-10 SharePoint Structure – Sites Tab 

  

 Field 

Description 

Find Enables you to Find the site collection containing the text in the site 

collection by typing in the text box. 

Read sub sites • Immediate – Reads immediate sub sites of selected Site 

Collections 

• All – Reads all sub sites of selected Site Collections. 

Reverse Check Enables to toggle the selection of sites. 

 

Content Tab 

The Content tab allows you to select List Types content to load into the Tzunami 

Deployer and whether to load items and their versions.  

  
Figure 4-52: SharePoint Connection Wizard – SharePoint Structure - Content Tab 

Active Directory Tab 
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The Active Directory tab allows you to load user and groups from Active Directory 

domains. 

 
Figure 4-53: SharePoint Connection Wizard – SharePoint Structure - Active Directory Tab 

8. Click Next. The Thank you for using the Connection Wizard screen appears. 

9. Click Done. Tzunami Deployer begins scanning the SharePoint Online and loads 

information about the selected site collection, including sub sites, lists, folders, files 

and list items.  

A Results window appears, displaying the load progress. 

 
Figure 4-54: Loading Target SharePoint On-Premise– Results Window 
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 You can stop the loading process at any time by closing the Results window, right-
clicking in the SharePoint area, and selecting Stop Loading SharePoint. 

When the loading process completes, you can browse the SharePoint structure in 

the Project window. 

 
Figure 4-55: Loaded Target SharePoint 

The following table displays the various icons used by SharePoint Online to 

represent various types of items. 

 

Table 4-11: SharePoint Online Icons 

Icon Description 

 Web Application 

 SharePoint Site 

 List 

 Document Library 

 Picture Library 

 Folder  

 

 
Each item in the structure tree is followed by two numbers. The first number is the number 
of documents and list items deployed, but not yet migrated to the target SharePoint. The 
second number is the total number of documents and list items in that particular location 
and all its nested hierarchy. 

 
Clicking a location in the tree displays the list of items in that location. The name of the item 
appears in the first column. Metadata property values and other information appear in the 
adjacent columns. 

To activate the various actions in Tzunami Deployer, select an item and choose a menu 
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option or right-click an item to display a context-sensitive menu. All the actions in the 
context-sensitive menus are also available in the Data menu. When you select an item, only 
the options that are relevant to the selected item are made available for activation. All other 
options are deactivated. 

You can right-click an item and select Open to view it. In lists that support document 
versioning, you can view the versions of an item by right-clicking the item and selecting 
Versions. 

4.3 RELOADING SHAREPOINT ITEMS 
If you choose not to read all the sites or lists in the SharePoint Structure screen of the 

SharePoint Connection Wizard, they appear in the SharePoint tree, grayed out and 

unavailable. Similarly, if changes are made to SharePoint after it is loaded into Tzunami 

Deployer, those changes are not reflected in your Tzunami Deployer project. In both cases, 

you can refresh the SharePoint information in the Tzunami Deployer project by reloading 

selected items. Moreover, Tzunami Deployer provides an option Update Migration DB to 

check. So, the user may reload items in current project only or may reload the items in current 

project along with updating information in Link Resolver Service’s database, too. 

4.3.1 Reload SharePoint items to Current project only 

The reload operation in Tzunami Deployer can be performed to get the latest data from the 

SharePoint Site or selected item as required. To update the information in the current 

Deployer project only, perform the following steps: 

1. In the Target SharePoint tab, right-click the desired item and select Reload 

Item. The Load SharePoint Items window appears. 

 
Figure 4-56: Load SharePoint Items Window 

2. Select which items you wish to reload and whether to load all document 

versions. 

3. Select option to read sub sites and select radio button to read immediate 

only or all as required. 

4. Check option to read security and metadata or not. 
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5. Make sure Update Migration DB option is unchecked to reload items in 

Deployer tree only. If this option is checked, then Migration DB also gets 

updated. 

6. Click OK. A Results window appears, displaying the load progress. The items 

are reloaded into your project window. 

4.3.2 Reload SharePoint items to Current project including update in 

Migration Database 

The reload operation in Tzunami Deployer can be performed to get the latest data from the 

SharePoint Site or selected item as required. The latest information for selected site/item is 

updated in the current Deployer project by default. Moreover, when Update Migration DB 

option is checked, the information is stored in the migration database, too. The migration 

DB is located at C:\ProgramData\Tzunami\Tzunami SPO Migration. 

To reload item in the current Deployer project as well as update the information in 

Migration DB database, perform the following steps: 

1. In the Target SharePoint tab, right-click the desired item and select Reload 

Item. The Load SharePoint Items window appears. 

 
Figure 4-57: Load SharePoint Items Window 

2. Select which items you wish to reload and whether to load all document 

versions. 

3. Check Update Migration DB option. 

4. Click OK. A Results window appears, displaying the load progress. The items 

are reloaded into your project window and updated the same in Link 

Resolver Services database. 
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4.3.3 Clear Migration Database 

Tzunami Deployer provides an option to clear the data from migration database. If test data 

need or old data from migration database should be removed, user can perform the action 

from the target tree view of the Deployer migration project. 

Perform the following steps in target source tree view of the project: 

1. Right click on item in the target source. A Lists/Libraries can be selected as required. 

2. Click on Clear Migration DB option. 

 
Figure 4-58 Clear Migration DB option 

3. In the confirmation window, click on Yes button. 

 
Figure 4-59 Confirmation to clear migration database 

The information for updated action is displayed. 
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4.3.4 Benefits of using Update Migration DB option 

Tzunami Deployer provides an option Update Migration DB. When this option is checked, 

henceforth the items migrated successfully are updated in the migration database. Any 

instance of Tzunami Deployer in the same machine can identify the migrated items from 

other instances of Deployer at the runtime without reloading. Therefore, following benefits 

are achieved. 

1. Information of successfully migrated items from an instance of Tzunami Deployer is 

available to other instances of Tzunami Deployer instantly. Therefore, there is no need 

of reloading process for the information of latest changes made in target through other 

instances of Tzunami Deployer. 

2. The reloaded information of target from an instance of Tzunami Deployer is available to 

other instances of Tzunami Deployer instantly. So, reloading items in each Tzunami 

Deployer is no longer needed. 

3. Since the reloaded information of target items from an instance of Tzunami Deployer is 

available to all other instances of Tzunami Deployer, the operational cost of reloading 

needed in each instance of Tzunami Deployer is reduced. 

4. Incremental migration of same item in same library can be accomplished with reloading 

library only (not all items necessarily). 

4.4 REFRESH O365 USERS AND GROUPS 
Tzunami Deployer loads the users and groups from O365 Azure Active Directory as well while 

connecting to SharePoint Online target. There are two options: one using O365 AD Service 

and another is using Rest API to load users and groups. Based on the options, latest updates of 

users and groups are loaded in SharePoint Online target panel of the project. 

When there are recent changes in the users and groups in O365 Azure Active Directory that 

changes are updated in O365 AD Service. User can reflect those changes in SharePoint Online 

target panel for pre-load target source. To do so, perform the following steps: 

1. Right click on target source tree view 

2. Click on Refresh Users & Groups option 
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Figure 4-60 Refresh Users and Groups 

3. Number of recently updated users and groups are displayed 

 
Figure 4-61 Number of updated users and groups 

 The recently updated users and groups are displayed in three categories.  

• Added: recently added users and groups. 

• Removed: recently deleted/sign-in blocked users and groups. 

• Restored: recently restored deleted/sign-in enabled users and groups. 

The added and restored users and groups are now available in users and groups mapping, 

whereas removed users and groups are not available in users and groups mapping. 

4.5 REMOVING SHAREPOINT PROJECT 
You can load a different SharePoint server into the current Tzunami Deployer project or you 

can reload SharePoint content in all the virtual servers by removing the SharePoint 

information from the Tzunami Deployer project and loading a new SharePoint target. 
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To remove a SharePoint target: 

• Right-click in the Target SharePoint tab and select Remove SharePoint from 

Project. All target SharePoint information is removed from the project. 

 The project is automatically saved after the SharePoint is removed. 

4.6 HANDLE THROTTLING WITH SHAREPOINT ONLINE 
SharePoint online maintains optimal performance and reliability of the SharePoint Online 

service through throttling. Throttling limits the number of user actions or concurrent calls to 

prevent overuse of resources. It’s very rare to get throttled while using Tzunami Deployer. 

But, a very large number of CSOM calls might be requested while running multiple instances 

of Deployer or large number of items loaded/migrated at once. In such scenarios, some 

requests may get throttled and encountered errors for some operations.  

To get rid of errors due to throttling, Tzunami Deployer provides configurable settings in 

Deployer.exe.config file. User need to carry out the following steps to configure the 

settings: 

1. Navigate to the directory where Tzunami Deployer is installed. 

(for example: C:\Program Files (x86)\Tzunami\Deployer 4.0) 

2. Open the Deployer.exe.config file in edit mode. 

3. Locate the settings <!--Setting for handling the case of Throttling for CSOM call in case 

of Online--> under appSettings node. 

4. Increase the value for NumberofRetry and/or MaximumDelay 

 

Figure 4-62 Settings for Handling the case of Throttling for CSOM call. 

5. Save the file. 

6. Run the Deployer. 

4.7 SPLIT SOURCE CONTENT 
In any ECM system, a folder may have a fixed number of maximum data items. This value 

differs from one ECM system to another ECM system. Therefore, the source ECM system 

and SharePoint may have the different value for maximum number of items limit in a list. If 

the source ECM system supports greater number of maximum number of items in a list, then 

a case may encounter where the number of items in a list crosses the maximum limit in 

SharePoint. In such case, the exceeded number of items get failed during migration in 

Tzunami Deployer. To overcome such limitation, the items in the source list should be split. 
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Tzunami Deployer provides a feature to split the number of items of a source to a user 

defined value during the loading of source content in Tzunami Deployer Migration Project. If 

the target lists already have the data items that items should be considered for the item 

count. 

Steps for Spit Content in Deployer migration project considering the items in target lists 

1. Create or open the Deployer Migration Project, then load the tdx file in source panel. A 

tdx file browsing window appears. 

 
Figure 4-63 TDX File Browsing Window 

Enter the name, browse the tdx file. 

 

2. Connect the target site and load the contents. 

 
Figure 4-64 Deployer Migration project 
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3. Select a list in source item in source panel, then click on List threshold split option. 

 
Figure 4-65 List Split Option 

4. In target Items window, select the list in which source data to be migrated. Then, click 

on OK button. 

 
Figure 4-66 Deploy in Target. 
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5. In the Split For Target screen, number of items deployed from source is displayed in 

Source section. Number of items in target list is displayed in Target section. 

 
Figure 4-67 Items counts in Source and Target lists 

6. Select appropriate value to split the content. Consider the value appeared in Target 

section while specifying the value. Sum of Split on and Target Item count should not 

exceed the SharePoint list threshold value. Then, click on OK button. 

 

7. In the Reload Project confirmation window, click on Yes button. 

 
Figure 4-68 Confirmation screen for split content. 
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8. The Deployer migration project is reloaded. The source panel displays the divided 

content in the source panel. 

 
Figure 4-69 Split content screen 
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4.8 GLOBAL ACL MAPPING 
Tzunami Deployer provides a feature to map the source Users, Groups and Roles mapping in 

Deployer Migration project. This mapping should be performed before starting the 

deployment process. Once mapping for source’s Users, Groups and Roles and save in global 

mapping location, the ACL will be automatically mapped in deployment process. 

 
This feature is only supported for Target SharePoint Online, OneDrive and Teams. It is disabled for the 
target SharePoint On premise. 

Steps for Global ACL Mapping in Deployer migration project  

1. In Deployer Options, make sure Global Use Global Mapping option under Mapping is 

configured. 

 
Figure 4-70 Option Mapping: Use Global Mapping option 

2. In tool bar of Deployer Migration project, click on Global ACL or right click on source 

pane, then click on Export ACL option. 
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Figure 4-71 Global ACL: Load Global ACL screen 

 

3. In Load Global ACL window, click on Load [Exporter] button. 

The Tzunami Exporter application opens. Proceed the application by clicking on Next 

button with valid credential until tree view of source items appears in screen with 

Export Global ACL option is displayed. 

 
Figure 4-72 Global ACL: Export Global ACL screen in Exporter 

 

4. Click on Export Global ACL. 
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Figure 4-73 Global ACL: Global_ACL of Source ECM 

The Users, Groups and Roles from source ECM is exported to a file and saved in a 

folder. Save the file in default location. 

 

5. A confirmation window appears for exported source ACL in file. Click on OK button. 

 
Figure 4-74 Global ACL: Source ECM Global ACL file. 

6. Now, cancel the Tzunami Exporter screen by clicking on Cancel button as we have 

exported global ACL information and do not want to proceed to export the data at this 

point. Proceed the cancel process as guided through the wizard. 

 

7. Click on Load [XML] button in the Load Global ACL window. The Users, Groups and Roles 

are loaded. 
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Figure 4-75 Global ACL: loading source ACL 

8. In Target ACL, enter the target SharePoint site collection URL. To load the target Users, 

Group and Roles, clicking on Load [Service] or Load [XML] in target ACL using Tzunami 

O365 AD Service or Rest API configured for API Settings under Security>Active Directory  

in Deployer options. 

 



 

  Page | 4-111  

––

 
Figure 4-76 Global ACL: loading target ACL 

 

The Entities tab displays the Users and Groups whereas the Roles tab shows the roles of 

source and target in respective left and right panels. The Users and Groups check boxes 

are available to filter the users and groups in the list and search boxes are available to 

filter the users, groups and roles by typing the name. Also, the Load button on the 

button will load the already mapped users, groups and roles in mapping panel if exists. 

 

9. In Entities and Roles tabs, select the user, group or role from source and target as 

required and click on Map button in right side of the panel. All users, groups and roles 

mapped are displayed in mapping panel in respective panel. The mapped users, groups 

and roles can be selected and removed one by one if required by clicking Remove 

button on or can be removed all by clicking on Remove All button at once. 
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Figure 4-77 Global ACL: Mapped Users, Groups and Roles 

User can map source group to Create New Group. Mapping to create new group will 

create the same group name in target SharePoint site. Mapping multiple source 

groups to single create new group will create a single group having first mapped 

group name in the target SharePoint site. 

10. After mapping all users, groups and roles as required, click on Save button. The 

confirmation window shows the mapping files created and saved location. Click on Yes 

button. 

 
Figure 4-78 Global ACL: Confirmation for saving global acl mapping 
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In case of source group mapped with Create New Group, new group with same 

name as source group is created in target SharePoint immediately while saving. User 

can click on Yes button to create new group to load the newly create group in target 

ACL panel of Load Global ACL window so that user can map another source group to 

the newly created group in target SharePoint. 

 
Figure 4-79 Reload newly created group confirmation 

When new group is created, user needs to load/reload the target SharePoint in 

Deployer project to reflect the changes. 

11. In the confirmation window for saved files, click on OK button. 

 
Figure 4-80 Global ACL: Confirmation for saved global ACL 

 

12. Click on Close button. Then, in every Deployer migration project, make sure that Use 

Global Mapping option is used and location for mapping files are pointing correctly. The 

mapping wizards for Users, Groups and Roles will automatically references the required 

files and shows the mapped data accordingly in respective wizard screens. 
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4.9 BEST PRACTICE 
• Use a template project: Create one project as a template, preferably with the 

SharePoint target loaded. Clone this project (using the Save As option) multiple 

times – in accordance to the data exported in the export phase. 

• Be organized: Verify that your project files are saved under a well-organized file 

system hierarchy. 

• Prepare a project for Deploying: 

• Open one of the projects you have created. 

• Load the source data into that project. Load the structure and then reload 

desired content within it. 

• Reload the target destination site/sub-site/list which may not be fully loaded 

(if you loaded it only partially). If there are many documents in a target list, 

for example, it may be unnecessary to load all the existing documents when 

reloading that list. However, choosing not to load this could prevent 

Tzunami Deployer from identifying duplicate file names. 

• Document versions for target need not be loaded. 

• Work on multiple projects in parallel. You can run 3 instances of Deployer on 

one front end server (assuming 4GB RAM, 2 GHz Xeon processor server 

configuration). However it is recommended that the instances be increased 

or decreased based on server load. 

5 MODELING TARGET SHAREPOINT 

This chapter explains how to model target SharePoint and deploy the source content. This 

chapter contains the following topics: 

• Modeling Target SharePoint  
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5.1 MODELING TARGET SHAREPOINT 
Tzunami Deployer enables you to model your target SharePoint, into which the source 

content will eventually be migrated. You can model: 

• Structure – Create or modify site collection, sites, portal areas (SPS2003 only), 

libraries, lists and folders. 

• Metadata – Design the property sets and properties that comprise the columns of 

the target SharePoint lists. 

• Security and Permissions – Create or modify groups and permissions levels, add 

users and assign permissions. If you are satisfied with your existing target SharePoint 

structure and do not wish to make any modifications to it, you can skip this section 

and proceed to the deploying step. 

After loading a target SharePoint, you can model your target SharePoint.  

 
Modeling a SharePoint target does not actually modify your server. All changes are made in your 
Tzunami Deployer project and are only applied to the target SharePoint when you migrate them. 

5.1.1 Modeling SharePoint Structure 

Tzunami Deployer enables you to use its simple and intuitive interface to create, delete, or 

modify items in the target SharePoint structure. SharePoint 2007/2010/2013/2016/2019 or 

SharePoint Online supports creating folders under lists. SharePoint 2003 only supports 

creating folders under libraries. Tzunami Deployer also enables you to edit the properties of 

existing SharePoint items. You can right-click the following items and select an action from 

the context sensitive menu: 

• Sites 

• Portal Areas 

• Lists 

• Folders 

• Items 

 

 
You can also rename an item by selecting it and pressing F2. SharePoint imposes 
some character and length limitations on item names. Tzunami Deployer may 
rename folders or documents by replacing invalid characters with an underscore (_). 

These procedures are similar to the procedures used in the native SharePoint 
environment. Any SharePoint item can be deleted, except for virtual servers and 
some built-in lists. 

The icons of newly created items in Tzunami Deployer are displayed with a star ( ) overlay. 

Similarly, the icons of modified items in Tzunami Deployer are displayed with a pencil ( ) 

overlay. The overlays signify that the particular item exists or is modified in the Tzunami 

Deployer project only, and not in SharePoint. For example: 
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 – Existing unmodified document library. 

 – Existing modified document library. 

 – New document library. 

The overlays are removed after the changes are migrated. 

5.1.1.1 Creating a New Site 

Tzunami Deployer allows you to create new sites on the target SharePoint Structure. New 

site can be added as a site collection, if created under the virtual server or a web 

application, or as a sub-site, if created under another site, from the templates (like Blogs, 

My Sites, Team Sites, Meeting Workspaces etc.) and according to the location you selected 

in the target SharePoint. 

To create a SharePoint site in Tzunami Deployer: 

1. Right-click the location in the target SharePoint in which to create the new 

site and select New > Site. The New WSS Site window appears. 

  
Figure 5-1: New WSS Site Window 

 
When you create a site collection, the Owner field is enabled (since only site 
collection have owners) and the Use unique permissions checkbox is disabled (since 
site collection always have unique permissions – they cannot inherit permissions 
from their parent, for they do not have a parent). When you create a sub-site, the 
opposite is true. 
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2. Enter information describing the URL. A SharePoint site URL is comprised of 

the following: 

• Server address – The server URL, such as http://moss.tzunami.net.  

This value can also be an IP address. 

• Managed path – Typically sites/ or personal/. Additional managed 

paths can be configured in SharePoint. 

• Hierarchy of site group and parent sites – Relevant for sub sites 

only. 

• Site name – For a site collection, enter a site name and select the 

managed path from the drop-down list. For any other site, enter the 

site name. 

3. Enter a Title and Description to be used for the new SharePoint site. 

4. Select the Site Template to be used. When you select a template, a short 

description is displayed below it. 

 
For a site collection, enter the owner account. 

For sub sites, select whether the site should use unique permissions. If you do not 
select Use unique permissions, the site inherits the permissions of its parent site. 

5. Click OK.  

The new SharePoint site is added to the target SharePoint tree. The 

configuration of the new site is determined by the SharePoint site template 

you selected. 

  
Figure 5-2: Tzunami Deployer Project Window – Target SharePoint Site 
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5.1.1.1.1 Creating a New List in a SharePoint Site 

Tzunami Deployer allows you to create new lists on the target SharePoint Structure. New 

list can be created in a site or portal area from the templates in the target SharePoint. 

To create a new list in a SharePoint site: 

1. Right-click a site or portal area and select New > List. The New SharePoint 

List window appears. 

  
Figure 5-3: New WSS List Window 

2. From the Template drop-down list, select the list template you want to use 

(For e.g. Document Library). 

3. Enter a name and description for the new library and click OK. 

The new library is created. 

 
You can select Display list on the Quick Launch for quick launch display. You can also 
select Specify relative URL, and specify the URL of the list. This is not a SharePoint 
option. 
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5.1.1.1.2 Editing Properties of SharePoint Item 

Different types of items have different properties and settings that can be edited, as 

follows: 

• Sites that are created in Tzunami Deployer and have not yet been migrated 

to the target SharePoint can be edited using the Edit Site option. Properties 

of all sites can be viewed using the Properties window. The URL, language, 

and template of the site cannot be edited. 

• Lists, folders, files, and list items can be edited using the Properties window. 

 

 
The Properties window can remain open while you work in the Project window. It 
reflects the properties of the currently selected item. 

Several items can be simultaneously edited using the Properties window. 
 

You can edit the properties of new sites till they are migrated to the target SharePoint. 

However, you cannot edit the properties of sites that already exist in SharePoint. Such 

existing sites can only be viewed in the Properties window. 

To edit properties of a new site: 

1. Right-click a new site in the target SharePoint tree and select Edit Site. The 

New WSS Site window appears (Figure 5-1) with the non-editable fields 

disabled. 

2. Modify all the enabled properties and click OK. 

The site’s properties are edited. 

5.1.1.1.3 Find and Replace Folder or File Names 

The Find and Replace window is used to make naming corrections to files and folders 

within Document Libraries. 

To correct file and folder names within Document Libraries: 
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1. Right-click on the target SharePoint tree and select Find & Replace.  

The Find and Replace window is displayed. 

 
Figure 5-4 Find and Replace window for ‘Single Input’ option. 

 

 
Figure 5-5: Find and Replace Window for Use Mapping File option. 
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2. Click on Single Input tab.  

OR 

Click on Use Mapping File tab. Click on Browse button. Locate the 

FindAndReplaceSample.xml file. The FindAndReplaceSample.xml file has to 

be configured before browsing it. This file provides the options to configure 

the text to be found and replaced with. Also, there are options to apply find 

and replace for Folders or Files or both separately along with using RegEx 

pattern and match-case or not.  

 

Figure 5-6: Configuration of FindAndReplaceSample.xml file 

Then, proceed to step no 6. 

3. Enter text in Find field.  

4. Select the Match Case checkbox for case-sensitive searches. 

5. Type the replacing text in the Replace field.  

6. Click List Items. 

A list of folders and files containing the text you entered in the Find field, 

along with their expected name, appears. 

7. Select the files or folders you want to change by selecting their 

corresponding checkboxes. 

Select All Items under Select dropdown, to list all items, based on search 
criteria. 

OR 

Select Problematic Items under Select dropdown, to list problematic items 
only, based on search criteria 

AND/OR 

Check Folder checkbox, to list all folders only, based on search criteria. 
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AND/OR 

Check Document checkbox, to list files only, based on search criteria. 

 

8. Click Truncate long item name. 

Long file names and folder names will get truncated to the Maximum 

filename length set in the Deployer Options Auto Fixes settings. Click 

Rename Items. 

The names are renamed. 

 
If Automatic truncation option is enabled in Tools>Options…>AutoFixes, a 
confirmation message will be displayed. User can confirm to discard automatic 
truncation by clicking on No button or to apply automatic truncation as well (if 
applicable) by clicking on Yes button. 

 

9. Select Replace name checkbox to replace folder/file names.  

10. Select Replace extension checkbox to replace file extensions.  

11. Click on Close icon   to close the window. 

 
You can leave the Replace field empty to remove the searched value from all names. If 
all characters in name are replaced with empty value, Deployer will keep “_” in name 
by default. 

The Select Problematic Items is very useful if you have just deployed content but have 
yet to migrate it, and would like to prevent illegal naming, blocked extensions, and 
long URLs in SharePoint. For example, replacing “Business Intelligence” with “BI” is a 
good solution for handling long URLs. 
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5.1.1.1.4 Generate mapping file for find and replace for migration project. 

Steps to auto generate Find_Replace.xml file in Project Location: 

1. Right click on the target library., then click on to Find and Replace the items which are 

exceeding the SharePoint limitations.  

 
Figure 5-7 Find and Replace Window 

      Find and Replace window opens with Single Input and Use Mapping File tabs. 

2. In the Single Input tab,  

Enter the characters that you want to replace in the Find field for the problematic items, 

then enter the characters that you want to replace with. Then click on button Add to 

Mapping button. 

 
Figure 5-8 Create Find and Replace file in project location. 
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In the confirmation window, click on OK button. 

 

Figure 5-9 Added Find and Replace entry. 

A Find_Replace.xml is created and the entry is updated in the Reports folder in the 

project location. 

3. Find_Replace.xml file looks as below: 

 
Figure 5-10 Find and Replace file. 

4. Repeat step 2 as necessary for other entries that you want to create. 

5. Once the entries are updated the in Find_Replace.xml file, browse it file from the 

Reports folder in project location as shown in below screenshot. You can re-use the xml 

file if there is issue in initial migration and must re-migrate same set of data. 

 

Figure 5-11 Import Find and Replace xml file. 
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6. Click on List Items button to list the problematic items and Rename Items button to 

replace in the selection items. 

 

Figure 5-12 Replace the problematic items. 

 
You must click on Add to Mapping button before renaming the items to map the 
renamed items in Find_Replace.xml file on each Find and Replace action. 

 

5.1.1.2 Find and View Items 

5.1.1.2.1 Viewing Item Properties 

You can view the metadata properties or other attributes of various objects in Tzunami 

Deployer. The Properties window displays the properties of the currently selected item. If 

more than one item is selected, a property whose value is not the same for all items 

appears empty. Editing such a property affects all the selected items. Read-only 

properties are grayed out in the Properties window. The Properties window can remain 

open while you work in the Project window.  

To view an object’s properties: 

• Right-click an item and select Properties. 

Or 

Click . 

Or 

Press F4. 

The Properties window appears. 
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Figure 5-13: Properties Window 

 
Only items that appear in Bold can be edited. 

You can modify user or multi user type properties (For e.g. Created By, Modified By)  

     

 To modify user type properties from Select People window. 

1. Select the user type property and click  button in Properties window. The Select 

People window will appear. 

2. Click Search and select users that you want to add and then click Add->. 

3. Click OK. 

 

Figure 5-14: Select People Window 
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5.1.1.2.2 Finding Item Versions 

You can view the versions of various items in Tzunami Deployer. The Versions window 

displays the properties of each version of the item.  

To view an item’s versions: 

• Right-click an item and select Versions. 

The Versions window appears. 

 
Figure 5-15: Versions Window 

5.1.1.2.3 Finding Items 

You can find one or more items in a project. The Find window enables you to find items 

based on different criteria and properties.  

To find items: 

• Select View > Find > Find or Find All. 

The Find window appears. 

 
Figure 5-16: Find Window 
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Table 5-1: Find window Fields 

Field Description 

Find what The text to search 

Look in Select a search scope from this list: 

• All 

• Sources Only 

• Currently Selected Source 

• Target Only 

Find options  

Match case Only find instances of the Find what texts that are matched both by 
content and by case. For example, searching for "MyObject" with 
Match case selected finds "MyObject" and not "myobject" or 
"MYOBJECT." 

Match whole word Only displays instances of the Find what text that are matched in 
complete words. For example, searching for "MyObject" returns 
"MyObject" and not "CMyObject" or "MyObjectC". 

Use Indicates how to interpret special characters entered in the Find 
what text box. The options include: 

• Wildcards – Special characters such as asterisks (*) and 
question marks (?) represent one or more characters. 

• Regular expressions – Special notations define patterns of 
text to match. 

Find filters  

Items types Select a results scope from this list: 

• All 

• Items only – Results include only items and documents.  

• Containers – Results include only containers, such as 
folders, lists, and sites. 

Property name The Find what text is searched only in a specific property. 

Property type Indicates that only properties of a certain type are searched. 

• All 

• Boolean 

• Choice 

• Currency 

• Date Time 

• GUID 

• Multiple Choice 

• Number 

• Text 

• User 

 

5.1.2 Modeling SharePoint Metadata Service 

Documents and data items are associated with metadata properties (also referred to as 

fields or attributes) such as creation date, author, title, keywords, status, and so on. 



 

  Page | 5-129  

In SharePoint, the metadata is managed via lists and libraries. Each list or library has its own 

property set – the collection of properties that is specific to the container. 

The Metadata Editor provides you with a centralized authoring environment in which to 

define the columns of all lists and libraries in the entire target store. Using the Metadata 

Editor you can create new property sets, duplicate property sets, create new properties, and 

copy them from one property set to another. 

To view the Metadata Editor: 

1. Select View > Metadata Editor. 

Or 

Click  

Or 

Press F9. 

The Metadata Editor window appears. The top half of the window displays the property sets 

of the selected source system. The bottom half displays the property sets of the target 

SharePoint store. 

The Metadata Editor window displays the property sets on the left and the properties of the 

currently selected property set on the right. 

 
While the cursor hovers over a property set, a hint appears displaying the number of 
containers that are using the property set. 

 
Figure 5-17: Metadata Editor Window 

 
The Metadata Editor only displays one source system’s metadata information at a 
time. As you navigate between the source systems tabs in the Project window, the 
displayed metadata changes accordingly. 

All source metadata is read-only as well as some of the properties in the target. The 
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icons of these items are displayed with a blue lock ( ) overlay. 

2. If you right-click a property set in the left half of the screen and select Show 

usage, the File Property set window appears, displaying the containers that 

use the selected property set. 

 
Figure 5-18: File Property Set Window 

3. Select an item and click Go To. Tzunami Deployer displays the selected item 

in the Project window. 

5.1.2.1 Creating Property Sets 

New property sets can be created to define the target SharePoint metadata.  

To create a property set: 

1. In the Metadata Editor Window (Figure 5-17), right-click a property set (or 

an empty area in the properties list on the right) and select New > 

Document Library Property Set or New > Picture Library Property Set.  

A new property set is added in rename mode. 

2. Type a logical name for the property set and presses Enter.  

You can define new properties for this property set. 

 
In order to create property sets for other types of lists (e.g. Contacts, Tasks, and so 
on), you can duplicate an existing property set. 

5.1.2.2 Creating and Editing Properties 

You can create a new property or edit the existing properties for the property set. 

To create a property: 
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1. In the Metadata Editor window (Figure 5-17), right-click a property set. 

2. Select New > Property. The Add Property window appears. 

 

 
Figure 5-19: Add Property Window 

3. Fill in the fields according to the information in the following table and click 

OK.  

The property is added as a new column in the list using this property set. 

Table 5-2: Add Property Window Fields 

Field/Item Description 

Name This is an internal technical name that is not shown in SharePoint. 
This field is read-only. 

Display Name The name that appears in the list and in SharePoint 

Description A textual description of the property 

Type Select a standard data type: 

• Boolean 

• Date Time 

• Hyperlink 

• Choice 

• Multiple Choices 

• User 

• User Multi 

• Text 

• Note 

• Lookup 

• Lookup Multi 

• Number 

• Currency 

• Outcome Choices 
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Field/Item Description 

Default Value Specify a default value for this property. The default value must be 
a legal value, based on the type of the property. For e.g., if the 
property type is set to Date Time, the default value must be a valid 
date. 

Required Select this check box to specify that a value must be entered for this 
property. 

Choices Specify the values that appear as choices for this property. You can 
add a value by entering it in the Choices field and clicking Add.  

This option only applies to properties of type Choice and Multiple 
Choice. 

Allow other choices Select this check box to specify whether values for this property are 
limited to the supplied list of choices or whether it is permitted to 
specify other values for the property. 

This option only applies to the following property types: Choice and 
Multiple Choice. 

Currency Format Select the currency to use for this property. The selected currency 
format must be a legal format on the target SharePoint. 

This option only applies to the following property type: Currency. 

 

To edit a property: 

1. In the Metadata Editor window (Figure 5-17), right-click a custom property 

set. 

2. Select Edit Property. The Edit Property window appears. 

 
Figure 5-20: Edit Property Window 

5.1.2.3 Assigning Property Sets 

Property sets have underlying types that must match the list to which you assign them, so 

that a document library property set can only be assigned to a document library and not to 

a different library (For e.g. an image library) or to a different type of list. A property set 

cannot be used on more than one list or library. This section is relevant to property sets 

that are not in use (new or duplicated). 
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To assign a property set to a list: 

1. Drag and drop a property set from the Metadata Editor onto a library or list 

in the Project window. 

Or 

Right-click the property set and select ‘Assign To...’. The Target Items 

window appears. 

 
While you drag a property set to a valid location, the cursor changes to a link. If the 
target location is not valid, either because it is already assigned with the same 
property set, or because it is of a different type than the property set underlying 
type, the cursor changes to a ‘not allowed’ symbol ( ). 

Created property set can be assigned to list or library. 

 
Figure 5-21: Target Item Window 

2. Select a target list to which to assign this property set and click OK.  

A confirmation window appears indicating which property set will be 

assigned to which list. 

3. Click Yes.  

The Assign Property Set window appears, displaying property mapping 

information. 
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Figure 5-22: Assign Property Set Window – Property Mapping 

 

4. Select a source property (top left) and a corresponding target property set 

(top right) and click Map. Repeat this step for each property you want to 

map. 

5. Click Next. The Assign Property Set window displays value mapping 

information based on the property mapping performed in the previous set. 

 
This step may appear multiple times, based on the property mapping. This step will 
appear for each Choice / Multi Choice type target property that was mapped and 
once for all the User type properties. Based on the source values and the general 
options of Tzunami Deployer, this step may not be displayed. 
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Figure 5-23: Assign Property Set Window – Value Mapping 

6. Select a source property value (top left) and a corresponding target value 

(top right) and click Map. Repeat this step for each property value you want 

to map. Check Add all unmapped values as legal target property values for 

adding unmapped value to target. Similarly Check Remove unmapped 

target values for removing the unmapped target values. 

7. Click Next. 

The property set is assigned. Since modifying the property set modifies the 

columns of the target list and pencil overlay appears on the target location 

icon (for example ). 

 
The property set in use by a SharePoint list is displayed in the Properties window. 
You can navigate directly to the property set by right-clicking the SharePoint item 
and selecting Edit Property Set. 

 

5.1.3 Modeling SharePoint Security and Permissions 

5.1.3.1 SharePoint Web Front End server and SharePoint Online Security  

Each site collection in SharePoint Web Frond End server and SharePoint Online has its own 

list of users and groups. Once you grant certain user permissions on content or sub content 

of the site collection, the user is added to the site user list. Also, new groups that are 

created are added as site collection groups.  

In SharePoint 2007/2010/2013/2016/2019 and SharePoint Online content can be secured 

at all hierarchy levels: site, list, library, folder, or item. Each user is granted permission for 

the specific content, either directly or by being a member of a site group which has 

permissions for that content. 
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Once you create sub content, the default security settings to this sub-content are inherited 

from the parent content. Using the SharePoint user interface, you can change these 

default settings and assign unique permissions to the sub-content. 

SharePoint 2007/2010/2013/2016/2019 and SharePoint Online have used the concept of 

permission-levels, which are permission sets. Each user or group can be assigned with one 

or more permission-levels. Permission-levels are managed in sites and can be inherited 

from a parent site. 

5.1.3.2 SharePoint 2003 Security  

In SharePoint 2003, site group is used as a role. This means that if you wish to grant a user 

certain permission, you add that user as a member of a site group that has those 

permissions. Each site that breaks inheritance has its own set of groups. 

In SharePoint 2003, content can be secured only at the site, list, or library level. A user 

could be granted site permissions only by being a member of one of the site groups. Also, a 

user can get explicit permissions on a list or library. 

 
Active Directory groups are represented as SharePoint users. 

A SharePoint group cannot contain another SharePoint group. Each group represents 
a collection of SharePoint users. 

Tzunami Deployer enables you to perform the following security and permissions 

customizations: 

• Create groups 

• Assign permissions to users 

• Modify or delete groups 

• Modify permissions 

• Edit Permission Levels (SharePoint 2007 only) 

• View the Users Permissions report 

• Import/Export users 

  

5.1.3.3 Creating Groups 

In order to assign permissions to an Active Directory user or group, you must first add the 

user or group to the site, either directly or as part of a SharePoint group. 

To create a group: 
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1. Right-click a SharePoint site and select Security > Edit Users & Groups. The 

Manage Security window appears, listing all SharePoint groups ( ) and all 

Site Collection users ( ). 

  
Figure 5-24: Manage Security Window 

 

2. Click Create and select Group.  

 

 

In SharePoint 2003, select User, Site Group, or Cross Site Group. 
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The Create Group window appears. 

  
Figure 5-25: Create Group Window 

 

3. Enter a name and description for the group and select a user to be the group 

owner. 

4. Add members to your group and click OK.  

 In SharePoint 2003, setting a group owner is available only for Cross-site groups. 

The new group is added to the Manage Security window. 

 

5.1.3.4 Assigning Permissions to Users and Groups 

In order to assign user permissions, you must add users to a group or Cross-site group. 

To assign user and group permissions: 

1. Right-click a SharePoint item and select Security > Edit Permissions. The <Item 

Name> Permissions window appears. 
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Figure 5-26: <Item Name> Permissions Window 
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2. Click Add. The Users / Groups window appears displaying all the available users 

and groups. 

  
Figure 5-27: Add User Window 

3. Select the relevant users and/or groups and click OK. The selected users/groups 

appear in the <Item Name> Permissions window (Figure 5-26).  

4. Select a user/group and assign the various permission / permission-levels in the 

Permissions area. 

5. Click OK. 

 

5.1.3.5 Modifying Groups 

To modify a group: 

1. Right-click a SharePoint site and select Security > Edit Users & Groups. The 

Manage Security window appears (Figure 5-24). 

2. Select the group to be modified and click Update. The Update Group 

window appears (Figure 5-25). 

3. Modify the information as necessary and click OK. 

The groups are modified. 

5.1.3.6 Modifying Permission Levels 

This option is available only for SharePoint Server 2007, SharePoint Server 2010, 

SharePoint Server 2013, SharePoint Server 2016, SharePoint Server 2019 and SharePoint 

Online.  
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You can modify any of the permission levels, except for Full Control and Limited Access. 

The permissions are inter-dependent. Selecting certain permissions might select other 

permissions that are required in permission levels. 

To modify a permission level: 

1. Right-click a SharePoint site and select Security > Edit Permission Levels. The 

Permissions Levels window appears. 

  
Figure 5-28: Permissions Levels Window 

2. Select a permission level and select which permissions to assign to the 

permission level. 

3. Click OK. 

The permission level is modified.  

5.1.3.7 Import/Export Users & Groups 

Tzunami Deployer enables you to export or import Active Directory users and groups to an 

XML file. For organizations with a large Active Directory, you can connect and read the 

entire Active Directory domain users and groups once and then export it. Future projects 

can then import the XML file instead of rereading the Active Directory domain. 
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To export users and groups: 

1. Right-click an item and select Security > Import/Export Users & Groups. The 

Import/Export Users & Groups window appears. 

 
Figure 5-29: Import/Export Users Window 

 
2. Select Export users/groups to XML file and click Browse… 

3. In the File Name list, type or select a name for the file. 

4. Click Export. The users are exported to the XML file. 

 
You can manually create your own users/groups based XML file or edit existing ones, 
and add other users/groups (using Excel or any other tool that generates XML files) 
and import it. 

 

To import users/groups: 

1. Right-click an item and select Security > Import/Export Users & Groups. The 

Import/Export Users & Groups window appears. 
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2. Select Import users/groups from XML file and click Browse…  

3. Select the XML file containing users/groups and click Import.  

The users/groups will be available in Deployer project target as normal AD 

users/groups. 

5.1.3.8 Viewing Security Information 

Security information is part of the content loaded into Tzunami Deployer projects. Several 

views and reports are available to assist you during the migration process. 

5.1.3.9 View Permissions 

Viewing permissions enables you see an item’s users and groups (on the top pane) and the 

security permissions assigned to each user/group (on the bottom pane). 

To view permissions: 

• Right-click an item and select Security > View Permissions. 

The View Permissions window is displayed. 

 
Figure 5-30: View Permissions Window 

5.1.3.10 Edit Roles 

Editing roles allows you to add, remove, or edit roles and assign specific permissions to 

each role. Roles are used during the migration of security settings. 

To edit roles: 
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• Right-click an item and select Security > Edit Roles. 

The Edit Roles window is displayed. 

 
Figure 5-31: Edit Source Roles Permissions window 

 
If the source system uses the concept of roles, those roles are read from the system 
and cannot be modified. For systems that do not use roles, Tzunami Deployer 
generates a default set of roles to facilitate the migration process. 

5.1.3.11 View Users Roles 

View User Roles displays users’ roles report for each item, the security entities that have 

permissions on the item and their matching role. 

To view the Users Roles report: 

• Right-click an item and select Security > View Users Roles. 

The Users Roles report is displayed. 

 
Figure 5-32: Users to Roles Report 
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5.1.3.12 View Users Permissions 

View Users Permissions displays user permissions report, for each item, the security 

entities and their permissions. 

To view the Users Permissions report: 

• Right-click an item and select Security > View Users Permissions. 

The User’s Permissions report is displayed. 

 
Figure 5-33: Users to Permissions Report 

5.1.3.13 Import/Export Role Definitions 

Since roles can be modified, it is often useful to have the ability to export and import the 

roles definitions to a file. The roles can then be imported for use in a different project. 

To Import/Export role definitions: 

• Right-click an item and select Security > Import/Export role definitions. 

The Import/Export Role Definitions window is displayed. 

  
Figure 5-34: Import/Export Role Definitions Window 
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6 DEPLOYING SOURCE DATA FOR MIGRATION  

This chapter explains how to deploy source content to the target source content. This chapter 

contains the following topics: 

• Deploy Source Data 
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6.1 DEPLOY SOURCE DATA 
The deployment stage specifies which source folders, files, and items are to be migrated to 

which SharePoint site collection, sites, lists, and folders on the target SharePoint server. 

Similar to the modeling stage, Tzunami Deployer does not immediately migrate the source 

items to the SharePoint server during deployment, but only stores the migration instructions 

in the current Tzunami Deployer project. The Tzunami Deployer content migration changes 

are only applied to the target SharePoint server in the migrating stage. 

In the modeling stage, you can define the SharePoint structure into which you can deploy the 

source folders and files. If you wish, you can design and define the entire model of the 

SharePoint structure and only then deploy your first folders and files. Alternatively, you can 

iteratively design parts of the SharePoint structure, deploy the items into those parts and then 

go back and repeat this process as many times as required.  

In some cases, not all source items are to be migrated. For example, executable files such as 

EXE and DLL are usually not stored in SharePoint. In other cases, the target location for items 

is determined by their metadata properties. For example, you may want items created in the 

year 2001 to be placed in a corresponding folder in SharePoint. In both cases, you can filter 

the source so that only relevant items will be affected by the current deployment operation. 

After completing the deployment stage, the target items appear with an upload overlay ( ). 

To remove the item assignment, find the location in which the item is deployed (in the target 

SharePoint) and delete it. 

The following steps describe how to deploy source items to a target SharePoint: 

• Select the actual items to be deployed from the source to the target SharePoint. 

• Specify the various deployment options, related to structure, files, and security, 

using the Deploy Wizard. 

• Keep track of the deployment process to ensure that you have deployed all the 

items that are required. 

 
SharePoint imposes some character and length limitations on item names. Tzunami Deployer 
may rename folders or documents by replacing invalid characters with an underscore (_). 

 

6.1.1 Deploying Selected Source Items to a Target SharePoint Locations 

When you select to deploy a source item to a target SharePoint item, some items may not 

be deployed for the following reasons: 
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• The file extension appears in the blocked extensions list, as defined by the 

SharePoint administrator (For Example: .exe, .bat, .mdb, and so on). You can 

ignore this warning and deploy the items. However, the migration will fail unless 

the items are renamed or the SharePoint server is modified to accept the files. 

• The item has already been deployed into SharePoint. Tzunami Deployer does 

not allow the same item to be deployed more than once into SharePoint. 

To select the source items and target locations: 

1. In the top half of the Project window, select the source files or folders to be 

deployed. 

2. Drag the selected items to the target location in the SharePoint, in the bottom 

half of the Project window. 

Or 

Right-click the selected items in the source store and select Deploy to. The 

Target items window appears displaying the target SharePoint store. 

3. Select the target location and click OK.  

 
Tzunami recommends that you to drag and drop selected items. By this stage, you 
should already know exactly what you are dragging, where you are dragging to, as 
what (site, list, or document), and which properties you want to add. 

 
Tzunami Deployer may inform you that some items will not be deployed. You can 
display these items by clicking Yes. 

6.1.2 Defining Deployment Options 

After selecting the source items and target location for deployment, the next step is to 

define the behavior of the deployment. This is done using the Deploy wizard, which guides 

you through the following: 

• Specify how Tzunami Deployer handles item versions, duplicate names, and lists.  

• Specify whether source folders are created in the target SharePoint as sites, lists, or 

folders, and how subfolders and content items are handled. 

• Map source users and groups to the appropriate corresponding users and groups 

used in the target SharePoint. 

• Map source security permissions and roles to the appropriate SharePoint roles / 

permission-levels. 

• Map source metadata properties to the appropriate columns in the target 

SharePoint. 

• Map source item property values to the appropriate property values in the target 

SharePoint. 

• Complete the deployment process. 

6.1.2.1 Defining Deploy Options 

You can check the deployment option(s) to deploy structure, files, and security. 
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Figure 6-1 Deploy Wizard 

 

To define the deployment behavior: 

1. Select one or more of the following deployment options specified in the 

following table. 

 

Table 6-1 Deployment option 

Field Description 

Deployment Option Tzunami Deployer will deploy the structure, file and security 

based on the selection. 

Deploy structure Copies the source content folder hierarchy to the target 
SharePoint. If no folders are selected for deployment, this option is 
disabled. If the target location cannot directly contain files, for 
example a SharePoint site, this option is selected and cannot be 
modified. 

Deploy files Copies the source files and items to the target SharePoint. If only 
files and items are selected for deployment, this option is selected 
and cannot be modified. 

Deploy security Copies source content security settings to the target SharePoint. 

 

2. Click Next. The Deploy wizard displays the Global Settings screen. 

6.1.2.2 Defining Global Settings 

You can define the global setting of items, lists and advanced folder hierarchy in the Global 

Setting Screen. 

Items: 



 

  Page | 6-150  

This tab provides various options to be made for handling duplicate file names, versions 

and web-parts on pages.  

 
Figure 6-2 Deploy Wizard - Global Settings Items 

3. Select the various global setting items from Items Tab and according to the 

information in the following table. 

Table 6-2: Deploy Wizard –Global Settings Items 

Field Description 

Duplicate File Names Specify how Tzunami Deployer handles multiple items with the 
same name in a target location.  

Add a numeric suffix to 
new items 

Item(s) is deployed with a numeric suffix appended in file name. 

Skip items with matches  Item(s) does not get deployed. 

Overwrite matching 
items 

Item(s) is deployed by overwriting the existing item(s). 

Incremental migration 

 

Item(s) is deployed with behavior specified as I or II. 

 
The incremental migration allows updating 
properties of existing items.  Depending on version 
settings of a library the item version number may 
change. 

 

I. Add version to 
existing item 

Item(s) is deployed as new version in the existing item(s). 

II. Update 
properties of 
last version 

III. Skip New Items 

Item(s) is deployed and properties get updated in the last 
(highest) version of the existing item(s). 

 

When this option is checked, Tzunami Deployer skips all the 
newly added items and only deploy the updated items in source 
system, which where migrated in previous migration. 
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IV. Skip ACL for 
Existing Items 

When this option is checked, Tzunami Deployer skips ACL update 
of existing items in target, but not for the new items. 

V. Update security 
only 

Use this option to update security only for previously migrated 
data. 

VI. Overwrite all When this option is checked, target security will be removed and 
created new security. 

VII. Overwrite 
mapped 

When this option is checked, target security will be updated from 
mapped securities only. 

Use existing folders 
hierarchy 

Tzunami Deployer will ignore the duplicate items handling for 
folders, and use the existing folder structure. This option is only 
available when the target of the deployment is a list or a folder 

Deploy Versions Specify which item versions to copy when the deployment is 
migrated. The item versions you specified to deploy are selected 
by default. You can deploy 

 

All versions All document versions are deployed. 

Only last <#> versions Only the specified number of latest document versions are 
deployed 

Versions By Modified 
Date 

Only those documents versions that match the modified date are 
deployed 

Major and Minor 
Versions 

Selecting this option facilitates to specify the number of latest 
major and minor versions in dropdowns as shown below: 

 

Last Major versions can be specified from -1 or 1 or onwards.  

‘-1’ indicates to migrate all major versions. ‘1’ indicates to 
migrate only one latest major version and so on. 

Last Minor versions can be specified from -1 or 0 or 1 or 
onwards. ‘-1’ indicates to migrate all minor versions associated 
with specified major versions. ‘0’ indicates not to migrate any 
minor versions and ‘1’ indicates to migrate one last minor 
version associated with the specified major versions.  

Deploy only approved 
versions 

Only those document versions marked as approved (non-draft) 
are deployed 

Deploy all versions as 
Major 

All document versions (including minor versions) are deployed as 
major versions. 

Deploy last minor 
version as major 

Last minor version is deployed as major version. 

WebParts Specify whether to deploy WebParts on Pages or not. 

Deploy WebParts on 
Pages 

Select this option to deploy WebParts on Pages. 

Lists: 

This tab provides various options to be made for handling List configuration and Views.  
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Figure 6-3: Deploy Wizard - Global Setting Lists 

4. Select the various global setting lists from Lists Tab and according to the 

information in the following table. 

Table 6-3: Deploy Wizard - Global Setting Lists 

Field Description 

Lists Select whether to automatically update lists so that they support 
the deployed source items.  

• Change list to support major versions 

• Change list to support minor versions 

• Change lists to support attachments 

• Change surveys to support multiple responses 

• Changes list to require content approvals 

Views Select how to migrate views in the target.  

• Do not migrate views 

• Add views 

• Replace views 

 
This Views is applicable when migrating from 
SharePoint Source. 

 

 

 

 

Advanced: 

This screen enables you to create folder hierarchy by grouping the files based on the   

selected property into a folder.  For e.g. if organizations have documents in a folder are 
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separated by the ‘Document Type’ property according to the departments (Marketing, Sales, 

HR, Account, Finance, etc.). When deploying, a new folder will be created for each 

‘Document Type’ property and all documents the same property at that level will be 

migration into the new folders (Marketing, Sales, HR, Account, Finance etc.).   

 
Figure 6-4: Deploy Wizard - Global Setting Lists 

5. Select Folder Hierarchy Creation to select property of folder. 

6. Select Folder Property and Click Next. The Deploy wizard displays the Define 

deployment structure screen (Figure 6-5). 

6.1.2.3 Defining the Deployment Structure 

You can define the deployment behavior of folders and container hierarchies in the Define 

deployment structure screen. The options in this screen differ according to the type of 

SharePoint target location into which you are deploying. In addition, the type of item you 

select in the tree determines the options in the Set selected item parameters area. 

For example:  

• When deploying into a folder or a list, you can only create sub-folders. 

• When deploying into a site, you can create sub sites or lists.  

The configuration that you set for any item overrides the configuration of its 

sub-items. For e.g. when deploying into a site, if you deploy a folder as a 

library, you can deploy its sub-folders only as sub-folders of the library, and 

not as sub sites. 
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Figure 6-5: Define Deployment Structure Screen 

This screen enables you to specify which type of items will be created in 

SharePoint and to set various deployment parameters. You can select and 

configure each branch of the deployment structure tree. For e.g. you can 

specify that a folder from the source file system is deployed as a new site, 

and that its sub-folders are deployed either as sub sites of the new site, as 

lists of that site, or as sub folders of the new site’s default document library. 

To define the deployment structure: 

1. Define the deployment structure options according to the information in the 

following table. 

Table 6-4: Deploy Wizard – Items Handling Window Fields 

Field Description 

Deployment structure 
tree  

Select the item for which to define deployment configuration.  

Set selected item 
parameters 

Select the type of item to create in SharePoint:  

• Folder 

• List 

• Site 

• Portal area. (Available only in SPS2003, and only when the 
target location is a descendant of the Home Area.) 

 
When deploying as a list you must select the 
appropriate list template from the available templates 
in the site. When deploying as a site, you must enter 
the site properties. 
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Field Description 

Deploy hierarchy Select this option to deploy all sub-folders. If you do not select this 
option, only the folder whose options are currently edited and its 
content will be deployed. No sub-folders (and no items in the sub-
folders) are deployed. 

Deploy items Select this option to deploy the files and items in each source 
folder. Selecting this option affects only the selected folder, not its 
sub-folders. If you do not select this option, only the sub-folder 
hierarchy is created and no documents are deployed to the target 
location.  

When selected, a Documents branch ( ) appears under the folder 
in the deployment structure tree. 

Flat deploy Select this option to ignore the source folder hierarchy and create a 
flat structure in which all documents in the source folder and its 
sub-folders are deployed to the same target location. This option is 
only available if Deploy hierarchy is selected. 

When selected, an All Documents branch ( ) appears under the 
folder in the deployment structure tree and all sub-folders are 
hidden. 

Quick launch navigation Select this option to deploy source sites Quick Launch navigation. 

Top link bar navigation Select this option to deploy source sites Top link bar navigation 

Inherit navigation from 
parent 

Select this option to inherit navigation from parent during 
deployment. 

Use unique permissions Select this option to deploy sites using unique permissions. 

Display list on the Quick 
Launch 

Select this option to display lists/libraries on the Quick Launch bar. 

Specify relative Url Specify relative Url for lists/libraries. 

 

2. Click Next. If Security is deployed, the Deploy wizard displays the Map 

source users and groups screen (Figure 6-19). If Security is not deployed, the 

Deploy wizard displays the Property Mapping screen (Figure 6-7). 

6.1.2.4 Mapping Term Store in XML file 

When source property is of type Managed Metadata and linked with a term set, the 

property can be migrated as Choice/Multichoice or source term set can be mapped  with a 

target term set. 

Mapping Term Store in XML file enables to preserve source term store in target. 

Mapping term store is applicable when the Commit Managed Metadata field preserving 

term hierarchy option is selected under Options>SharePoint Connectivity in the Tools 

menu of the Deployer. 

To map term store: 

1. Open TermMapping.xml file located in Deployer’s installation directory (e.g. 

C:\Program Files (x86)\Tzunami\Deployer 4.0) with write privilege. 

2. Mapp the Unique Identifier assigned by SharePoint for term store hierarchy in 

<TermStoreMapping>, <TermGroupMapping>, <TermSetMapping> and 

<TermMapping> for the source and target. Then, save the file. 
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Figure 6-6: Term store mapping example 

 
The TermMapping.xml file should be configured as mentioned above before running 
the Deployer. The target Term Set should be Open type. 

This feature is available for SharePoint Online only. 

The user should be listed in Term Store Administrators in term store management. 

 

6.1.2.5 Mapping Properties 

Items are associated with metadata properties (sometimes referred to as fields or 

attributes), such as creation date, last modification date, author, title, keywords, status, 

and so on. 

When the source property set (sometimes referred to as category or profile) does not 

match the target SharePoint property set (the columns in the target list or folder), Tzunami 

Deployer requests information regarding the mapping of source properties to target 

properties. The Property Mapping screen appears, as shown below. Properties with the 

same name and matching types are automatically matched and appear in the Mapped 

Properties area, as well as previously mapped properties. 

Tzunami Deployer has an ability to add Content Types (that already exists on the Target 

Site Collection) to the lists/libraries during deployment. 

If any source properties cannot be matched to any target property, a yellow notification 

bar at the top of the screen indicates that the target has fewer properties than the source. 

This may indicate that you might lose data, since source information is not deployed to 

target SharePoint columns. You can click the link in the notification bar to automatically 

add properties to your target SharePoint list. Alternatively, you can manually add the 

missing columns before starting the deployment process. 
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. 

 
Figure 6-7: Property Mapping Screen 

To map properties: 

1. Select a source property and its corresponding target property and click Map. 

Repeat this step for each property you wish to map. The mapping is displayed in 

the bottom of the screen. 

 
If the source items use several different property sets, For e.g. documents with 
different profiles, or when deploying to several targets with different property sets 
or lists of different types, this step is repeated for each pair of source and target 
property sets. 

If you need to map the properties associated with content type, add the content 
type first using “Add Content Type” button, and then proceed for property mapping. 

Clicking Import/Export enables you to create a property mapping XML file, according 
to your current mappings, or load a different property mapping XML file. You can 
generate your own mappings (using Excel, or any other tool that generates XML files) 
and import the XML file. 

 
2. Click Next. The Deploy wizard displays the Value Mapping screen (Figure 6-17). 

 
If you map properties of different types to each other (For e.g. a text property to a 
numeric property), a warning message is displayed. Clicking Yes instructs Tzunami 
Deployer to convert the values. If Tzunami Deployer fails, it assigns an empty value to 
the target property. Clicking No returns you to the Property Mapping screen, in 
which you must change the mapping. 

For user-type properties, such as Created By or Modified By, or for choice properties, 
the Map Property Values screens appear. In these screens you can map the values of 
choice type properties, if required. 
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6.1.2.6 Adding Content Type 

Tzunami Deployer enables you to add Content Type to target during deployment. The 

Adding Content Type to Target window shows the list of Content Type from the Target 

Site collection, which allows you to select one or more Content Type from the lists that you 

want to add in lists\libraries during deployment. The added Content Types that you 

selected in this window will be available in the Content Type Value Mapping screen.  

 
Figure 6-8: Adding Content Type to Target Window 

To add content type 

Deployer has a feature to create Content Type in Target SharePoint from Deployer and it 

allows to preserve the source categories as separate content type automatically in 

SharePoint by associating Source property set with Deployer created Content Type. 

Steps for achieving it are given below: 

1. Deploy the source data to any target library. During deployment in first property 

mapping wizard, a new button PropertySet as ContentType is added as below 

screenshot: 
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Figure 6-9 Add Content Type: option screen 

 

2. Once clicked on button PropertySet as ContentType below window popups. 

 
Figure 6-10 Add Content Type: select property sets 

 

3. Now, check on the required Source Property Set or category property set and click 

OK button. Once OK button is pressed all the selected property set will be displayed 

on Content Type to Create box on right hand side as below: 
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Figure 6-11 Add Content Type: selected property sets 

 

Additionally, we can expand the source property set to view or select and deselect 

the property under property set. 

 

4. Click on Create button. Now, all the selected source property set will be created as 

Content Type. Note that all the content type created from this window will have 

document as parent Content Type and item content type will also be migrated as 

parent document type. 

5. We can validate the created content type by clicking on Add Content Type button. 

After clicking on Add Content Type button new window popups as below screenshot 

where all the recently created content type are listed under Deployer created 

Content Types with selected. This step is only for validation.  

 
Figure 6-12 Add Content Type: Deployer added content types 
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6. Similarly, if you want to create source property set as Folder Content Type, then 

there is advanced window. Referring to screenshot in step no 3 there is another 

button named Advanced. Click on Advanced button and new window popups as 

below: 

 
Figure 6-13 Add Content Type: Advance option 

7. Select the source property set from the dropdown and make its ParentContentType 

as Folder as below screenshot: 

 
Figure 6-14 Add Content Type: add folder content type option 

Click on Add button. 

 

8. After clicking Add, content type will be added in first content type creation window 

as below: 

 
Figure 6-15 Add Content Type: Added folder content type 

 

9. Click on Create. Content Type will be created as parent Folder type. 



 

  Page | 6-162  

Now, you can click Next to proceed further and finish deployment. 

 
When the Content Type 'Link to a Document' is added to a Document Library from 
the SharePoint web, the links get resolved irrespective of the approach used in the 
migration, i.e. CSOM or Migration API. 

But, when the Content Type 'Link to a Document' is added to a Document Library 
from Deployer during the deployment, the links get resolved only when the CSOM 
approach is used for the migration. 

6.1.2.7 Automatically Adding Properties 

Tzunami Deployer enables you to automatically create the missing columns in your target 

SharePoint list if it has fewer properties than your source. The Missing Properties in Target 

window lists the properties that were not mapped and offers to create respective columns 

in the target. All the source properties that you select in this window are automatically 

mapped to their corresponding newly created SharePoint columns. 

  
Figure 6-16: Missing Properties in Target Window 

 
To automatically create and map properties: 

1. Select the various options according to the information in the following 

table.  

Table 6-5: Missing Properties in Target Window Fields 

Field / Item Description 

Select properties to 
add to the target 
location  

Select properties from the list of source properties that do not 
currently exist in the target location to automatically create a 
property in the appropriate target SharePoint list.  

You can click Check All or Clear All to select or deselect all the 
properties, respectively. 

 

2. Click OK.  

The added target properties are automatically mapped with the respective 

source properties and are displayed in the Property Mapping screen (Figure 

6-7). 
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If you add missing properties, the target location is modified (columns are added to 
it). As is the case with other modifications, a pencil overlay appears on the target 

location. For example, . 

All property and value mappings that you perform are stored in the Tzunami 
Deployer project so that the next time you map from the same source property set 
to the same target property set or the same values appear in the source items, 
Tzunami Deployer automatically maps them. 

If all properties and values are successfully mapped by Tzunami Deployer, the Value 
Mapping steps may not be displayed. You can determine if these steps are displayed 
in the Options window. 

6.1.2.8 Mapping Property Values 

In order to assign values to choice properties (properties that offer a list of specific possible 

values, For e.g. Status) and user properties (such as Created By and Modified By), Tzunami 

Deployer enables you to map values from the source items to specific target choice values. 

After you map properties, as described in the previous section, the Value Mapping screen 

appears, once for users and once for each choice (and multi-choice) property in the target 

locations. 

 
Figure 6-17: Value Mapping Screen 

This screen displays the source property and valid target property values, as well as any 

existing mappings.  

 
The Properties window can remain open while you work in the Project window. It 
reflects the properties of the currently selected item or items. 

If the !<default>! value is mapped, you can leave source values unmapped. When 
deploying an item whose property value is unmapped, the corresponding deployed 
item property will be assigned with the same value as the !<default>! . If the 
!<default>! value is not mapped to a target value, all source values must be mapped. 
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Properties that are not marked as required can be assigned an empty value by 
mapping the source value to !<empty>!. To instruct Tzunami Deployer to assign an 
empty value in all cases, map!<default>! to !<empty>!. 

Another special target value is !<Keep Original>!, which appears only if the target 
property allows fill-in values. Fill-in values enable you to add a value even if it is not 
included in the list of values). 

After the new deployed items are created in the target SharePoint, you can override 
the values assigned to them in the Value Mapping step by using the Properties 
window. 
 
 

To map source property values to target property values: 

1. Select a source property value and a corresponding target property value 

and click Map. Repeat this step for all the property values you wish to map. 

The mapping is displayed in the bottom of the screen. 

 
When handling long lists of values, you can enter a sub-string in the Filter fields. All 
values that do not contain this sub-string will be filtered from the corresponding list. 

2. Click Next.  

This Value Mapping screen will reappear for each mapped target choice (and 

multi-choice) property, as well as once for User type properties. When all 

source property values are mapped, the Deploy wizard displays the Ready to 

deploy screen. 

 
If you selected to add unmapped values as legal target property values, the 
unmapped source values will be added to the legal values list of the property. 

Clicking Import/Export enables you to create a property mapping XML file, according 
to your current mappings, or load a different property mapping XML file. You can 
generate your own mappings (using Excel, or any other tool that generates XML files) 
and import the XML file. 

6.1.2.9 Completing the Deployment Process 

Tzunami Deployer is now ready to deploy the source items into the target SharePoint.  



 

  Page | 6-165  

 
Figure 6-18: Ready To Deploy Screen 

If Tzunami Deployer encounters errors or deployment failures, these errors are 

displayed in the deployment report and are announced in the next step of the 

wizard. You can navigate to report by clicking on the link. 

To complete the deployment process: 

1. Click Next. Tzunami Deployer begins deploying your source items into your 

target SharePoint. 

When the structure is created and the documents are added, the Ready to 

deploy screen displays a link to view the deployment report. If any warnings 

or errors were generated as part of the deployment process, icons with the 

relevant number of errors/warnings appear. 

 
Tzunami recommends that you review this report carefully and search for any 
warnings. 

2. Click Next. The Deploy wizard displays the Deploy security screen. 

3. Click Next. The security deployment process begins. 

 
The Properties window can remain open while you work in the Project window. It 
reflects the properties of the currently selected item or items. 

You can skip the security deployment and manage the security at another time 
unchecking the Deploy security checkbox (Available only when migrating to 
SharePoint 2003) in the Deploy Wizard. 

The Security Deployment report is stored in the following directory: 
<Project Folder>\Reports\Security Deploy Report.<Date>.<Time>.xml. 

This report exists only when migrating to SPS2003, in which case a link to the report 
is displayed. 
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When Tzunami Deployer finishes deploying all items and settings, the 

Deploy wizard displays the Thank you screen. 

4. Click Done. The new items are displayed in the bottom half of the Project 

window. 

6.1.3 Mapping Security Information 

The first page of the Deploy Wizard contains the Deploy Security checkbox. Selecting this 

checkbox enables you to also deploy the source security settings for your deployed 

containers and items. 

If you select the Deploy Security checkbox, the following screens are added to the wizard: 

• Groups mapping – Mapping of source groups to target groups as containers 

of users. 

• Entities mapping – The concrete user mapping. 

• Roles Mapping – Mapping of source roles (permissions sets) to target roles. 

In the following example we review a deployment from LiveLink to SharePoint 2007.  

Assuming we would like to deploy the following hierarchy as a Document Library into 

SharePoint 2007: 

 <User_X>’s permissions <User_Y>’s 
permissions 

<Test Group>’s 
permissions 

 Documents See, modify, add See, modify, 
delete, add 

See, modify, add 

 File A See, modify See, modify, 
delete 

See 

 File B See, modify See, modify, 
delete 

See 

 Sub Folder See, modify, delete, 
add, modify permissions  

See, modify, 
delete, add 

See 

 File 1 See, modify, delete, 
modify permissions 

See, modify, 
delete 

See 

 

Tzunami Deployer uses the concept of security roles, each representing a set of permissions. 

If the source system supports this concept, the roles are read from the system. Otherwise, 

Tzunami Deployer generates its own roles. You can add, remove and modify the roles used. 

David’s set of permissions qualify him the role of Contributor on the Documents folder and 

its content, but qualifies as an Administrator on Sub Folder and its child item. Ron’s role is 

Web Designer on all the hierarchy and Test Group has the role of Reader on all content 

except for Documents, in which he is a Contributor. 
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6.1.3.1 Groups Mapping 

 
Figure 6-19: Group Mapping screen 

 

  The screen consists of three lists: 

• Source groups – The source groups that are relevant to the items deployed. 

• Target groups – The target groups that are relevant to the site into which 

we deploy. 

• Mapped – Pairs consist of source groups and target groups that are already 

mapped. 

In this step you can map a source group either to an existing site group, or to create a new 

site group bearing the same name. 

In our example, we have only one source group (Test Group), and in the target we have the 

three default site groups (Members, Owners, and Visitors) and one user-created group 

named Target Group. We will map Test Group to Target Group. This means the members of 

Test Group will be added as members of the Target Group. 

 
If the source is File System, this step is absent, since File System groups are treated 
as Active Directory groups, which can be mapped to SharePoint users. 
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6.1.3.2 Entities Mapping 

 
Figure 6-20: Entities Mapping screen 

 

 This screen also consists of three lists: 

• Source users & groups – The source users and groups that are relevant to 

the specific items deployed. Included are users belonging to the groups. 

• Target users & groups – All the local and domain users in the target. This 

means that also users that are not relevant to the target site are included (if 

you map to these users, they will be added to the target site). 

• Mapped – Pairs consist of source user or group and target user or group 

each, that were already mapped. 

In this step you can map each source user or group to a target user or group. 

Mapping a source entity to a target entity means that the target entity will receive the 

same permissions that the source entity has. These permissions will be assigned based on 

the role mapping step. Also, when Tzunami Deployer performs the group mapping, group 

membership is migrated based on the entities mapping. 

 
You can use the Filter field in order to drill down to a specific name. 

Tzunami Deployer suggests some of the mappings based on the user names. Also 
Tzunami Deployer suggests the mapping of groups based on our mapping on the 
previous screen. 

 

6.1.3.3 Role Mapping 

After mapping the default user and the other users you wished to map, click Next to get to 

the third security screen: Role Mapping: 
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Figure 6-21: Role Mapping screen 

 

This screen contains three lists: 

• Source roles – The source roles (each role is a permissions set). 

• Target users & groups – You can select more than one target role. 

• Mapped – Pairs consist of a source role and its mapped target role(s). 

Roles, as mentioned earlier, are sets of permissions. In this step you map a source role to a 

target role. This means that target entities that were mapped to a source entity with a 

certain role will be assigned with the corresponding role that will be mapped in this screen. 

A sensible mapping would be: Administrator > Full Control, Contributor > Contribute, 

Reader > Read, Web Designer > Design. 

 
You can check more than one target role. 

When migrating from WSS2.0/SPS2003, Site groups are handled as both groups 
(containers of users), and roles (sets of permissions). This means that Site groups will 
appear in both the Groups mapping and the Roles mapping steps. 

 

Following our example, the outcome of our security mapping will be: 

 David’s role Ron’s role Test Group’s role 

 Documents Contribute Design Contribute 

 File A Contribute Design Read 

 File B Contribute Design Read 

 Sub Folder Full Control Design Read 

 File 1 Full Control Design Read 
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6.1.3.4 Checking Deployed Items 

Once you have finished the deployment, you can scan the hierarchy of items and search 

for problematic items. 

To find problematic items: 

• Select View > Find > Find Problems. 

Tzunami Deployer scans the hierarchy in the target system for problematic 

items. If there are no problematic items, a message is shown. If Tzunami 

Deployer encounters problematic items, the Problematic Items window 

appears (Figure 6-22). 

 
The window updates itself as you modify items to handle their problems. 

You can double-click (or click Go To) on an item to navigate to it directly. 

Click Copy to clipboard and Export to retrieve the list of problematic items. 

The following problems are checked: 

• Name contains invalid character. 

• Name and URL are too long 

• Blocked extensions 

• Files are too large 

• Properties values are illegal (Hyperlinks start with a protocol 

schema, required properties have values, required properties do not 

have a default value). 

 

 
Figure 6-22: Problematic items window 

 

6.1.3.5 Managing the Deployment Process 

This section describes a variety of options that enable you to keep track of the deployment 

process. For e.g., you can determine which source items are deployed to which target 

locations: 
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• Item Counters – Items in the container versus the number of items deployed. 

For example, the following shows that only one item of the 25 in this hierarchy is 

deployed: 

 

The first number is the number of files and items deployed, but not yet migrated to the 

target SharePoint. The second number is the total number of files and items in that location 

and all its nested hierarchy. In the source system, this enables you to verify that all files 

intended for migration were indeed deployed. In the target SharePoint system, this indicates 

how many items currently in the specific location were deployed but were not yet migrated 

to SharePoint. 

• Icon Overlays – Each item or folder can only be deployed once. After 

deployment, the icons of both source and target items appear with an upload 

overlay ( ). For e.g. .  

If you try to redeploy an item that is already deployed, a message is 

displayed. You can remove a deployed item by finding the location to which 

the item is deployed (in the target SharePoint) and delete it. 

• Find Source/Target Tool – You can find the correlation between items in the 

source and their new location in the target: 

• Select a source item and click  Find Source/Target to find the 

deployed target item. 

• Select a target item and click  Find Source/Target to find the 

deployed source item. 

• Deployed To / Deployed From Column – The source includes a Deployed To 

column that specifies the address of new item in the target SharePoint. The 

target SharePoint includes a Deployed From column that specifies the 

address of the source item that was deployed.  

• Find Problems – You can instruct Tzunami Deployer to search for known 

problems (such as long URLs, which is a SharePoint limitation, blocked 

extensions, and so on) by selecting View > Find > Find Problems. This option 

can only be performed before the migrating stage, on not migrated items. 

 

• Filtering Source Items – Tzunami Deployer enables you to filter the items that 

appear in the source system. 

6.1.3.6 Filtering Source Items 

When you apply a filter to a folder, the filter is automatically applied to all sub-folders. You 

can set a different filter for a sub-folder or disable filtering for it altogether by editing the 

sub-folder’s filter settings. 
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To filter the source store list: 

1. Click . 

Or 

Right-click a source folder you wish to filter and select Filter. 

The Edit Filter window appears. 

 
Figure 6-23: Edit Filter Window 

2. Select a property from the list of Properties. 

3. In the Condition area, select one of the following conditions from the drop-down 

list and enter a value in the corresponding field(s): 

• Equals to 

• Different than 

• Greater than 

• Smaller than 

• Between 

• Matches 

• Doesn’t match 

• Empty Value 

• Non Empty Value 

 
Some conditions have single value and others have multiple values, for example the 
Equals to condition can contain up to five values.  
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4. Click Add Condition. The condition is added to the Filter area, displaying the full 

filter expression. 

 
You can only add one condition per property. 

You can edit a condition for a property by selecting the property and modifying the 
condition type or it’s currently assigned values and clicking Add Condition. 

Also, date-time type property has Date and Time and Date Only filter options under 
Condition to include time or not along with date. 

You can remove a condition from a property or all the conditions from all the 
properties by clicking Clear Condition or Clear All, respectively. 

 

5. Click Import/Export Button. Export button can be pressed to dump added filter 

condition as an XML file. Likewise, Import button can be pressed to import the 

saved filter conditions accordingly.  

6. Click OK. 

The filter is applied to the source hierarchy and the icon at the filtered location, 

including all its sub-folders, includes a filter overlay ( ), as well as an additional 

counter specifying the number of files and items that passed the filtering. 
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6.1.4 Best Practice for deploying source 

• Drag and drop: Deploy selected items from the source to a pre-determined 

location in the target. At this stage of the Deployment, you should already 

be aware of what you’re dragging (site, list, etc.) and which properties you 

want to add accordingly.  

• Mass Deploy: Repeat the “Drag and Drop” phase for as many projects as 

you like. Keep in mind that using more than one person to conduct the 

migration can help you move through the different phases simultaneously 

and thereby at a quicker pace. 

Make sure not to deploy the same site collection using two different 

projects that are destined to run simultaneously, as this could cause 

inconsistency issues. 

• Review the Deploy Reports for any warnings 

• Check for problems before Commit: Before migrating your project to 

SharePoint, use the “find problems” option from the Deployer menu (Ctrl 

+P) in order to identify any issues that may occur as a result of SharePoint 

limitations, such as long URLs, or blocked extensions.  

• SharePoint Limitations: Keep in mind SharePoint column limitations while 

adding missing properties.  

• Multiple Deployment: Simulate multiple deployments for a source type till 

you find the one that suits your needs best. Use the same deployment 

pattern for that item type in future. 

6.2 AUTO DEPLOYMENT AND MIGRATION 
Tzunami Deployer provides a single click auto deployment and migration solution. Auto Deploy 

and migration is an approach of migration where user just needs to click on a button and the 

Deployer itself identifies, plans, analyzes and performs all the necessary steps needed to make 

items migrate to target. 

During the deployment process, Deployer maps the User and Groups, Properties and Values 

based on the best matching condition for SharePoint. If there are no possible matches it will 

add the source properties to target as far possible. 

This feature is included in the product so that novice user can perform the deployment and 

migration process without knowing the tool’s available features in detail. User, then, can 

perform the analysis of the migrated content and plan for the comprehensive deployment 

process for the actual migration process. 

To execute the auto deployment and migration process, perform the following steps: 

1. Deploy the content from Source to Target panel 
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Figure 6-24 Deploy wizard screen 

 
Before proceeding auto deployment and migration, it is recommended to check the 

problematic items by pressing CTRL or navigating to View>Find>Find Problems and 

resolve the problematic items. 

2. Click on Finish button 

An auto deployment process starts. After completing the auto deployment process, a 

formation message to start migration appears.  

 

 
Click on Yes. 

 
If there are problematic items, then you will see the warning message to view. Click on 

Yes to continue without resolving problematic items. 

  

Click on No to view the problematic items. You need to resolve the problematic items 

navigating to View>Find>Find Problems or pressing CTRL. 
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3. Then, the auto migration process starts. 

 
 

 

Figure 6-25 Auto migration process 
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6.3 DELTA DEPLOYMENT 
Tzunami Deployer provides a single click delta deployment solution. Delta deployment is a new 

approach of migration where user just needs to initiate the delta deployment command with a 

single click after which Deployer itself identifies, plans, analyzes and performs all the necessary 

steps needed to make items ready for Migrate. 

 
Delta deployment completely depends on previously migrated project. So, user need to 

make sure that every project created for migration should be unique and they are safely 

placed until the delta deployment is carried out. 

The Link Resolver Service must have been used in previously migrated project. 

Tzunami Inc. does not recommend to use Save As option or remove/reload operations in 

the regular migration project. If such operations have been performed, Delta deployment 

may not work as expected. 

6.3.1 Configure Global Settings for Delta Deployment 

Tzunami Deployer uses Security, Property and Value mappings from the previous migration 

by default. It identifies the required mappings to perform delta deployment based on the 

mapping files available in the migration project. 

However, Tzunami Deployer provides a facility to use a global (custom) mapping across all 

delta deployment, too. To achieve this, user need to provide the path for mapping files and 

check the option Use Global Mapping. 

6.3.2 Edit Mapping files 

Tzunami Deployer saves all the mapping files (Property, Value, Roles, Groups and Entities) 

when migrating the content from source system to target system. Those mapping files are 

re-used, by default, when performing delta deployment. 

Even though Tzunami Deployer uses the previous migration project’s mappings by default, 

user can edit the mapping files to change the mappings as desired. Then, Tzunami Deployer 

performs the Delta deployment based on the edited mapping files. 

 
If you want to reflect changes made in entity mapping (user or group mapping) during 

delta deployment, confirm that following options are checked. 

• Always option for Show Value Mapping Dialogs under Options>Mappings menu.  

• Always option for Show Security Mapping Dialogs under Options>Security menu. 

To edit the mapping files for Delta deployment: 
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1. Open existing project, it will load all source and target information that were 

migrated previously. 

2. Click on Mapping Editor from the tool bar. 

 

Figure 6-26 Mapping Editor Option 

 

3. Mapping Editor opens. 

 

Figure 6-27 Mapping Editor Screen 

4. Click Edit for the desired mapping file to update. The files open in an editor. 

Make necessary changes in the file in the existing format. 

5. Then Click Close. 
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6.3.3 Perform Delta Deployment 

To perform delta Deployment:  

1. Open existing project, it will load all source and target information that were 

migrated previously. 

 

Figure 6-28 Loading Deployment Project Screen 

 
Before performing Delta deployment, confirm that the option Use Link Resolver 
Service is checked under menu, Tools>Options>Others>Link Registration.  

And, Tzunami Deployer 4.0 Migration Service is in running state in windows service. 

Also, Tzunami Inc. does not recommend to run regular migration project while 
performing delta in same machine with multiple instances of Tzunami Deployer at 
the same. 
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2. Select root folder in Source Tab. Then click Delta Deployment  

Or  

Right click on root folder in Source Tab, then click Delta Deployment. 

A dialog to browse the specification file is displayed. Browse the specification 

file which is located previous migration project location. 

 

Figure 6-29 Loading Specification File for Delta Deployment 

Then click on OK. 

 

3. The Delta Deployment executes. Tzunami Deployer connects to source, exports 

and loads the data for delta deployment, then deploys to target automatically. 

 

Figure 6-30 Delta Deployment Screen 

Based on existing project file, Deployer identifies and plans the structure of 

source items that need to be exported and exports the delta contents (contents 

that were modified after last export). The exported contents will be 

automatically loaded in Deployer.  

After loading the exported contents, Deployer analyzes the existing migration 

reports to figure out which items were deployed to which location, and based 

on that, it deploys the contents to target as incremental migration. By default, a 
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new version will be added to the existing items, and new items will be created 

for non-existing items. 

During deployment, user do not need to take any action except few 

confirmation pop ups which may appear depending on condition to make sure 

user is aware of those actions. Deployer will use all the security mapping, 

property mapping and value mapping files based on the option selected by user 

on whether to use global mappings or mappings saved in the project location 

from previous migration. 

Once deployment completes, user can verify the newly deployed item in target 

panel. If user need to perform any post deployment action, they can perform it.  

Otherwise delta contents are ready for migration. 

4. Click Migrate, then click on Yes. 

 

 

                     Figure 6-31 Migration Screen 
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6.4 SECURITY ONLY MIGRATION FOR ALREADY MIGRATED CONTENT 
Tzunami Deployer provides a feature to migrate the ACL of the previously migrated content. 

This is useful if there are anomalies in security for the migrated content. The new 

deployment does not deploy the new items (if any) and perform the security related 

changes and hence updates the security information in previously migrated content. 

Security only migration can be performed using Security only Migration option in icon bar or 

from the incremental migration option as well. Either way of deployment uses the same 

option and produce the same result.  

Steps to perform security only migration 

1. Open the Deployer Migration project, and reload the items in source and target panels. 

And select items to deploy in source panel. 

 
Figure 6-32 Migration Project window 
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2. From the top icon bar, click on Security Only Migration option. 

 
Figure 6-33 Security Only Migration option in icon bar 

 

3. Select option Overwrite All or Overwrite Mapped as required. 

Overwrite All: Overwrites all the target ACL with new ACL. 

Overwrite Mapped: Only mapped ACL from current migration will be overwrite in target, 

leaving unmapped ACL as it is in target. 

 
Figure 6-34 Options in Security Only Migration 
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4. Expand the tree view 

 
Figure 6-35 Taget Tree view for Security Only Migration 

5. Select the previously migration item in target tree view. 

 
Figure 6-36 Security Only Migration with Previos Item 

6. Click on OK button. Deploy wizard starts. 
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7. In Define Deployment Structure wizard, select the appropriate structure for 

deployment. 

 
Figure 6-37 Deployment Structure window 

Click on Next button. If confirmation for overwriting existing Role mappings is asked, you 

can click on Yes or No as you wish, and proceed ahead. 

8. In Map Source Users and Groups wizard, perform mapping as required. 

 
Figure 6-38 Users and Groups Mapping window 

Click on Next button. 
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9. In Map Source Roles To Target Roles wizard, perform mapping as required. 

 
Figure 6-39 Roles mapping window 

Click on Next button. 

10. In Ready to Deploy wizard, click on Next button. 

 
Figure 6-40 Deploy Ready Window 

 

11. You can view the Deployment report following the link.  
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Figure 6-41 Deployment report window 

Click on Next button 

12. In Deploy Security wizard, click on Next button 

 
Figure 6-42 Deployer Security window 
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13. In final wizard, click on Done button. 

 
Figure 6-43 Thankyou  wizard 

14. In project window, click on Migrate button. 

 
Figure 6-44 Starting migration for Security Only Migration 
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15. Confirm the migration by clicking on Yes button. 

 
Figure 6-45 Confirmation for Migration 

16. Security only migration starts. Successful security only migration screen looks like 

 
Figure 6-46 Migration completion window 

   User can perform following actions using available buttons. 

• User can close the window by clicking on Close button. 

• User can open a window containing migration reports list by clicking 

on View Reports button. Individual reports can be opened from the 

list. 

• User can open the target site (root of deployment) by clicking on 

Open button. 

• User can start migration verification by clicking on Start Verification 

button. This feature requires additional license, please contact 

Tzunami Support at support@tzunami.com. 

 

  

mailto:support@tzunami.com
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Steps to perform security only migration form normal Deployment process 

1. Open the Deployer Migration project, and reload the items in target panel. 

 
Figure 6-47 Security Only: Reload target 

2. Deploy the source data to target as deployed in previous migration project and make 

sure Deploy Security option is checked. Then click on Next. 

 
Figure 6-48 Security Only: Deploy with security 

 

3. In Global Settings screen, check Incremental Migration radio button. Then click on 

Update security only radio button. The Skip new items check is disabled now to skip any 

new items deployed (if any). 
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Figure 6-49 Security Only: Update security only option 

In ACL Options, check Overwrite all or Overwrite mapped radio button. The Overwrite 

all option will remove the existing security of the items in target and create new security 

and assign. The Overwrite mapped option will update the mapped securities only in the 

target. The Use existing folders hierarchy should be check in this screen. Then, click on 

Next. 

 

4. In Define Deployment Structure screen, continue with the displayed structure 

deployment. Then, click on Next. 

5. In Map Source Groups screen, map the source groups to target groups as required. 

Then, Click on Next. 
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Figure 6-50 Security Only: Groups mapping 

6. In Map Source Users and Groups screen, map the source users and groups as required. 

Then, click on Next. 

 
Figure 6-51 Security Only: map users and groups 

7. In Map Source Roles to Target Roles screen, map the roles. Then click on Next until 

deployment process is finished. 
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Figure 6-52 Security Only: Map roles 

8. Click on Done button. The security only migration is ready to migrate the security 

changes in target. Proceed for migrating the data to target.  
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7 MIGRATING USING DEPLOYER PROJECT 

This chapter explains how to migrate the deployed content to target SharePoint. This chapter 

contains the following topics: 

• Executing the Migration 

• Migrating Now 

• Schedule Migrate 

• Batch Mode Migrate 

• Migrate Process Using Migration API 

• Best Practice for migrating a Deployer Project 
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7.1 EXECUTING THE MIGRATION 
The migrating stage executes your target SharePoint customizations and migrates your source 

items to your target SharePoint. You can perform the migrating stage immediately after 

deployment or you can schedule it for a later date.  

The migrating process first applies the model that was designed in Modeling Target 

SharePoint. This ensures that the sites, libraries, lists, and folders are created in the target 

SharePoint and that their metadata is set, so that they are ready for the migration of items 

into them, according to the deployment scheme you built in Deploying Source Data for 

Migration. 

The actual content migration physically copies the source items (For e.g. Microsoft Office 

documents) to the target library, list, or folder on the SharePoint site, while updating their 

metadata properties according to the Tzunami Deployer project definitions. 

You can estimate how much time the migrating stage requires with the following calculation: 

( )
( )ZN

YX




= anticipated migrating time. 

Where: 

X –  The total number of documents to Migrate. 

Y –  The average migrating rate for one Tzunami Deployer instance. This rate can be 

determined by migrating a project and dividing the number of documents by the 

amount of hours taken to complete migrating. 

Z –  The number of servers (that meet the required specifications) available on which to 

run Tzunami Deployer. 

N –  The number of Tzunami Deployer instances planned to run on each server. 

 
While your projects are in the Migrating stage, create and work on additional projects to save time. 

When one project finishes the Migrating stage, you can immediately begin Migrating another. 

You can run multiple Tzunami Deployer projects on a single server. Keep in mind that the number of 

Tzunami Deployer projects running simultaneously on one machine and the total number of running 

projects depends on your hardware, network connections, and the SharePoint environment 

maintenance and response time. This maintenance and response time depends on the amount of 

free memory on the machines running Tzunami Deployer, hardware, available CPU, network 

connectivity to SharePoint, DB indices on the SharePoint SQL server, and so on. 

Avoid making additional changes directly to your target SharePoint during the Migrating stage. 

 

After the Migrating stage is complete, the numbers on the left of the item counters in both 

the source and target trees are set to zero and the New, Modified, and Deployed overlays 

are removed from all icons. 



 

  Page | 7-196  

7.1.1 Migrating Now 

To migrate the changes to the SharePoint server: 

1. Select Data > Target SharePoint 

2003/2007/2010/2013/2016/2019/SPOnline> Migrate to SharePoint.  

Or 

Right-click in the target SharePoint store area and select Migrate to 

SharePoint. 

 
If the Tzunami Deployer project was modified since it was last saved, Tzunami 
Deployer informs you that the current project data will be saved. 

Tzunami Deployer prompts you to verify that you wish to migrate your 

changes to SharePoint. 

2. Click Yes. Tzunami Deployer begins migrating your changes and displays a 

progress window indicating the number of modifications being made to the 

SharePoint server, as well as the progress and time estimation. 

 
Figure 7-1: Migrate Progress Window 

User can perform following actions using available buttons. 

• User can close the window by clicking on Close button. 

• User can open a window containing migration reports list by clicking 

on View Reports button. Individual reports can be opened from the 

list. 

• User can open the target site (root of deployment) by clicking on 

Open button. 
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• User can start migration verification by clicking on Start Verification 

button. This feature requires additional license, please contact 

Tzunami Support at support@tzunami.com. 

 

 
Clicking Errors only filters the displayed progress messages to show error messages 
only. 

After Tzunami Deployer finishes migrating your changes, you can right-click the new 
SharePoint site or document library and select Open to view the site or document 
library using your Internet browser. 

 

If the migrating process completes successfully without errors, you have 

finished migrating your content. 

If errors or failures are displayed in the Migrate Progress window (Figure 

7-1), a new tab is added to the window, indicating which items were not 

migrated and what problems caused the failure. 

 

3. Click the Commands tab. The Commands tab appears listing the actions that 

failed to be migrated to SharePoint and the reason for the failure. All actions 

are selected by default. 

 
Figure 7-2: Migrate Window – Commands Tab 

User can perform following actions using available buttons. 

• User can close the window by clicking on Close button. 

mailto:support@tzunami.com
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• User can open a window containing migration reports list by clicking 

on View Reports button. Individual reports can be opened from the 

list. 

• User can open the target site (root of deployment) by clicking on 

Open button. 

• User can start migration verification by clicking on Start Verification 

button. This feature requires additional license, please contact 

Tzunami Support at support@tzunami.com. 

 

4. Select the actions that you want to retry migrating to SharePoint and click 

Try Again. 

 
If you close the window without resolving the failed commands, you can resolve 
them later by right-clicking in the SharePoint store and selecting View pending 
commands. You can then retry migrating the items. 

5. User can view the list of migration report’s location by clicking on View 

Reports button. 

 
Figure 7-3 View Migration Report Location 

           User can double click to open the report file. 

6. User can open the target site of migrated data by clicking on Open button. 

 

7. User can start migration verification by clicking on Start Verification button. 

The migration verification jobs created and saved for the migrated data.  

 
Figure 7-4 Start Verification 

For more detail, refer migration verification user guides. 

mailto:support@tzunami.com
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7.1.2 Schedule Migrate 

You can schedule Tzunami Deployer to migrate a project at a time that is most convenient 

for you. 

To schedule Deployer project: 

 
Once you have successfully deployed contents to the target, save the Deployer 
project.  

1. Select Data > Target SharePoint 2013> Schedule Commit to SharePoint 2013. 

Or 

Right-click in the target SharePoint store area and select Schedule Migrate 

to SharePoint 2013/ SharePoint Online. Check this 

The Schedule Migrate window appears. 

 
Figure 7-5: Schedule Migrate window 

 

Table 7-1: Schedule Migrate 

Parameters Descriptions 

Start Set the start date and time for schedule Migrate. 

 
The start date and time should be greater than current 
date and time. 

 

Mode Enables you to specify how Deployer runs the schedule Migrate 
process.  

• Mini GUI - Runs Deployer and starts to migrate a project 
opening the Mini Deployer interface. It shows Migrate 
progress, Elapsed time and Time left (estimation) in Mini 
Deployer window. 
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• No GUI - Runs Deployer and starts to Migrate without 
opening the user interface of Deployer. 

 

2. Click Save.  

 
Please ensure that the Project File is not opened in any Deployer instances during 
the scheduled time. 

7.1.3 Batch Mode Migrate 

You can schedule Tzunami Deployer to migrate a project at a time that is most convenient 

for you.  

To set a time for migrating a project: 

 
Once you have successfully deployed contents to the target, save and close the 
Deployer project.  

 

1. Create a batch file with Migrate command in the following format.  

Deployer.exe <DeployerProjectFile> [/Migrate [/nogui] [/minigui]] [/SMTP 

<mail.domain.com>] [/From <name@domain.com>][/To <name@domain.com>] 

[/PORT <SMTP port>] 

Usage 

Parameters Descriptions 

/Migrate Opens the provided Deployer Project File and 
immediately starts to Migrate to SharePoint. If a 
project is not provided, or if there are no commands 
to Migrate, Deployer opens regularly. 

[/nogui] This flag is used with the “/Migrate” option, in order 
to run Deployer and start to Migrate without opening 
the user interface of Deployer. 
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[/minigui] This flag is used with the “/Migrate” option, in order 
to run Deployer and start to Migrate a project opening 
the Mini Deployer interface. It shows Migrate 
progress, Elapsed time and Time left (estimation) in 
Mini Deployer window. 

 

For example: 

C:\> “C:\Program Files (x86)\Tzunami\Deployer 4.0\Deployer.exe” “F:\My 

Project\Project1.tde” /Migrate  

 

C:\Program Files (x86)\Tzunami\Deployer 4.0> Deployer.exe “F:\My Project\Project1.tde” 

/Migrate /nogui  

 

C:\Program Files (x86)\Tzunami\Deployer 4.0> Deployer.exe “F:\My Project\Project1.tde” 

/Migrate /minigui  

 

C:\> “C:\Program Files (x86)\Tzunami\Deployer 4.0\Deployer.exe”  “F:\My 

Project\Project1.tde”  /Migrate /nogui /SMTP mail.friendsco.com /From info@friendsco.com 

/To admin@friendsco.com /Port 465 

 

 
For better performance and less intrusions on the machine, you can use the /nogui 
flag, which does not display the Tzunami Deployer user interface. 
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The first parameter is the path to Deployer executable file.   

  

 
 

Save the file. 

2. Run the batch file in the task scheduler. For more information about task 

scheduler, refer to:  

http://technet.microsoft.com/en-us/library/cc748993.aspx. 

7.1.4 Migrate process using Migration API 

When migrating content (files and folders) to SharePoint Online using Migration API, 

Tzunami Deployer migrate the contents to Azure Storage. Depending on Azure’s own import 

schedule, the uploaded contents are migrated from Azure to SharePoint Online.  

To Migrate content to SharePoint Online using migration API: 

1. Click .  

 
If the Tzunami Deployer project was modified since it was last saved, Tzunami 
Deployer informs you that the current project data will be saved. 

Tzunami Deployer prompts you to verify that you wish to migrate your 

changes to SharePoint. 

2. Click Yes. Tzunami Deployer begins migrating contents to Microsoft Azure 

Storage. 

 
Once the migration is completed in target SharePoint, the logs are downloaded from 
Microsoft Azure Storage in the project location. Tzunami strongly recommends to 
run the pilot migration and verify the logs before starting the migrations projects. 

 

7.1.5 Schedule Security Migration 

Tzunami Deployer provides the feature to migrate the permission related changes in later 

data and time. If the migration project has pending commands for permissions, then during 

migration those security related changes can be scheduled for later time. The scheduled 

migration will be stored in migration database and migrated in specified data and time. 

Steps to schedule security migration 

After completing the deployment, the migration can be started during which perform 

following steps: 

1. Click on Migrate. 

http://technet.microsoft.com/en-us/library/cc748993.aspx
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2. If there are pending commands for permissions, Migrate Security Later option is 

displayed. Check this option. Then, click on Yes button. 

 
Figure 7-6 Migration confirmation screen 

3. In Schedule Migrate screen, check Normal check box in Type group. Then, specify the 

date and time. After that, select the Mini GUI or No GUI mode. 

 
Figure 7-7 Schedule security migration in later date and time 

  Then, click on Save button. 

4. The migration job for security is scheduled for specified date and time and is saved in 

migration database. The Deployer migration project will be started and run in scheduled 

date and time with specified MiniGUI or NoGUI mode.  

7.1.6 Best Practice for migrating a Deployer Project  

• Check for problems before Migrate 

• Start migrating the projects: While these projects are migrating, begin 

creating as many new Deployer projects as you can. 

• Run several Deployer instances on one server: The number of Deployer 

projects running simultaneously on one machine and the total number of 

projects which can run simultaneously depend on your hardware, network 

connection and SharePoint environment maintenance and response time 

(free memory on the machines running Deployer, HD availability, CPU, 

network connectivity to the SharePoint farm, DB indices on the SharePoint 

SQL server, etc.). 

• Don’t waste time: You can immediately migrate another project as soon as 

the previous project finishes migrating. You also have the option to schedule 
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a Migrate in the future with Deployer’s command line capabilities. Keep in 

mind SharePoint column limitations while adding missing properties. 

• Avoid performing changes to the SharePoint outside of Deployer during 

the Migrate phase. 

• In order to produce a rough estimation on the duration of the Migrate 

Phase, verify the following environment-dependent variables: 

• X: Total number of documents to Migrate 

• Y: Average Migrate rate for one Deployer instance. Test this once 

with one project migrating M documents for H hours and just do a 

simple calculation of M/H. 

• Z: Number of servers available to run Deployer 

• N: Number of Deployer instances designated to run on each server.  

 
It is not recommended to run more than 3 Deployer instances on a single server. 

Rough time estimation for the duration of the Migrate process can be 

calculating using these parameters: 
( )
( )ZN

YX




 

• Schedule Migrate: With Scheduled Migrate, you can schedule Tzunami 

Deployer to migrate a project at a time that is most convenient for you. 

• Identify Issues: During Migrate, or any other phase of the migration project, 

identify any problems that may arise. Save the export/deploy/Migrate 

reports and logs which contain any warnings or errors. Notify the Tzunami 

Support Team about these issues.  
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8 AUTO MIGRATION 

Tzunami Deployer provides the feature to automatic scheduled migration from supported ECM 

system to SharePoint. The schedules jobs in windows for automatic migration works based on 

the parameters specified in migration plan file. The template for migration plan is available in 

Deployer installation directory (MigrationPlan.csv). 

 
Figure 8-1 Migration Plan Template 

This migration plan (which is an input for migration jobs) should be created and is one time 

configuration task, beforehand scheduling the migration jobs. The fields in migration plan file 

are ProjectPath, ECM System, Using Migration API, Is Already Exported, Source Path, Source 

ID, Specification Template Path, Export Location, SiteCollection Url, Target Url, Verification 

and Schedule. 

Based on this template file, a migration plan file is created and the fields are configured by 

using Tzunami  <ECM> Migration Planner tool which is guided through exporter wizard. Based 

on the selected folders, a number of migration plans are created in the migration plan file. 

The field in migration plan Is Already Exported will have default value FALSE. However, you 

have to set its value to TRUE when you want to process from existing (already exported content 

from .tdx file) to migrate the source content. 
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The field in migration plan Using Migration API will have default value FALSE. However, you 

have to set its value to TRUE when you want to Migration API while migrating to SharePoint 

target. 

This template file is not required to process manually. You need to run the Tzunami Exporter 

tool to create migration file and need that created migration file manually. The following 

section guides you in details. 

The following subsections will guide you through the steps involved to configure the 

automation process sequentially. 

• Create Exporter Specification file and Migration Plan through Tzunami  <ECM> 

Migration Planner tool in Migration Project 

• Update Migration Plan file  

• Import the migration file in Tzunami Auto Migration Manager (In Windows System 

Tray) 

8.1 CREATE MIGRATION PLAN FILE 
Tzunami Deployer uses the Migration Plan file and Specification file to schedule auto 

migration Deployer projects. These files are created by Tzunami  <ECM> Migration Planner 

tool. This tool opens the respective ECM exporter. To create Migration Plan and Specification 

files, perform the following steps: 

1. Run the Tzunami  <ECM> Migration Planner from start menu, for example, here, 

Livelink exporter is started. 

 

 
Figure 8-2 ECM Source Connection Screens 

2. Select the required options 
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Figure 8-3 ECM Source Export Options Screens 
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Click on Next button. 

 

3. Source and Target Mapping wizard opens. In the left side, source folders/subfolders are 

displayed in tree structure. Select the folders/subfolders for migration in a chunk. 

In the right side, enter the Target SharePoint URL and connect. The Target SharePoint is 

loaded in the tree view. Select site or subsite or Library or List as root of deployment. 

 

Figure 8-4 Mapped Source and Target screen 

Click on Map button. You will see the mapped source and target root for migration. You 

can remove the mapped source and target. you can check/uncheck the check box to 

select or not for subfolders in source automatically. 

 After mapping, click on Next button. 

 
The migration plan file will create number of rows based on the folders selected in this tree view. You 
should expand the root folder and select the subfolders wisely so that migration plan file will have 
manageable number of jobs created. 
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4. In the Property Mapping screen, select the source and target property and click on Map 

button to map properties. If you want to create source property in target, the select the 

source property and click on Add button. 

 
Figure 8-5 Property Mapping Screen 

After completing property mapping, click on Next button. Multiple property mapping 

screens may appear, complete mapping as required. 
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5. In the Security Mapping screen, enter the site collection URL and click on Load[Service] 

button. 

a. Entities Tab: Select the user and group from source and target, then click on 

Map button. The mapped users and groups are displayed the bottom panel. 

The Users and Groups check boxes help to filter users and groups quickly. The 

filter text helps to find the relevant items quickly in source, target and mapped 

panels. Mapping source group to !<Create New Group>!, creates new group in 

target having group name as in source. You can remove the mapped group 

using Remove button. The Suggest button provides the best matching 

suggestion for mappings. 

 

Figure 8-6 Users and Groups Mapping 
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b. Roles Tab: Select roles from source and target, then click on Map button. The 

mapped roles are displayed the bottom panel.  You can remove the mapped 

group using Remove button. The Suggest button provides the best matching 

suggestion for mappings. The filter text helps to find the relevant items quickly 

in source, target and mapped panels. 

 

 

Figure 8-7 Roles Mappings 

After mapping users, groups and roles, click on Next button. 
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6. In Project Options screen, provide the location to create auto migration plan files.  

The Project folder holds Auto Migration csv, Auto Migration created Deployer Project 

and Exported TDX information and extracted files. Deployer project name and exported 

folder name will be auto created. Please use a folder close to the drive root to allow 

deep hierarchies and long file names. 

 
Figure 8-8 Creating Migration Plan Screen 

  Check the following check boxes and set date time for: 

▪ Use Migration API: check this option to use the migration api in auto 

migration project. 

▪ Start Verification after migration: check this option to use the migration 

verification feature right after completing the migration. 

▪ Schedule Date and Time: set the date and time for auto migration project to 

start. 

After completing, click on Done button. If confirmation for location to create is 

displayed, click on  Yes button. 
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The required files are created in the provided location under Plan folder. The folder contains 

following file formats: 

• .csv : This is the Auto Migration Plan file. It  stores all the information 

required to create the auto migration project in Tzunami Deployer later on 

along with all other information about source, target and schedule time. 

This file needs to imported in Tzunami Auto Migration Manager to schedule 

and execute the migration. 

• .xml : This is the specification file. This file includes all the information 

required to extract the data from source server during auto migration. It 

stores the hierarchy selected for migration along with connection 

parameters, credentials (in encrypted form), Tzunami Exporter options and 

other filter parameters as specified during creation of migration plan file. 

  

8.2 ABOUT MIGRATION PLAN 
Migration Plan file (MigrationPlan.csv) includes following information in which some 

ProjectPath, ECM System, Using Migration API, Is Already Exported, Export Location Site 

collection URL, Target URL, Verification and Schedule fields should be updated. 

Description of fields: 

• Project Path: Location and name of Deployer Migration project to be 

created for auto migration. Location and project name should be unique if 

there are multiple rows in migration plan file. 

In Project path, the full name of the migration project should have been 

defined. Note that .tde extension has been provided. So, the Project path for 

project can be  

“D:\DeployerMigration\livlinkExport\CH001\DEProject\CH001.tde” 

referencing to export location. We can clearly see that the auto migration 

project will be created in DEProject directory. 

• ECM System: Name of the source ECM. 

• Using Migration API:  Based on the option selected, the migration API is set 

to “FALSE” or “TRUE”.  

• Is Already Exported: By default it is set to “FALSE”. 

Set to “TRUE” if you want to use automation migration from already 

exported content. The already migrate data should be available in specified 

Source Path location. 

• Source Path: source container path which is willing to migrate. No need to 

set if “Is Already Exported” is true. 

• Source ID: Unique of that container which is willing to migrate. For 

Documentum ECM 'Object Id' of the container. No need to set if “Is Already 

Exported” is true. 

• Specification Template Path: File path of the specification file which is save 

during plan file creation. No need to set if “Is Already Exported” is true. 
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• Export Location: Export location also set during plan file creation. Export 

location for each migration job (each row in migration plan) should be 

different. Otherwise, duplicate export location error occurs. 

if “Is Already Exported” is true then provide already exported folder 

locations for each migration jobs. 

• Site Collection URL: Target SharePoint site collection URL where exported 

content is to be migrated. Migration project   

• Target URL: Target SharePoint URL where exported content is to be 

migrated. Provide full URL for sites/subsites for Lists where you want to 

migrate data. 

• Verification: Based on the option selected, the verification is set to “FALSE” 

or “TRUE”. Setting true will start the verification jobs after migration 

automatically. Note that, you should already have the license for migration 

verification to use this feature. Please, refer Migration Verification User 

Guide for more details about migration verification feature. 

• Schedule: Either 'Now' or Date Time to schedule the migration jobs. 'Now' 

will immediately start the migration. If Date Time is provided, then 

migration process will be start on that date and time. The scheduled job will 

create a new Deployer Migration Project in the same location as specified in 

Project Path field. 

 
Figure 8-9 Example of Updated Migration Plan File 
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8.3 AUTO MIGRATION MANAGER 
Once Deployer has been installed, a Tzunami Migration application will run in windows system 

tray. This application helps to manage the migration projects in the machine. The updated 

migration plan should be imported in this application. On successful import, the migration 

projects are updated in migration database and Deployer Migration projects will run on 

scheduled date and time.  

For the first time, user needs to provide the credential for target SharePoint. The credentials 

and cookies for each site collections are saved in C:\ProgramData\Tzunami\UsersCache 

location. Different site collections can use different users as well, however using same 

migration user for all site collection is recommended. As usual, migration user must be the 

member of site collection administrator group of each site collections. It is recommended that, 

create a pilot project and connect the target site collection in the machine where auto 

migration will run, so that the required cookie for auto will be available during auto running the 

migration projects.  

To import the migration plan file in Tzunami Migration application, perform following steps: 

1. Go to System Tray. 

2. Right click on Tzunami Migration application. 

3. Click on Open Tzunami Auto Migration Manager, an application opens. 

 
Figure 8-10 Auto Migration Manager Screen 

4. Click on Browse, select the migration plan file. Then, click on Import Plan button. On 

successful import, tasks will be scheduled and displayed in the list. 
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Figure 8-11 Auto Migration Manager scheduled jobs 

 

If any error occurs during import of migration plan, errors are logged in auto migration log 

file. The log file is maintained date wise and located in the Deployer install directory. e.g.:  

C:\Program Files (x86)\Tzunami\Deployer 4.0\Log\AutoMigration_2022_06_08.xml 

5. The Tzunami Auto Migration Manager manages scheduling migration jobs. 

6. The migration projects can be searched based on status and scheduled date. 

7. The status dropdown includes following status: 

• All: available all jobs. 

• Pending: jobs in queue to run in scheduled date time. 

• Running: jobs in running state now. 

• Completed: already completed jobs. 

• Paused: jobs in suspension state (until it is changed to pending state back). 

The Scheduled Date field provide date picker to select a date. 

 The Search/Refresh button searches and updates the list of scheduled jobs based on 

selected status. The Export, Reading, Deploy and Migrate status fields shows the status of 

migration process. The color index is as follows:  

Grey: Pending. 

Blue: Running. 

Green: succussed without error. 

Red: Error occurred. 
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Figure 8-12 Tzunami Auto Migration Manager Screen 

 Once the migration is completed, the manager looks like as below: 

 
Figure 8-13 Tzunami Auto Migration Manager Screen after completion 

Where, the green button indicates that the migration job status is completed without error. The 

status column with “Completed” indicates the migration project is completed. However, there 

may be errors while migrating data to target source.  

8. You can perform the following actions for each job. 

• Change status: You can change the status of a job from ‘Pending’ to ‘Paused’ and vice-

versa. 

o If a job is in pending state, it can be changed to paused state to pull out the job 

from queue. 
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o If a job is in paused state, it can be changed to pending state to push the job in 

queue. 

• Reschedule Date: you can change the Date of a job to reschedule in different date time. 

• Save: When you change the Status and/or Date of a job, you need to save it by pressing 

‘Save’ button for that job under Action column. 

• View the reports of exported data:  Click on folder icon after Source column for 

completed jobs. 

•  View the reports of migrated data:  Click on folder icon after Target column for 

completed jobs. 
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9 AUTO DELTA MIGRATION 

Tzunami Deployer provides the feature to automatic scheduled delta migration from supported 

ECM system to SharePoint. The scheduled jobs in windows for automatic migration works 

based on the parameters specified in delta migration plan file. The template for migration plan 

is available in Deployer installation directory (DeltaMigrationPlan.csv). 

Auto delta migration works under following conditions: 

• Previous Deployer Migration project (tde) should not be modified, deleted and 

renamed. 

• Source and Target of the Deployer Migration project should not be removed. 

• ExportSpecFile.xml file which is located on SpecificationFiles folder on Deployer 

Migration project folder should not be modified, renamed or deleted. 

• Delta migration setting should be set before delta migration under Deployer Option. 

Furthermore, auto delta migration auto detects the changes in source data based on following 

behavior.  

• Delta migration supports all filter applied in the first export except modified filter as 

delta export is based on modified date. 

• Delta migration will export and migrate all the file which are modified after the first 

export. 

 
The current implementation does not support the auto delta migration of auto migrated 
Deployer projects. 

If same container is exported and migrated with multiple chunks with filter condition then, 
delta of each project will export same content which might cause duplication. 
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Automatic delta migration can be carried out in Tzunami Deployment with following approach. 

1. Creating auto delta migration plan file manually. 

The Tzunami Delta Migration Manager will be running in the system tray where Tzunami 

Deployer is installed. 

To open the Tzunami Delta Migration Manager, perform the following steps: 

• Go to System Tray, and locate Tzunami Migration application. 

• Right click on Tzunami Migration application, then click on Open Tzunami Delta 

Migration Manager option. 

• The Tzunami Delta Migration Manager window opens. 

 
Figure 9-1 Tzunami Delta Migration Manager Window 

 

In this window user can perform following actions: 

• User can browse the auto delta migration plan file using Browse button 

• User can import the browsed auto delta migration plan file using Import Plan 

button 

• User can view the auto delta migration jobs and status in the list. 

• The job list can be filter with Status and Scheduled Date using Search/Refresh 

button. 
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9.1 CREATING AUTO DELTA MIGRATION PLAN FILE MANUALLY 
Auto delta migration schedule (.csv) can be created manually for existing projects with csv 

column “Project path” and “schedule date” and that csv can be imported from auto migration 

tray. 

 
Figure 9-2 Sample Auto Delta Migration Plan File 
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10 CONFIGURING TZUNAMI DEPLOYER 

ADVANCE FEATURES 

This chapter describes how to configure Tzunami Deployer settings and covers about rule 

engine. 

10.1 RULE ENGINE 
Deployer Rule Engine is a powerful Deployer component that enables you to automate large 

parts of the deployment process by creating flowcharts of If-Then statements in a rule editor. 

A Rule consists of a set of conditions (logical IFs) and Actions (logical THENs). If all conditions 

are fully met, then the Actions are executed. A Rule Set is a set of rules that define 

deployment options for a specific Enterprise Content Management (ECM) system. 

The Deployer Rule Engine is intended for power users, System Integrators, and Tzunami 

Deployer specialists. It provides you with a high degree of freedom in regard to the business 

logic you can create.  

The order of the Rules in a Rule Set is important. The Rule Engine processes each container 

item in the deployed item, evaluating the Rules one after the other against each item. If even 

one Condition is not met, the Rule is ignored, and the Rule Engine proceeds to the next Rule. If 

all Conditions are met, the Actions are performed, and the Rule Engine continues handling the 

next item. No other rule is evaluated for that item. As a result, even if two Rules are valid for a 

certain item, only the first Rule is evaluated and performed. 

The Rule Sets Editor contains several built-in default Rule Sets that define some common 

deployment logic schemas. You can customize these default Rule Sets to suit your specific 

deployment needs. 

10.1.1 Opening the Rule Sets  

To open the Rule Sets Editor: 

• Select Tools > Deployment Rules.  

Or 

Press F8. 

The Rule Sets Editor appears. 
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Figure 10-1: Rule Sets Editor 

10.1.2 Specifying Rule Set Location 

Rule Sets are saved on the file system. The location of each Rule Set must be specified in the 

Rule Engine.  

To specify the locations of Rule Sets: 

Select Tools > Options. The Options window appears.  

1. Click Rule Engine. 

   
Figure 10-2: Options Window 

2. Click Add and browse to the location of the Rule Set. 

Or 
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Enter the location in a new line in the Locations area. 

3. Select Rule Set and click OK. 

 
You can use two special variables in the definition of the location: 

@DEPLOYER@ – denotes the Tzunami Deployer installation folder. 

@PROJECT@ – denotes the currently open Tzunami Deployer project. 

You can delete a location by highlighting the relevant text in the Location area, and 
deleting it. 

 
You can specify that the location of a new Rule Set be automatically added to the list 

of locations, by clicking Add location to list of rules set locations when you define a 

new Rule Set (Figure 10-3). 

10.1.3 Rule Sets Editor 

You can create multiple Rule Sets for each ECM system. However, at any given time, only 

one Rule Set can be used during the deployment process. 

To set which Rule Set to use during the deployment process: 

1. Select Tools > Options in the menu. The Options window appears, displaying 

the existing Rule Sets in the bottom half of the screen (Figure 10-3). 

2. Select the Rule Set for the ECM to use during the deployment. 

10.1.4 Creating a New Rule Set 

To create a Rule Set: 

• In the Rule Sets Editor (Figure 10-1), click New Rules set. The New 

Deployment Rules Set Form appears. 

 
Figure 10-3: New Deployment Rules Set Form 

• Enter the following information for the new Rule Set and click OK. 

Table 10-1: New Deployment Rule Set Form Fields 

Field Description 

Rules Set Name Specify a name for the Rule Set. 

Type Select the type of source ECM the Rule Set applies to from the 
drop-down list. 

Filename Specify where to save the Rule set file. 
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Field Description 

Add location to list of 
rules set locations  

Select this option if you wish to display the file location in the 
Locations pane in the Options window (Figure 10-2). 

 

 
If the Rule Set you are creating is very similar to an existing Rule Set, you can 
duplicate the existing Rule Set and edit its rules. 

10.1.5 Copying a Rule Set 

To copy a Rule Set: 

When you duplicate a Rule Set, it appears with the same name as the original Rule Set, 

followed by - Copy. 

1. Select Tools > Deployment Rules. The Rule Sets Editor appears. 

2. In the Rule Set Editor toolbar, click Copy.  

 

10.1.6 Creating a Rule in a Rule Set 

To create a rule in a Rule Set: 

1. Click New in the Rules toolbar. The Rule Editor window appears. 

 
Figure 10-4: Rule Editor Window – General Tab 

 

2. In the General tab enter the following information:  

Table 10-2: Rule Editor, General tab – Description of Fields 

Field Description 

Title Enter a name for the rule. 
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Field Description 

Description Enter a description for the rule. 

Enabled Select if you want this rule to be processed as part of the Rule Set. 

 

3. Click the Conditions tab and define the condition(s): 

a. Click New. The Conditions Selector window appears, listing all 

available conditions.  

 
These conditions may differ depending on the type of ECM system you specified in 
the Type field of the Rule Set. 

 
Figure 10-5: Conditions Selector Window 

b. Select the Condition(s) you wish to add and click OK. Each Condition 

is displayed both in the top pane and the bottom pane. The 

Condition’s variables are marked in blue and underlined.  

 
Figure 10-6: Rule Editor Window – Conditions Tab 

c. In the bottom pane, select a value for each variable by clicking the 

variable, and entering or selecting a value. 

 
If you do not select a value, the rule is considered incomplete, and will not be 
processed. 
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4. Click the Actions tab and define the action(s): 

a. Click New. The Actions Selector window appears, listing all available 

actions. Note that these conditions may differ depending on the 

type of ECM system you specified in the Type field of the Rule Set.  

 
Figure 10-7: Actions Selector Window 

 

b. Select the Actions you wish to add and click OK. Each Action is 

displayed both in the top pane and the bottom pane. The Action’s 

variables are marked in blue and underlined. 

 
Figure 10-8: Rule Editor Window – Actions Tab 

 

c. In the bottom pane, select a value for each variable by clicking the 

variable, and entering or selecting a value. 

 
If you do not select a value, the rule is considered incomplete, and will not be 
processed. 
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10.1.7 Copying and modifying a Rule in a Rule Set 

This option is useful if you wish to create a rule that is similar to an existing one. Instead of 

creating a new rule from scratch, you can first copy the existing rule, and then edit it.  

To copy a rule in a Rule Set: 

1. Select the rule you wish to duplicate. 

2. Click Copy in the Rule toolbar. The Rule Editor window appears, displaying 

the new rule. 

You can now edit the information in the General, Conditions, and Actions 

tabs of the rule.  

To edit a rule in a Rule Set: 

1. Select the rule you wish to edit. 

2. Click Edit in the Rule toolbar.  

Or 

Double-click the rule. 

The Rule Editor window appears, displaying the selected rule. 

You can now edit the information in the General, Conditions, and Actions 

tabs of the rule. 

10.1.8 Defining Conditions 

This section provides descriptions of the various Conditions you can define. Each description 

includes the relevant variables, as well as general remarks, if applicable. 

 
If you specify multiple Conditions in a rule, Tzunami Deployer arranges them in the 
order in which they will be evaluated. You cannot change this order. 

If you define contradicting Conditions in a Rule, the Rule will never be executed, 
because there will never be a case when all Conditions are met. 

You can define a Rule with no conditions. This rule will apply to all items. However, 
note that only this rule will be executed. 

10.1.8.1 Parent is of type <Parent Type> 

Check if the designated (new) parent of the item is of a certain type. 

Variables 
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Variable Description 

<Parent Type> The type of the designated parent. The type can be one of the following 
values: 

• Web Application 

• Site Collection 

• Sub Site 

• Area – The Portal Area used in a SharePoint 2003 Server 

• Site – Automatically adjust between Root site, WSS, or Area 

• Document Library 

• Image Library 

• List – A list of any type, including Document Library and Image 
Library 

• Folder/List. Note that lists are also recognized as folders 

• Area Listing – The List used in a SharePoint 2003 Server 

 

10.1.8.2 Items is at level <Level> of parent <Parent Type> 

Check if the Items hierarchy is at same level of designated parent type items. 

Variables 

Variable  Description 

<Level> The value (or values) to search for in the item. 

<Parent Type> The type of the designated parent. The type can be one of the 
following values: 

• Web Application. 

• Site Collection. 

• Sub Site. 

• Area – The Portal Area used in a SharePoint 2003 Server. 

• Site – Automatically adjust between Root site, WSS, or 
Area. 

• Document Library. 

• Image Library. 

• List – A list of any type, including Document Library and 
Image Library 

• Folder/List. Note that lists are also recognized as folders 

• Area Listing – The List used in a SharePoint 2003 Server 

 

10.1.8.3 Source Parent is of type <Source Type> 

Checks the source type of the parent of current item 

Variables 
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Variable Description 

<Source Type> The type of the designated parent. The type can be one of the 
following values: 

• Web Application 

• Site Collection 

• Sub Site 

• Area – The Portal Area used in a SharePoint 2003 Server 

• Site – Automatically adjust between Root site, WSS, or 
Area 

• Document Library 

• Image Library 

• List – A list of any type, including Document Library and 
Image Library 

• Folder/List. Note that lists are also recognized as folders 

• Area Listing – The List used in a SharePoint 2003 Server 

 
Remarks 

This condition is only available if you specified SharePoint 2007, SharePoint 2010, 

SharePoint 2013, SharePoint 2016 and SharePoint 2019 in the Type field of the Rule Set. 

10.1.8.4 Source is of type <Source Type> 

Checks the source type of the current item 

Variables 

Variable Description 

<Source Type> The type of source. The type can be one of the following values: 

• Web Application 

• Site Collection 

• Sub Site 

• Area – The Portal Area used in a SharePoint 2003 Server 

• Site – Automatically adjust between Root site, WSS, or Area 

• Document Library 

• Image Library 

• List – A list of any type, including Document Library and Image 
Library 

• Folder/List. Note that lists are also recognized as folders 

• Area Listing – The List used in a SharePoint 2003 Server 

 

Remarks  

This condition is only available if you specified SharePoint 2003, SharePoint 2007, 

SharePoint 2010, SharePoint 2013, SharePoint 2016 or SharePoint 2019 in the Type field of 

the Rule Set. 
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10.1.8.5 Source Server Template is <Server Template> 

Check if the source list is based on a specific list definition type (server template). 

Variables 

Variable  Description 

<Server 
Template> 

Server template ID of the source list. In SharePoint 2007 it is also 
referred to as Base Template. This can be one or several of the values in 
Table 10-3, or any custom Server Template ID. 

 

Table 10-3: Standard Template IDs 

ID Template Name ID Template Name 

0 No List Template 202 Meeting Attendees List 

100 Generic List 204 Decision 

101 Document Library 204 Meeting Decisions List 

102 Survey 207 Meeting Objective 

103 Links 207 Meeting Objectives List 

104 Announcements 210 Text Box 

105 Contacts 210 Meeting Text Box 

106 Events 211 Things To Bring 

107 Tasks 211 Meeting Things To Bring List 

108 Discussion Board 212 Home Page Library 

109 Picture Library 212 Meeting Workspace Pages List 

110 Data Sources 300 Portal Sites List 

111 Web Template Catalog 301 Posts 

112 User Information 302 Comments 

113 Web Part Catalog 303 Categories 

114 List Template Catalog 402 Facility 

115 XML Form 403 Whereabouts 

116 Master Page Catalog 404 Call Track 

117 No Code Workflows 405 Circulation 

118 Workflow Process 420 Timecard 

119 Web Page Library 421 Holidays 

120 Custom Grid 499 IMEDic 

121 Solution Catalog 600 External List 

122 No Code Public 850 Publishing Page Library 

130 Data Connection Library 1100 Issue Tracking 

140 Workflow History 1200 Admin Tasks 

150 Gantt Tasks 1220 Health Rule 

200 Meetings 1221 Health Reports 

200 Meeting Series List 1301 Translation Lists 

200 Area Document Library 2002 Personal Document Library 

201 Agenda 2003 Private Document Library 

201 Meeting Agenda List -1 Invalid Type 

202 Meeting User   

 
Remarks 
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• You can enter any custom Server Template ID in order to support 
customized lists.  

• This condition is only available if you specified SharePoint 2010, SharePoint 
2013, SharePoint 2016 or SharePoint 2019 in the Type field of the Rule Set. 

10.1.8.6 Source Item is a Document Workspace  

Check if the source item is a document workspace 

10.1.8.7 Expected target parent is a Meeting Workspace 

Check if the expected target parent is a Meeting Workspace. 

10.1.8.8 Source item is a Meeting Workspace 

Check if the source item is a meeting workspace 

10.1.8.9 Source parent item's <'Property Name'> property equals <Values> 

Checks if the value of the current item’s source parent item property equal certain value. 

Variables 

Variable Description 

<Property Name> The display name of the property (case sensitive). 

<Value> The value (or values) to search for in the item.  

 
Remarks 

If property name is entered in <Property Name>, then the Condition is true only if the 

value matches the current items source parent property name. 

10.1.8.10 Number of subitems <Great/Equals/Less than> <Number> <not including 

items under sub-containers> and <count sub-containers as items> 

Check if the number of sub items of item is greater than/equals to/ less than the total 

number of sub-containers as items excluding item under sub-container. 

Variables 

Variable Description 

<Great/Equals/Less than > The type of the Operators. The type can be one of the 
following values: 

• Greater Than 

• Equal 

• Less Than 

< Number> The value (or values) to search for in the item. 

<not including items under 
sub-containers> 

• Including items under sub-containers (recursively) – 
Select number of sub-items under sub-containers 
(recursively) 

• Not including items under sub-containers – Do not 
select the number of sub-items under sub-
containers   
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<count sub-containers as 
items> 

• Count sub-containers as items – Count number of 
sub-items in sub-containers as items 

• Do not count sub-containers as items– Do not 
Count number of sub-items in sub-containers. 

 

10.1.8.11 Source Item’s <Property Name> property equals <Value> 

Checks the value of the source item’s property 

Variables 

Variable Description 

<Property Name> The display name of the property (case sensitive). 

<Value> The value (or values) to search for in the item.  

 
Remarks 

If property name is entered in <Property Name>, then the Condition is true only if the 

value matches the current items property name. 

10.1.8.12 Container <is/is not empty> 

Check if the container is empty or not. 

Variables 

Variable Description 

is A keyword indicating that the container does not have items 

Is not empty A keyword indicating that the container has items  

 

10.1.8.13 Source item's <'Property Name'> property contain <'Value'> 

Check if the source item’s property name contains a value. 

Variables 

Variable Description 

<Property Name> The display name of the property (case sensitive). 

<Value> The value (or values) to search for in the item.  

 

10.1.8.14 Source item's children have <all> of the properties <Values> 

Check if the children of the current item have certain property value. 

Variables 

Variable Description 

<all> The display all or any value of the property 
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<Values> The value (or values) to search for in the item. 

 

10.1.8.15 Parent Deployment option <Property Name> equals <Value> 

Check if the deployment option of the current item’s parent property has a certain value. 

Variables 

Variable Description 

<Property Name> The deployment option property to check. This can be one of the 
following values: 

• Invalid 

• Description 

• Language Id 

• Language Name 

• List Template Name 

• List Template Server template. 

• List Template Base type. 

• URL 

• Owner login name 

• Owner display name 

• Site Template name 

• Title 

• Deploy Files  

• Deploy Hierarchy  

• Flat Deploy  

<Value> The value to search for in the deployment options of the item. 

 

10.1.8.16 Deployment option <Property Name> equals <Value> 

Check if the deployment option of the current item property has a certain value. 

Variables 
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Variable Description 

<Property Name> The deployment option property to check. This can be one of the 
following values: 

• Invalid 

• Description 

• Language Id 

• Language Name 

• List Template Name 

• List Template Server template. 

• List Template Base type. 

• URL 

• Owner login name 

• Owner display name 

• Site Template name 

• Title 

• Deploy Files 

• Deploy Hierarchy 

• Flat Deploy 

Value The value to search for in the deployment options of the item. 

 

10.1.8.17 Source Item {Does | Does not have} unique permissions 

Checks if a source item has unique permissions or it inherited/has the same permissions as 

the parent. 

Parameters 

Parameter Description 

Does A keyword indicating that the source item has unique 
permissions. 

Does not have A keyword indicating that the source item does not have unique 
permissions. 

10.1.8.18 Any of the subitems' <'Property Name'> property equal <Values> (Do not 

look recursively in sub-containers) 

Check if property of sub-item of item has certain property values but don’t look recursively 

in sub-containers of item 

Parameter 

Parameter Description 

All The display any or all properties 

Value The value to search for in the deployment options of the item. 
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Parameter Description 

(Do not look recursively 
in sub-containers) 

• Look recursively in sub-containers 

• Do not look recursively in sub-containers 

 

10.1.8.19 All sub-items’ <Property Name> property equals <Value> (using <flags>) 

Check if the property of all sub-items of item has certain value using the provided flag. 

Variables 

Variable Description 

<Property Name> The display name of the property (case sensitive). 

<Value> The value (or values) to search for in the item. 

<flags> • Consider folders – Selecting this flag will consider 
subfolder of folder containing subfolders and items. 

• Look recursive – Selecting this flag will recursively look 
for items or folders in containers. 

• Accept empty containers – Selecting this flag will 
accept empty containers 

• Ignore already deployed items – Selecting this flag will 
help to ignore which is already deployed. 

 
Remarks 

• If a property name of each sub-items of item is entered in <Property Name>, 

then the Condition is true only if the values of all sub-items of item include 

value defined in the Condition using the flag. 

• This Condition will also check the items and files of the currently checked 

container. 

10.1.9 Defining Actions 

This section provides descriptions of the various Actions you can define. Each description 

includes the relevant variables, as well as general remarks if applicable. 

 
If you specify multiple Actions in a rule, Tzunami Deployer arranges them in the 
order in which they will be evaluated. You cannot change this order. 

If you define illogical combinations of Actions; the Actions are performed in the order 
determined by Tzunami Deployer, and invalid Actions are ignored. 

10.1.9.1 Deploy as <Type> 

Sets the deployment options to deploy as a certain type 

Variables 
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Variable Description 

<Type> The type to deploy as. This can be one of the following values: 

• Web Application 

• Site Collection 

• Sub Site 

• Area – The Portal Area used in a SharePoint 2003 Server 

• Site  – Automatically adjust between Root site, WSS, or Area 

• Document Library 

• Image Library 

• List – A list of any type, including Document Library and Image Library 

• Folder/List. Note that lists are also recognized as folders 

• Do not Deploy – Using during the deployment process 

• Area Listing - The List used in a SharePoint 2003 Server 

 

10.1.9.2 Set <Deploy Option> to <Value> 

Sets a deploy option to a certain value. 

Variables 

Variable Description 

<Deploy Option> The name of the deployment option. This can be one of the 
following values. 

• Invalid 

• Description 

• Language Id 

• Language Name 

• Title 

• Deploy Files 

• Deploy Hierarchy 

• Flat Deploy 

• Enable Quick Launch 

• Inherit Navigation 

• On Top Navigation bar 

Value The value to set for the deployment option. 

 

10.1.9.3 Set the best-matching workspace template 

When an item is deployed as a site, this action matches the template of the deployed site 

to best matching available site templates. 
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10.1.9.4 Set Template to <Site Template> 

When an item is deployed as a site, this action sets the site template to a certain template. 

Variables 

Variable Description 

<Site Template> The name of the site template. For example: Team Site, Blank 
Site, and so on. 

 
Remarks 

This Action is valid only when an item is deployed as a site. 

10.1.9.5 Set Template using the following <mapping>  

When an item is deployed as a site, this action sets the site template according to the 

specified site mapping. 

Variables 

Variable Description 

<Mapping> A mapping of source templates to target templates. See Table 
10-4 and Table 10-5 for a list of standard source template IDs 
and standard target template Name#IDs. 

 

Table 10-4: Standard source values (Template base type IDs) 

ID Template Name Description 

1 STS Template for Team Site, Blank site and Document 
workspace 

2 MPS Meeting Workspaces Template 

3 CENTRALADMIN Central Admin Site 

4 WIKI Wiki Site 

9 BLOG Blog 

20 SPS SharePoint Portal Server Site (Obsolete) 

21 SPSPERS SharePoint Portal Server Personal Space 

22 SPSMSITE Personalization Site 

30 SPSTOC Contents area Template (Obsolete) 

31 SPSTOPIC Topic area template (Obsolete) 

32 SPSNEWS News Site Template (Obsolete) 

33 SPSNHOME News Site Template 

34 SPSSITES Site Directory 

36 SPSCOMMU Community area template 

38 SPSREPORTCENTER Report Center 

39 CMSPUBLISHING Publishing Site 

47 SPSPORTAL Collaboration Portal 

50 SRCHCEN Search Center with Tabs 
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ID Template Name Description 

51 PROFILES Profiles 

52 BLANKINTERNETCONTAINER Publishing Portal 

53 BLANKINTERNET Publishing site Template 

54 SPSMSITEHOST My Site Host 

 

Table 10-5: Standard target values (Template name#Configuration ID) 

Template Name#ConfigurationID Title 

STS#0 Team Site 

STS#1 Blank Site 

STS#2 Document Workspace 

MPS#0 Basic Meeting Workspace 

MPS#1 Blank Meeting Workspace 

MPS#2 Decision Meeting Workspace 

MPS#3 Social Meeting Workspace 

MPS#4 Multipage Meeting Workspace 

CENTRALADMIN#0 Central Admin Site 

WIKI#0 Wiki Site 

BLOG#0 Blog 

SPS#0 SharePoint Portal Server Site (this template is obsolete) 

SPSPERS#0 SharePoint Portal Server Personal Space 

SPSMSITE#0 Personalization Site 

SPSTOC#0 Contents area Template (this template is obsolete) 

SPSTOPIC#0 Topic area template (this template is obsolete) 

SPSNEWS#0 News Site (this template is obsolete) 

SPSNHOME#0 News Site 

SPSSITES#0 Site Directory 

SPSCOMMU#0 Community area template (this template is obsolete) 

SPSREPORTCENTER#0 Report Center 

CMSPUBLISHING#0 Publishing Site 

SPSPORTAL#0 Collaboration Portal 

SRCHCEN#0 Search Center with Tabs 

PROFILES#0 Profiles 

BLANKINTERNETCONTAINER#0 Publishing Portal 

BLANKINTERNET#0 Publishing Site 

BLANKINTERNET#1 Press Releases Site 

BLANKINTERNET#2 Publishing Site with Workflow 

SPSMSITEHOST#0 My Site Host 

 

Remarks 
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• This Action is valid only when an item is deployed as a site. 

• This Action is available only if you specified SharePoint 2010, SharePoint 

2013, SharePoint 2016 or SharePoint 2019 in the Type field of the Rule Set. 

 

• In the Rule Sets Editor, the following window appears for defining the 

mapping: 

 
Figure 10-9: Site Template Mapping Editor Window 

 

• Enter a source template ID in the left hand field under Add mapping 

entries, and enter a target template Name#ID in the right hand field 

under Add mapping entries. Click Add to add this entry to the list of 

source and target values. 

• The source value “%OTHER%” can be used as a placeholder, 

signifying “any other template”. This can be used as a default 

mapping, instead of defining mappings for all source options. 

10.1.9.6 Use List Template having server template <Server Template>ID 

When an item is deployed as a list, this action sets the List Template based on a Server 

Template ID. 

Variables 

Variable Description 

<Server Template> The server template ID. You can enter a standard template ID 
(see Table 10-3 for a list of standard template IDs), or any 
custom Server Template ID. 

 
Remarks 
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• You can enter any supported Server Template ID, in order to support lists 

and libraries.  

• This Action is valid only when item is deployed as a list. 

• This Action is based on the SharePoint recommendation, in which each list 

template has a unique Server Template ID. 

10.1.9.7 Use List Template <Server Template Name> 

When an item is deployed as a list, this action sets the List Template based on the list 

template’s Name. 

Variables 

Variable Description 

<Server Template 
Name> 

The server template Name. You can enter a standard template name 
(such as Document Library, Contacts, and so on, see Table 10-3 for a 
list of standard template IDs) or any custom Server Template name. 

 
Remarks 

You can enter any supported Server Template Name, in order to support lists or libraries.  

10.1.9.8 Set List Template using the following <mapping>  

While an item is deployed as a list, this action maps template ID number from source to 

target according to the specified list template mapping. 

Variables 

Variable Description 

<mapping> A mapping of source template IDs to target template IDs. You can enter 
standard source and target template IDs (see Table 10-3 for a list of 
standard source and target template IDs), or any custom Server Template 
ID. 

 
Remarks 

This Action is available only if you specified SharePoint 2007, SharePoint 2010, SharePoint 

2013, SharePoint 2016 or SharePoint 2019 in the Type field of the Rule Set. 
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• In the Rule Sets Editor, the following window appears for defining a 

mapping: 

  
Figure 10-10: List Template Mapping Editor Window 

• Enter a source list template ID in the left hand field under Add 

mapping entries, and a target list template ID in the right hand field 

under Add mapping entries. 

• Click Use Existing to specify that if the site template includes this list 

type, it will be used and set true to existing column. 

• Click Add to add this entry to the list of source and target values. 

10.1.9.9 Set List Template using the following <mapping> (automatic) 

While an item is deployed as a list, this action automatically maps template ID number 

from source to target according to the specified list template mapping. 

Variables 

Variable Description 

<mapping> A mapping of source template IDs to target template IDs. You can enter 
standard source and target template IDs (see Table 10-3 for a list of 
standard source and target template IDs), or any custom Server Template 
ID. 

 
Remarks 
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• This Action is available only if you specified SharePoint 2007, SharePoint 

2010, SharePoint 2013, SharePoint 2016 or SharePoint 2019 in the Type field 

of the Rule Set. 

• In the Rule Sets Editor, the following window appears for defining a 

mapping: 

  
Figure 10-11: List Template Mapping Editor Window 

• Enter a source list template ID in the left hand field under Add 

mapping entries, and a target list template ID in the right hand field 

under Add mapping entries. 

• Click Add to add this entry to the list of source and target values. 

10.1.9.10 Use <property mapping file> and <add required target properties> 

Sets an XML document as the property mapping to be used for the item, and 

specifies whether to add required target properties. 

Variables 

Variable Description 

<mapping> The path to on XML file that defines the property mapping. 

Add required target 
properties| 
Don’t add required target 
properties 

Required target properties are the properties that are required 
in the target item but are not present in property mapping XML 
file. 

Use these keywords to specify whether to add missing 
properties to the target. 

10.1.9.11 Sample Property Mapping XML File 
<PropertyMapping SourceSet=“Tasks Column Set” TargetSet=“Tasks Column Set 2”> 

  <Pair> 

    <Source DisplayName=“Created” Name=“Created” 

            PropertyType=“DateTime” /> 

    <Target DisplayName=“Created” Name=“Created Date” 

            PropertyType=“DateTime” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Approval Status” Name=“_ModerationStatus” 

            PropertyType=“ModStat” /> 

    <Target DisplayName=“Approval Status” Name=“_ModerationStatus” 

            PropertyType=“ModStat” /> 
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  </Pair> 

  <Pair> 

    <Source DisplayName=“Name” Name=“D996E646-5C05-45b7-B24A-9AFAF5B21503” 

            PropertyType=“Text” /> 

    <Target DisplayName=“Name” Name=“D996E646-5C05-45b7-B24A-9AFAF5B21503” 

            PropertyType=“Text” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Modified By” Name=“Editor” PropertyType=“User” /> 

    <Target DisplayName=“Modified By” Name=“Editor” PropertyType=“User” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Created By” Name=“Author” PropertyType=“User” /> 

    <Target DisplayName=“Created By” Name=“Author” PropertyType=“User” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Start Date” Name=“StartDate” 

            PropertyType=“DateTime” /> 

    <Target DisplayName=“Start Date” Name=“StartDate” 

            PropertyType=“DateTime” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Due Date” Name=“DueDate” PropertyType=“DateTime” /> 

    <Target DisplayName=“Due Date” Name=“DueDate” PropertyType=“DateTime” /> 

  </Pair> 

  <Pair ValueMapping=“@DEPLOYER@\Rules\Mappings\Value Mapping - Tasks - 

Priority.xml”> 

    <Source DisplayName=“Priority” Name=“Priority” PropertyType=“Choice” /> 

    <Target DisplayName=“Priority” Name=“Priority” PropertyType=“Choice” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“% Complete” Name=“PercentComplete” 

            PropertyType=“Number” /> 

    <Target DisplayName=“% Complete” Name=“PercentComplete” 

            PropertyType=“Number” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Modified” Name=“Modified” PropertyType=“DateTime” /> 

    <Target DisplayName=“Modified” Name=“Modified” PropertyType=“DateTime” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Created” Name=“Created” PropertyType=“DateTime” /> 

    <Target DisplayName=“Created” Name=“Created” PropertyType=“DateTime” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Assigned To” Name=“AssignedTo” PropertyType=“User” /> 

    <Target DisplayName=“Assigned To” Name=“AssignedTo” PropertyType=“User” /> 

  </Pair> 

  <Pair> 
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    <Source DisplayName=“Description” Name=“Body” PropertyType=“Note” /> 

    <Target DisplayName=“Description” Name=“Body” PropertyType=“Note” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Title” Name=“Title” PropertyType=“Text” /> 

    <Target DisplayName=“Title” Name=“Title” PropertyType=“Text” /> 

  </Pair> 

  <Pair ValueMapping=“@DEPLOYER@\Rules\Mappings\Value Mapping - Tasks - 

Status.xml”> 

    <Source DisplayName=“Status” Name=“Status” PropertyType=“Choice” /> 

    <Target DisplayName=“Status” Name=“Status” PropertyType=“Choice” /> 

  </Pair> 

  <Pair> 

    <Source DisplayName=“Modified” Name=“Modified” 

            PropertyType=“DateTime” /> 

    <Target DisplayName=“Modified” Name=“Last Modified” 

            PropertyType=“DateTime” /> 

  </Pair> 

</PropertyMapping> 

Where; 

DisplayName is the Properties Display name. 

Name is the SharePoint internal name. 

PropertyType can be one of the following: DateTime, ModStat, User, Choice, 

and Text. 

10.1.9.12 Sample Value Mapping XML File 

Note that the sample mapping file includes references to two external XML files that 

contain value mappings (highlighted in the sample): Status and Priority. The Status 

value mapping file for this example is: 

<ValueMapping> 

  <Pair Source=“Issue” Target=“Waiting on someone else” /> 

  <Pair Source=“Completed” Target=“Completed” /> 

  <Pair Source=“{D3A98B62-323C-4130-AA18-2CA791C9E57D}” Target=“Not Started” /> 

  <Pair Source=“{D3A98B62-323C-4130-AA18-2CA791C9E57C}” Target=“{D3A98B62-323C-

4130-AA18-2CA791C9E57A}” /> 

</ValueMapping> 

 

Where value mapping provides a few “placeholder” values: 

{D3A98B62-323C-4130-AA18-2CA791C9E57C} – Empty Source.  

{D3A98B62-323C-4130-AA18-2CA791C9E57D} – Default Source.  

{D3A98B62-323C-4130-AA18-2CA791C9E57A} – Target Map to Empty. 

{D3A98B62-323C-4130-AA18-2CA791C9E57B} – Target Map to Keep Original. 
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These values match the values available to users in the Value Mapping step of the 

deployment wizard. 

Remarks 

You can create the mapping file manually, but it is recommended to export a 

property mapping during a regular deployment, and use the exported mapping. For 

more information. 

10.1.9.13 Set Title to <Title> 

Sets the title of the new item to the selected value 

Variables 

Variable Description 

<Title> The title of the item. 

 

10.1.9.14 Use unique permissions  

When an item is deployed as a site, this action sets the site to use unique 

permissions. 

Remarks 

This Action is valid only when an item is deployed as a site.  

10.1.9.15 Set owner to <user> 

When an item is deployed as a site, this action sets the owner to a certain value. 

Variables 

Variable Description 

<User> The username of the user who is being assigned as owner. 

The username is case sensitive. It should be the full user logon name (pre-
Windows 2000: DOMAIN\user). 

 
Remarks 

This Action is valid only when an item is deployed as a root site (site collection). 

10.1.9.16 Set Description to <Description> 

Sets the description of the new item to the selected value 

Variables 

Variable Description 

<Description> The description of the item. 

 

10.1.9.17 Add the missing properties [except] 

Adds the missing properties of the item except selected property  

Variables 
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Variable Description 

<except> The description of the item value. 

 

10.1.9.18 Add the missing properties [except of type] 

Adds the missing properties of the item except selected property type  

Variables 

Variable Description 

<Description> The description of the item type value. 

 

10.1.9.19 Execute the following Rules <Rules> 

Executes selected rules of the current Rule Set 

Variables 

Variable  Description 

<rules> The rules to execute. 

 
Remarks 

• It is considered good practice to disable Rules that are meant to be executed 

as part of this Action. 

Usually, Rules that are executed by this Action are small, zero, or one condition 

Rules. These are often created as Rules only to prevent duplication of their logic in 

multiple Rules. 
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11 NAMING AND URL LENGTH CONSIDERATIONS 

To ensure the smooth management of a SharePoint migration project, you should ensure that 
Site/Sub-site, List/Library, Folder/Files, Group, Permission Name and expected URL 
conventions for invalid characters, length and reserved words etc. The following sections 
highlights the basic considerations incorporated in Tzunami Deployer.  

11.1 SITE AND SUBSITE NAME 
The naming convention, applied in Tzunami Deployer, is listed in the following table. 
 

Table 11-1 Naming Considerations for Site and Sub-site. 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 2016/2019 
and Online 

Title Length supported 
( in characters) 255 255 

   

Reserved words  
(i.e. Forbidden to use) 

PRN, AUX, NUL, COM1, 
COM2, COM3, COM4, COM5, 
COM6, COM7, COM8, COM9, 
CON, LPT1, LPT2, LPT3, LPT4, 
LPT5, LPT6, LPT7, LPT8, LPT9, 
Wpresources 

PRN, AUX, NUL, COM1, COM2, 
COM3, COM4, COM5, COM6, 
COM7, COM8, COM9, CON, 
LPT1, LPT2, LPT3, LPT4, LPT5, 
LPT6, LPT7, LPT8, LPT9, 
Wpresources 

 
 

 

11.2 LIST AND LIBRARY 
The naming convention, applied in Tzunami Deployer, is listed in the following table. 
 

Table 11-2 Naming Conventions for List and Library. 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 2016/2019 
and Online 

Title Length 
supported ( in 
characters) 255 255 

. 

  

 

Tzunami Deployer automatically replaces invalid characters with an underscore (“_”). 
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11.3 FOLDER AND FILE 
The naming convention, applied in Tzunami Deployer, is listed in the following table. 

Table 11-3 Naming Convention for Folder and File. 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 2016/2019 
and Online 

 Invalid characters 
~ " # % & * : < > ? / \ { | } or tab 

characters 
" # % * : < > ? /  \ | or tab 
characters 

File name starts with period(.) 
or tidle(~)F Forbidden Permissible 

File name contains multiple 
period(….) Forbidden Forbidden 

File Name Length supported ( 
in characters) 128 

128 for SP 2016/2019. 
255 for SP Online. 

File URL Length supported ( in 
characters) 260 

260 for SP 2016/2019. 
400 for SP Online. 

Name starts with 
underscore(_) Permissible Permissible 

Name starts with vti  
(e.g._vti_cnf, _vti_pvt, 
_vti_bin, _vti_txt) 

Forbidden Forbidden 

Reserved words at the end of 
file name (i.e. Forbidden to 
use) 

_archivos, _arquivos, 
_bestanden, _bylos, _Dateien, 
_datoteke, _dosyalar, _elemei, 
_failid,  _fails 
_fajlovi, _ficheiros, _fichiers, 
_filer,  .files, _files, _file,  
_fitxers, _fitxategiak, _pliki, 
_soubory, _tiedostot 

_archivos, _arquivos, 
_bestanden, _bylos, _Dateien, 
_datoteke, _dosyalar, _elemei, 
_failid,  _fails 
_fajlovi, _ficheiros, _fichiers, 
_filer,  .files, _files, _file,  
_fitxers, _fitxategiak, _pliki, 
_soubory, _tiedostot 
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11.4 GROUP NAME 
The naming convention, applied in Tzunami Deployer, is listed in the following table. 

Table 11-4 Naming Consideration for Group Names. 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 
2016/2019 and Online 

 Invalid characters 
| \ " ' / [ ] : < > + = , ; ? * @ or tab 

characters 

| \ " ' / [ ] : < > + = , ; ? * @ or 

tab characters  

Title Length 
supported ( in 
characters) 255 255 

Name starts with 
underscore(_) Permissible Permissible 

11.5 PERMISSION NAME 
The naming convention, applied in Tzunami Deployer, is listed in the following table. 
 

Table 11-5 Naming Conventions for Permission Name. 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 
2016/2019 and Online 

 Invalid characters 
| \ " ' / [] : <> + = , ; ? * @ or tab 
characters 

| \ " ' / [] : <> + = , ; ? * 
@ or tab characters 

Title Length supported ( in 
characters) 64 64 

 

11.6 URL AND PATH LENGTH 
The SharePoint URL typically consists of following parts: 
URL= protocol + server name + folder or file path + folder or file name 
For Example: 
http://www.tzunami.com/sites/ 
supports/documents/Shared%20Documents/issue/File%20One.xlsx 
Here, 
Protocol= http:// 
Server name = www.tzunami.com/ 
Folder or file path = sites/supports/documents/Shared%20Documents/issue/ 
File name = File%20One.xlsx 
Then, 
The URL length (in character) is calculated as “folder or file path + folder or file name”.  
And the length is 61 characters. 
Tzunami Deployer will check the URL length (expected) based on the convention listed in 
the following table. 
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Table 11-6 Naming Conventions for URL 

Category 
SharePoint Server 2013 and 
earlier 

SharePoint Server 
2016/2019 and Online 

 Invalid characters 
\ / : * ? “< > | # % { } ~ & or tab 
characters. 

\ / : * ? " < > | # % or tab 
characters 

URL contains multiple 
periods (….) Forbidden  Forbidden 

URL start/end with 
period (.) Forbidden  Forbidden  

URL starts with 
underscore(_)  

 
Forbidden  

 
Underscore(_) starts in  URL 
for Folder and File is 
permissible. 

 

Forbidden 

 
Underscore(_) starts 
in  URL for Folder and 
File is permissible. 

 

URL Length supported ( 
in characters) 260 

260 for SP2016/2019. 
400 for SP Online. 
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12 DEPLOYER CONFIGURATION FILE 

12.1 DEPLOYER OPTION SETTINGS 
Tzunami Deployer has a Deployer.exe.config in the installation directory. This file consists of 

options required for Deployer during migration. When Tzunami Deployer runs, it loads the options 

for the running instances. The subsequent running instance of the deployer also shares the options 

from the initial instance of the deployer. 

Some options in the configuration files are set from deployer’s option in file menu. Some options 

should be manually updated to this file prior to execution of the deployer. This section lists and 

describes such options. 

In the deployer installation directory, find the Deployer.exe.config file. It’s an XML file. Open it in 

any xml file editor with elevated privilege. In the file locate the appSettings node. This node 

consists of options in key value pair. The following table lists the manually configurable options. 

Table 12-1 Options in Deployer Configuration File 

Key Description 

WebAuthBrowser This option is used to connect SharePoint online. Users 
can set value to "Edge", "Firefox", "Chrome" or "Internet 
Explorer" to support the installed browser. 

exportReportToCsv Deployer produces various reports during deployment and 
migration in html format by default. Users can set value to 
“True” to create additional reports in CSV format as well. 

exportReconsilationReport Deployer provides a feature to combine multiple reports 
in a single file as reconciliation report. Users can set the 
value to “True” to create such reconciliation report in 
excel format. 

MaxMigrationAPIThreads This option is used to process the migration package in 
parallel while using migration api in Deployer. Users can 
set value for desired number of threads to process 
packages in parallel which dependent on the number of 
threads of the system. 

ItemsPerPackageLimit This option is used to include the number of items per 
package while using migration api in Deployer. User can 
set value to the desired number of items. 

NumberofRetry This option is used to retry when there is throttling issue 
during migration in SharePoint online. Users can set the 
value to the desired number.  
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Key Description 

MigrationAPISkipPageMigration This option is used to migrate pages in Web Page/Site 
Pages library in SharePoint online using migration api. The 
value is set to “True” to skip the migration of pages. The 
pages remain in pending changes of the Deployer, and 
users can retry to migrate those pages by ensuring that 
associated libraries are migrated in the target source. 

When users set value to “False”, pages are migrated.  
However, it cannot be assured that associated libraries are 
migrated first before migrating pages. That may lead to 
errors in migration of pages and users see the errors as 
well as pending commands in Deployer. Users can retry 
the pending command by ensuring the associated libraries 
are migrated in Target SharePoint. 
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13 TROUBLESHOOTING  

13.1.1 Execution Report 

When Tzunami Deployer performs long operations, such as connecting to SharePoint and 

migrating, an execution report appears. 

 
Figure 13-1: Execution Report 

 

This report displays information concerning the progress of the running operation. The report 

shows Information, Warnings and Errors by default in Level and related operation in Description. 

You can perform various actions using the report: 

• Check box Auto-scroll - if checked, the report will automatically scroll down to the newest 

entry.  

• Check box Errors only – if checked, filters the entries to display only errors. 

• Check box Warnings only – if checked, filters the entries to display only warnings. 

• Button Save As… – Saves the report as a text file. 

• Button View - Displays an advanced view of the report, providing users with more details 

and possible resolutions to errors. 

If there were any errors during the running process, a balloon will appear, notifying us that errors 

were found. Pressing the View button, will display the advanced view of the report: 
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Figure 13-2: Execution Report – Advanced View 

 

The upper panel in this window displays the same information entries as in the execution report. 

The lower panel displays the details of the selected entry, and possible resolutions if exists. The 

Related Exceptions tab can be used to view information from the logs that is relevant to the 

selected error. 
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13.1.2 Unexpected Errors 

When Tzunami Deployer encounters an unexpected error, the following window pops up: 

 
Figure 13-3: Unexpected Error window 

 

This window provides information about the error. In order to see more details, click Show Details. 

You can also report this error to the Tzunami Support Team by clicking the Send Report button, or 

return to Tzunami Deployer by clicking Don’t Send. 

To send a report: 

1. Click Send Report. 

The Report window appears. 

 
Figure 13-4: Report window 
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2. Fill the From and From Email fields. 

3. In the Comments/Scenario field, describe the steps you performed that led to the 

unexpected error or add comments about the process. 

4. In the Attach files section, you can add or remove files that to send with the report. By 

default, Tzunami Deployer adds the logs of the project as attached files. 

5. Click OK. 

The generated report is sent to the Tzunami Support Team   
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14 FREQUENTLY ASKED QUESTIONS 

This section includes frequently asked questions in the following areas: 

• Installation. 

• Support # character. 

• Permission. 

• Security. 

• Broken Links. 

• Batch and Command Line Operations. 

• Remote Operation. 

• Logging. 

• Delta Deployment. 

14.1 INSTALLATION 
Where do I get the software for the Tzunami Deployer Remote Service? 

Tzunami Deployer Remote Service is a component needed in order to run Tzunami 

Deployer on non-SharePoint machines. This component is not available during the Tzunami 

Deployer evaluation phase (in which the Tzunami Deployer installation must be on the 

SharePoint server). Upon purchasing the product, all relevant links for download are 

supplied. If you have any more questions about this subject, please contact the Tzunami 

Support Team at support@tzunami.com. 

Does Tzunami Deployer support running migration operations without having to install any 

components on the SharePoint servers? 

Yes. When performing a migration to SharePoint 2003, there are no components that 

require installation on the SharePoint server. 

When migrating to SharePoint 2013, 2016 or 2019, the current version of Tzunami 

Deployer provides “On-Premise” mode for connecting to premise SharePoint server 

without using Tzunami Remote Service.  

Is Tzunami Deployer a Windows or a web based application? 

Tzunami Deployer is a Windows-based application with a Windows service component 

running on the SharePoint server (for migration to SharePoint 2010/ SharePoint 

2013/SharePoint 2016/SharePoint 2019 or SharePoint Online only). 

 

 

mailto:support@tzunami.com
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14.2 SUPPORT # CHARACTER 
How does Tzunami Deployer support “#” character in folder and file when migrating to 

SharePoint online? 

Tzunami Deployer supports “#” character in folder and file title property when migrating to 

SharePoint online and SharePoint 2019. The “#” character is preserved in folder and file 

title property after migration to SharePoint (i.e.; original file name from source is preserved 

in Title property for folder). 

In other target SharePoint on-premise versions, the “#” character is replaced with “_” 

character. 

14.3 PERMISSIONS 
What access rights does Tzunami Deployer require on the source environment? 

This varies from system to system. Generally, a user with full read permissions is required 

for the source system. A user that can access the data through the regular system interface 

should be sufficient in most cases. For more information about the requirements of the 

various systems, see the relevant Tzunami Deployer Exporter’s Guide. Migration 

Does Tzunami Deployer migrate folder structure? Does Tzunami Deployer migrate Documents 

and lists metadata? 

Yes. Tzunami Deployer extracts and enables the deployment and migrating of any hierarchy 

structure existing in the source system. Tzunami Deployer migrates metadata for sites, lists, 

items, and files, including the system properties (Create, Created By, Modified, and 

Modified By). 

Does Tzunami Deployer migrate version history of documents? 

Yes. Tzunami Deployer retains version history for items and documents with all relevant 

metadata. 

Does Tzunami Deployer migrate Document Policy Management? Does Deployer migrate Alerts? 

No. Tzunami Deployer is a data migrating tool and, as such, it does not support migrating 

document policies or alerts. 

Does Tzunami Deployer migrate Documents and Lists? 

Yes. Tzunami Deployer supports migration of all kinds of containers and contained items 

from the source system, including documents, data-items, folders, lists, libraries, and sites. 

Does Tzunami Deployer support the migration of all list types?  

Yes. Tzunami Deployer supports the migration of all list types, including Document 

Libraries, Issues, Tasks, Contacts, Announcements, Discussions, as well as custom lists. 
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Does Tzunami Deployer support multi-lingual migration? 

Tzunami Deployer is not language-specific. Whatever the language your data is written in, 

Tzunami Deployer will migrate it as-is. 

Does Tzunami Deployer migrate layouts, themes, and headers of sites? 

No. Tzunami Deployer is a content migration tool. Layouts, themes, and templates in 

general are not part of the content and, therefore, are not migrated. However, you can 

create your own custom templates in the target SharePoint and use those templates in 

Tzunami Deployer. 

Does Tzunami Deployer migrate Site Definitions? 

The main site definitions of SharePoint reside on the SharePoint server and are not part of 

the SharePoint data itself. For this reason, Tzunami Deployer does not support the 

migration of site definitions. Custom site/list templates, on the other hand, reside in the 

SharePoint libraries: “site/list template gallery”. These lists are read with Tzunami Deployer 

and the contained item can be migrated to the target SharePoint. Note that any 

dependency or inconsistency that might occur after migration is the responsibility of the 

creator of the site/list template – Tzunami Deployer is responsible only for moving the files. 

Does Tzunami Deployer migrate regional settings? Does Tzunami Deployer migrate workflows? 

No. Tzunami Deployer is a data migration tool and, as such, it does not support migrating 

non-data related definitions. 

Does Tzunami Deployer migrate Personal sites? 

Yes. Personal sites are treated as any site collection in Tzunami Deployer and can be 

migrated along with their content. 

Does Tzunami Deployer support site level migration? Does Tzunami Deployer support item level 

migration? 

Yes. Tzunami Deployer allows migration of content from any level in the source system to 

any level in the target system. 

Does Tzunami Deployer migrate Wiki Page content for Confluence to Modern Page in SharePoint 

Online? 

Yes. You can refer Annex Section for details steps required to perform during migration. 

 

14.4 SECURITY 
Does Tzunami Deployer migrate file system security? 
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Tzunami Deployer extracts file system security definitions and enables the mapping of 

these to SharePoint security definitions. Security modeling is a complex topic – if you have 

more questions about how exactly Tzunami Deployer supports security migration, contact 

the Tzunami Support Team at support@tzunami.com. 

Does Tzunami Deployer support migrating permissions at the list level? 

Tzunami Deployer enables the management of list-level permissions at any level, as well as 

migration of security settings during the migration process. Security modeling is a complex 

operation – we recommend consulting with the Tzunami Support Team at 

support@tzunami.com on all aspects of your security migration needs.  

Will Tzunami have any access to my data? 

No. Tzunami products are installed into your environment, and all data are stored locally. 

14.5 BROKEN LINKS 
Does Tzunami Deployer fix broken links? 

Tzunami Deployer itself does not handle the fixing of relative links that refer to the source 

system. Tzunami offers a redirection tool to solve such cases. For more information, 

contact the Tzunami Support Team at support@tzunami.com. 

 

14.6 BATCH AND COMMAND LINE OPERATIONS 
Does Tzunami Deployer support creating a batch of migration operations that can be run a 

scheduled time? 

Yes. Tzunami Deployer can work in non-GUI mode and performs operations in a batch style 

manner once batch files are created. You can schedule Tzunami Deployer as a command-

line tool to run at a scheduled time using the Windows Scheduled Tasks. For more 

information, contact the Tzunami Support Team at support@tzunami.com. 

14.7 REMOTE OPERATION  
Does Tzunami Deployer allow migration operations to be performed remotely? 

When performing a migration to SharePoint 2003, SharePoint Online and SharePoint Server 

2010 (without using remote service), all operations are done remotely. 

When migrating to SharePoint 2010/ SharePoint 2013/SharePoint 2016/SharePoint 2019, 

Tzunami Deployer requires a Windows Service component to be installed on the 

SharePoint server. After installation, all Tzunami Deployer instances can communicate and 

function remotely. 
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14.8 LOGGING 
Does Tzunami Deployer log migration operation results to a file? 

Yes. All actions are logged for later reviewing in case of errors. Tzunami Deployer also 

provides several XML reports for you.  

14.9 DELTA DEPLOYMENT 
Does Tzunami Deployer supports Delta Deployment? 

Yes. Tzunami Deployer supports the delta deployment. You have to save the previous 

regular migration project. Later on, you can load that project and perform delta 

deployment in one go (automatic). Delta deployment can be performed for modified 

source content only once. 

Does Tzunami Deployer supports Delta Deployment for Confluence Page migrated in Modern 

Page of SharePoint Online? 

Yes. When you have migrated the content using Tzunami Deployer, you have to update the 

Configuration file prior to perform Delta Deployment. Please, refer Annex Section for 

details. 
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15 ANNEX 

15.1 HOW TO UPDATE CONFIGURATION FILE TO PERFORM DELTA 

DEPLOYMENT OF MODERN PAGE 
To perform delta in confluence as source when the confluence pages are exported and deployed as 

modern pages in target (SharePoint Online) at first follow the following steps: 

1. Go to the project location and open the SpecificationFiles folder. 

2. Open RootDeploySourceTargetInfo in editor tool. 

The xml file will be like: 

 
Figure 15-1 Configuration File 

3. Now copy from <RootDeploySourceTargetInfo> to </RootDeploySourceTargetInfo> and paste it 

just below the end of RootDeploySourceTargetInfo as: 

 

 
Figure 15-2 Adding Nodes for Source and Target URL 

4. Edit the SourceUrl with the Url of wiki pages in your source as: 

 
Figure 15-3 Mapping Source and Target URL 
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5. Now edit the TargetParentUrl with the URL of the site which was deployed as team site from 

source. 

 

 
Figure 15-4 Editing Target's Parent Site URL 

 

6. Finally edit the TargetUrl with the url of SitePages as: 

 

 
Figure 15-5 Editing SitePage URL 

 

7. Save the xml file and close it. 

8. Now go to the Deployer project and perform delta deployment. 
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15.2 HOW TO CREATE MICROSOFT AZURE STORAGE ACCOUNT 
1. Log in to https://portal.azure.com.  

2. Go to Storage Accounts. Add one.  

3. While adding a new storage account, a couple of things need to be considered:  

Choose an appropriate nearest Geo Location for reduced latency and optimal throughput. Or use 

the default one. For example, the nearest location for Nepal would be Southeast Asia.  

 
Figure 15-6 Azure Storage Account Details 

4. Account kind should be either StorageV2 (general purpose v2) or Storage (general purpose v1).  

 

5. Go back to Storage Accounts list and click on the specific storage account.  

 
Figure 15-7 Azure Storage Account Name 

 

 

 

 

https://portal.azure.com/
https://portal.azure.com/
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6. Click on Queues and add a Queue.  

 
Figure 15-8 Azure Storage Account Queue 

7. Go to Access keys and copy any one of the keys to use in Deployer.  

 
Figure 15-9 Azure Storage Account Access Key 
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8. Use the Endpoints Protocol, Storage Account Name, Queue Name and the Access Key to connect 

to SharePoint Online in Deployer.  

 
Figure 15-10 Azure Storage Account Connection Details 
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16 COPYRIGHT AND TRADEMARK 

© Copyright2024. Tzunami Inc. All rights reserved. 

All intellectual property rights in this publication are owned by Tzunami, Inc. and protected by 

United States copyright laws, other applicable copyright laws and international treaty provisions. 

Tzunami, Inc. retains all rights not expressly granted. No part of this publication may be reproduced 

in any form whatsoever or used to make any derivative work without prior written approval by 

Tzunami, Inc. 

No representation of warranties for fitness for any purpose other than what is specifically stated in 

this guide is made either by Tzunami, Inc. or by its agents. 

Tzunami, Inc. reserves the right to revise this publication, and/or make improvements or changes in 

the product(s) and/or the program(s) described in this documentation at any time without prior 

notice. 

Any software on removable media described in this publication is furnished under a license 

agreement included with the product as a separate document. If you are unable to locate a copy, 

please contact Tzunami, Inc. and a copy will be forwarded to you. 

Tzunami is either a registered trademark or a trademark of Tzunami, Inc. in the United States 

and/or other countries. 

All other brand or product names are trademarks or registered trademarks of their respective 

companies. 

For further information, you can contact Tzunami Inc. at: 

Tzunami Inc. 

601 108th Avenue, NE 

Suite 1900 

Bellevue, WA 98004, USA 

Email: sales@tzunami.com, support@tzunami.com  

Web: http://www.tzunami.com 
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